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Safety Guidelines

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

Danger

indicates that death or severe personal injury will result if proper precautions are not taken.

Warning

indicates that death or severe personal injury may result if proper precautions are not taken.

Caution

> BB

with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

Caution

without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

Notice

indicates that an unintended result or situation can occur if the corresponding information is not taken into
account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes
in this documentation qualified persons are defined as persons who are authorized to commission, ground and
label devices, systems and circuits in accordance with established safety practices and standards.

Prescribed Usage
Note the following:

A Warning
This device may only be used for the applications described in the catalog or the technical description and only in
connection with devices or components from other manufacturers which have been approved or recommended by
Siemens. Correct, reliable operation of the product requires proper transport, storage, positioning and assembly
as well as careful operation and maintenance.

Trademarks

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the
owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent
editions.
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Purpose of the Operating Instructions

These operating instructions provide information based on the requirements defined by
DIN 8418 for mechanical engineering documentation. This information relates to the the
place of use, transport, storage, mounting, use and maintenance.

These operating instructions are intended for:

e User

¢ Commissioning engineers

e Service technicians

¢ Maintenance technicians

Please read the section "Safety Instructions and General Notes" carefully.

The help integrated in WinCC flexible, the WinCC flexible Information System, contains
detailed information. The information system contains instructions, examples and reference
information in electronic form.

Basic Knowledge Required

General knowledge of automation technology and process communication is needed to
understand the operating instructions.

It is also assumed that those using the manual have experience in using personal computers
and knowledge of Microsoft operating systems.

Operating Instructions' Range of Validity

The operating instruction manual applies to the TP 277 and OP 277 HMI devices in
connection with the WinCC flexible software package.

Position in the Information Landscape

These operating instructions form part of the SIMATIC HMI documentation. The following
information provides you with an overview of the SIMATIC HMI information landscape.

User manuals
e WinCC flexible Micro

Describes basic principles of configuration using the WinCC flexible Micro Engineering
System.

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO
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WinCC flexible Compact/ Standard/ Advanced

Describes basic principles of configuration using the WinCC flexible Compact
Engineering System/WinCC flexible Standard/WinCC flexible Advanced.

WinCC flexible Runtime

Describes how to commission and operate your runtime project on a PC.
WinCC flexible Migration

— Describes how to convert an existing ProTool project to WinCC flexible.
— Describes how to convert an existing WinCC project to WinCC flexible.

— Describes how to convert an existing ProTool project including a change of the HMI
device, for example from OP3 to OP 73 or from OP7 to OP 77B

— Describes how to convert an existing ProTool project including a change from a
graphics device to a Windows CE device.

Communications
— Communication Part 1 describes the connection of the HMI device to SIMATIC PLCs.

— Communication Part 2 describes the connection of the HMI device to third-party PLCs.

Operating instructions

Operating instructions for SIMATIC HMI devices.

- OP73,0P77A,OP 77B

- TP 170micro, TP 170A, TP 170B, OP 170B

— OP 73micro, TP 177micro

- TP177A, TP 177B, OP 177B

- TP 270, OP 270

- TP 277,0P 277

- MP 270B

- MP 277

- MP 370

Operating instructions for mobile SIMATIC HMI devices.
— Mobile Panel 177

- Mobile Panel 277

Operating instructions (compact) for SIMATIC HMI devices.
- OP77B

— Mobile Panel 177

— Mobile Panel 277

Operating instructions for SIMATIC accessories

— Industrial USB Hub 4

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO
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Getting Started
e WinCC flexible for first time users

Based on an example project, this is a step-by-step introduction to the basics of
configuring screens, alarms, recipes and screen navigation.

¢ WinCC flexible for power users

Based on an example project, this is a step-by-step introduction to the basics of
configuring logs, project reports, scripts, user management, multilingual projects and
integration in STEP 7.

e WinCC flexible Options

Based on an example project, this is a step-by-step introduction to the basics of
configuring the WinCC flexible Sm@rtServices, Sm@rtAccess and OPC server options.

Online Availability

Technical documentation on SIMATIC products and SIMATIC systems is available in PDF
format in various languages at the following addresses:

e SIMATIC Guide Technical Documentation in German:
"http://www.ad.siemens.de/simatic/portal/html_00/techdoku.htm"

e SIMATIC Guide for Technical Documentation in English:
"http://www.ad.siemens.de/simatic/portal/html_76/techdoku.htm"

Screens
The HMI device is sometimes shown in the form of photographs in these operating
instructions. The photographs of the HMI device may differ slightly from the factory state of
the HMI device.

Conventions

Configuration and runtime software differ with regard to their names as follows:
e "WinCC flexible 2005" for example, refers to the configuration software.

The term "WinCC flexible" is used in a general context. The full name, for example
"WinCC flexible 2005", is always used when it is necessary to differentiate between
different versions of the configuration software.

e "WInCC flexible Runtime" refers to the runtime software that can run on HMI devices.

The following text notation will facilitate reading these operating instructions:

Notation Scope

"Add screen" e Terminology that appears in the user interface, for example
dialog names, tabs, buttons, menu entries

e Inputs required, for example limit values, tag values
e Path information

"File > Edit" Operational sequences, for example, menu commands, context
menu commands
<F1>, <Alt+P> Keyboard operation

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO iii
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Please observe notes labeled as follows:

Note

Notes contain important information concerning the product, its use or a specific section of
the documentation to which you should pay particular attention.

Registered Trademarks

Names labeled with a ® symbol are registered trademarks of the Siemens AG. Other names
used in this documentation may be trademarks, the use of which by third parties for their
own purposes could violate the rights of the owner.

e HMI®

e SIMATIC®

e SIMATIC HMI®

e SIMATIC ProTool®

¢ SIMATIC WinCC®

e SIMATIC WinCC flexible®
e SIMATIC TP 277®

e SIMATIC OP 277®

Representatives and Offices

Training Center

If you have any further questions relating to the products described in this manual, please
contact your local representative at the SIEMENS branch nearest you.

Your Siemens representative can be found at "http://www.siemens.com/automation/partner”.

Siemens AG offers a variety of training courses in order to familiarize you with automation
systems. Please contact your regional Training Center, or the central Training Center in
D90327 Nuremberg, Germany.

Phone: +49 (911) 895-3200

Internet: "http://www.sitrain.com/"

Technical Support

You can find technical support for all A&D projects
Using the support request form on the web at
"http://www.siemens.de/automation/support-request”
Phone: + 49 180 5050 222

Fax: + 49 180 5050 223

Further information about our technical support is available on the Internet at
"http://www.siemens.com/automation/service".

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO
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Service & Support on the Internet

Service & Support provides additional comprehensive information on SIMATIC products
through online services at "http://www.siemens.com/automation/suppori":

e The newsletter offers you the latest information about your products.

¢ A large document base is available using our Service & Support search engine.
o A forum for global exchange of information by users and experts

e Current product information, FAQs and downloads

e Your local Automation & Drives representative

¢ Information about field service, repairs, spare parts and much more under the heading
"Services"

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO \"
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Overview 1

1.1 Product Overview

Applications for the TP 277 and OP 277

The HMI devices TP 277 and OP 277 represent a further stage of development of the HMI
devices TP 270-6 and OP 270-6.

The HMI devices are based on the standard operating system Microsoft Windows CE.

Compared with the Multi Panel MP 277, the TP 277 and the OP 277 offer an inexpensive
scaled option.

The mounting options and the functional scope of the TP 277 and OP 277 are compatible
with the HMI devices in the 270 series.

The TP 277 and OP 277 also have the following features:

e The HMI devices can be operated on PROFINET via the Ethernet port.
e The HMI devices feature a TFT screen with 256 colors.

e The use of projects with scripts and logs is supported.

In addition to the classic HMI application WinCC flexible, the HMI devices also support
additional applications, for example:

o Sm@rtService
o Sm@rtAccess

TP 277, OP 277 (WinCC flexible)
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1.2 Design of the HMI Device TP 277

1.2 Design of the HMI Device TP 277

Front view and side view

O——o
®

®
@———

0] Slot for a memory card

® Display / Touch screen

® Mounting seal

@ Recesses for mounting clamps
Bottom view

0] Ports

® Recesses for mounting clamps

TP 277, OP 277 (WinCC flexible)
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Overview
1.3 Design of the HMI Device OP 277

Rear view

Slot for a memory card
Rating label

DIP switch

Interface name

® e 60 0

1.3 Design of the HMI Device OP 277

Front view and side view

Slot for a memory card
Display
Recesses for mounting clamps

® e 60 0

Mounting seal

TP 277, OP 277 (WinCC flexible)
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1.4 Accessories

Bottom view
|
] @
0] Ports
® Recesses for mounting clamps
Rear view
@
®
0] Slot for a memory card
® Rating label
® DIP switch
® Interface name
1.4 Accessories
Accessory kit

The accessory kit is supplied with the HMI device.
The accessory kit contains the following:

e A terminal block for the power supply

e Mounting clamps for mounting the TP 277

e Mounting clamps for mounting the OP 277

Additional documents may be enclosed with the accessory kit.

TP 277, OP 277 (WinCC flexible)
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1.4 Accessories

RS 422-RS 232 Converter

You need the converter in order to connect third-party PLCs. Connect the RS 422-RS 232
converter to the RS 422/RS 485 port. The converter converts the input signals to RS-232
signals.

The converter is not supplied with the HMI device. The converter can be ordered separately
under the order number 6AV6671-8XE00-0AXO.

PC/PPI Cable

The cable is required when updating the operating system by bootstrapping. You can also
use the cable for transfer. Connect the PC/PPI cable to the RS 422/RS 485 port. The cable
converts the input signals to RS-232 signals.

The cable is not supplied with the HMI device. The cable can be ordered separately under
the order number 6ES7901-3CB30-0XA0.

Note

If the connection fails during the operating system update, set the system to a lower bit rate.
If you wish to communicate at high bit rate, you must used a PC/PPI cable of version 3 or
later. The version code is printed on the cable (e.g. "E-Stand 3" corresponds to version 3).

90° Angle Adapter
If space is restricted, you can use an angle adapter at the RS 422/RS 485 port.

The adapter is not supplied with the HMI device. The adapter can be ordered separately
under the order number 6AV6671-8XD00-0XA0.

Protective Foil
Protective foil is available for HMI devices with a touch screen.

The protective foil is not supplied with the HMI device. The protective foil can be ordered
separately under the order number 6AV6671-2XC00-0AX0.

Memory Card

Only use the SD memory cards tested and released by Siemens or multimedia cards. More
information can be found in the SIMATIC HMI catalog ST 80.

TP 277, OP 277 (WinCC flexible)
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1.5 Functional Scope with WinCC flexible

1.5 Functional Scope with WinCC flexible

The following tables show the objects which can be integrated in a project for a TP 277 or

OP 277.
Alarms
Object Specification TP 277 | OP 277
Alarms Number of discrete alarms 4.000
Number of analog alarms 200
Length of the alarm text 80 characters
Number of tags in an alarm Max. 8
Display Alarm line/Alarm
window/Alarm view
Acknowledge error message individually Yes
Acknowledge several error messages simultaneously 16 alarm groups
(group acknowledgement of alarm groups)
Edit alarm Yes
Alarm indicator Yes
ALARM_S Display S7 alarms Yes
Alarm buffer, retentive Alarm buffer capacity 512 alarms
Simultaneously queued alarm events Max. 250
View alarm Yes
Delete alarm buffer Yes
Line-by-line printing of alarms Yes
Tags, values and lists
Object Specification TP 277 /| OP 277
Tags Number 2.048
Limit value monitoring Input/Output Yes
Linear Scaling Input/Output Yes
Text lists Number 500 "
Graphics lists Number 400"
1) The maximum total of text and graphics lists is 500.

1-6
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1.5 Functional Scope with WinCC flexible

Screens
Object Specification TP 277 /] OP 277
Screens Number 500
Fields per screen 200
Tags per screen 200
Complex objects per screen (for example bars) 10
Template Yes
Recipes
Object Specification TP 277 /] OP 277
Recipes Number 300
Data records per recipe 500
Elements per recipe 1.000
Recipe memory 64 KB
Memory location e Memory card "
e Network drive

1) The number of recipe data records might be restricted by the capacity of the storage medium.

Logs
Note
The HMI devices are suitable for the logging of relatively small volumes of data.
The data are managed in several adjacent archives in a segmented circular archive. The use
of a large circular archive has a negative effect on performance.
Object Specification TP 277 /] OP 277
Logs Number of logs 20
Number of partial logs in a segmented circular log 400
Entries in each log including all partial logs 10.000

Filing format

CSV with ANSI character set

Memory location

e Memory card V)
e Network drive

1) The number of entries in the log may be restricted by the capacity of the storage medium.

TP 277, OP 277 (WinCC flexible)
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1.5 Functional Scope with WinCC flexible

Safety
Object Specification TP 277 /| OP 277
Safety Number of user groups 50
Number of users 50
Number of authorizations 32
Info texts
Object Specification TP 277 /| OP 277
Info texts Length (no. of characters) 320
(depending on font)
For alarms Yes
For screens Yes
For screen objects (for example for 10 field, switch, Yes
button, invisible button)
Additional functions
Object Specification TP 277 /| OP 277
Screen settings Calibrating the touch screen " Yes
Language change Number of languages 16
VBScript User-specific extension of the functionality Yes
Number of scripts 50
Graphic objects Vector and pixel graphics Yes
Trends Number 300
Task planner Number of tasks 48
Text objects Number 10.000
Direct keys PROFIBUS DP direct keys Yes
PROFINET IO direct keys Yes
1) TP 277 only
TP 277, OP 277 (WinCC flexible)
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1.6 Software Options

1.6 Software Options

The following software options are available for the HMI devices:
e Sm@rtService

The Sm@rtService option enables you to access a remote HMI device from the HMI
device or PC via Ethernet.

o Sm@rtAccess

The Sm@rtAccess option enables you to set up communication between different HMI
systems.

o /Audit

The /Audit option extends the HMI device to include functions for recording operations in
an audit trail and electronic signature.

e Pocket Internet Explorer

With the Pocket Internet Explorer option, you can view websites published on the

Internet.
1.7 Communications
Number of connections
Connection TP 277/ OP 277
Number using a bus connection 6
Number of connections based on "SIMATIC HMI HTTP Protocol" 8

Controllers

The following table shows the controllers which can be used with the HMI devices and the
protocols or profiles which can be used.

Note

In the following cases, do NOT release PROFINET 1O at the control panel of the HMI device:
o Use of PLCs by other manufacturers

o Use of SIMATIC 500/505 via NITP

TP 277, OP 277 (WinCC flexible)
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1.7 Communications

See also

PLC Protocol TP 277 | OP 277
SIMATIC S7 e PPI Yes
e MPI "
e PROFIBUS DP
e TCP/IP (Ethernet)
SIMATIC S5 e PROFIBUS DP Yes
SIMATIC 500/505 e NITP Yes
¢ PROFIBUS DP
SIMATIC HMI e HTTP/HTTPS (Ethernet) Yes
HTTP Protocol
Allen-Bradley PLC series SLC500, SLC501, SLC502, SLC503, Yes
SLC504, SLC505, MicroLogix and PLC5/11,
PLC5/20, PLC5/30, PLC5/40, PLC5/60, PLC5/80
e DF1259
e DH+ via KF2 module 3
e DH485 via KF3 module 4
e DH4854
GE Fanuc Automation PLC series 90-30, 90-70, VersaMax Micro Yes
e SNP
LG Industrial Systems PLC series GLOFA GM (GM4, GM6 and GM7) / Yes
(Lucky Goldstar) / IMO Series G4, G6 and G7
e Dedicated communication
Mitsubishi Electric PLC series MELSEC FX and MELSEC FX0 Yes
e FX
Mitsubishi Electric PLC series MELSEC FX0, FX1n, FX2n, AnA, Yes
AnN, AnS, AnU, QnA and QnAS
e Protocol 4
OMRON PLC series SYSMAC C, SYSMAC CV, Yes
SYSMAC CS1, SYSMAC alpha and CP
e Hostlink/Multilink (SYSMAC Way)
Modicon PLC series Modicon 984, TSX Quantum and Yes

(Schneider Automation)

TSX Compact
e Modbus RTU 9

PLC series Quantum, Momentum, Premium and
Micro
PLC series Compact and 984 via Ethernet bridge

e Modbus TCP/IP (Ethernet)

" Not possible when connected to S7-212.

2 Applies to controllers SLC503, SLC504, SLC505, PLC5, MicroLogix
3  Applies to controllers SLC504, PLC5 over DF1

4 Applies to controllers SLC500 to SLC 505 and MicroLogix

5  only with converter RS 422-RS 232 6AV6 671-8XE00-0AX0 (option)

Enabling PROFINET 10 (Page 6-36)

TP 277, OP 277 (WinCC flexible)
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Safety Instructions and General Notes 2

2.1 Safety Instructions

Working on the cabinet

VAN

Hazardous areas

VAN

Warning
Open Equipment

The HMI device is an open equipment. This means that the HMI device may only be installed
in housings or cabinets, whereby the device can be operated from the front panel.

Access to the housing or cabinet in which the HMI device is installed should only be possible
by means of a key or tool and only for trained and authorized personnel.

Dangerous Voltage
Opening the cabinet will expose high voltage parts. Contact with these parts could be fatal.

Switch off the power supply to the cabinet before opening it.

When operating the HMI device in hazardous areas the following warning applies.

Warning
Explosion Hazard

Do not disconnect while circuit is live unless area is known to be non-hazardous. Substitution
of components may impair suitability for Class |, Division 2 or Zone 2.

High Frequency Radiation

Proper use

VAN

Notice
Unintentional Operating Situations

High frequency radiation, for example from a cell phone, may cause unintentional operating
situations.

Warning

Commissioning of the HMI device is forbidden until it has been absolutely ensured that the
machine in which the HMI device is to be installed complies with Directive 98/37/EC.

TP 277, OP 277 (WinCC flexible)
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Safety Instructions and General Nofes

2.2 Standards, Certificates and Approvals

2.2 Standards, Certificates and Approvals

Certificates and approvals

VAN

CE approval

UL approval

2-2

Caution
The following overview shows possible approvals.
The HMI device itself is certified as shown on the rear panel labels.

C€

The automation system meets the general and safety-related requirements of the following
EC directives and conforms to the harmonized European standards (EN) for programmable
logic controllers published in the official gazettes of the European Union:

e 89/336/EEC "Electromagnetic Compatibility" (EMC Directive)

e 98/37/EG Directive of the European Parliament and Council of 22 June 1998 on the
approximation of the laws and administrative regulations of the Member States
concerning machinery

EC Declaration of Conformity

The EC Declarations of Conformity are kept available for the responsible authorities at the
following address:

Siemens Aktiengesellschaft
Automation & Drives

A&D AS RD ST PLC

PO Box 1963

D-92209 Amberg, Germany

Underwriters Laboratories Inc. conforming to
e UL 508 (Industrial Control Equipment)
e CSA C22.2 No. 142 (Process Control Equipment)

or

TP 277, OP 277 (WinCC flexible)
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FM Approval

2.2 Standards, Certificates and Approvals

Underwriters Laboratories Inc. conforming to

e UL 508 (Industrial Control Equipment)

e CSA C22.2 No. 142 (Process Control Equipment)
e UL 1604 (Hazardous Location)

e CSA-213 (Hazardous Location)

Approved for use in

e Class |, Division 2, Group A, B, C, D or

e Class |, Zone 2, Group IIC or

e non-hazardous locations

APPROVED

Factory Mutual Research (FM) conforming to

e Approval Standard Class Number 3611, 3600, 3810
Approved for use in

e Class |, Division 2, Group A, B, C,D T4

e Class |, Zone 2, Group IIC T4

Label for Australia

IEC 61131

0 N11/

The HMI device fulfills the requirements of standard AS/NZS 2064 (Class A).

The HMI device fulfills the requirements and criteria conforming to IEC 61131-2,

Programmable Logic Controllers, Part 2: Operating resource requirements and tests.

TP 277, OP 277 (WinCC flexible)
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2.3 Notes about Usage

2.3 Notes about Usage

Industrial Use

Residential Use

See also

The HMI device is designed for industrial use. The following standards are met:
e Requirements of the emission of interference EN 61000-6-4: 2001
e Requirements for noise immunity EN 61000-6-2: 2001

If the HMI device is used in a residential area, you must take measures to achieve Limit
Class B conforming to EN 55011 for RF interference.

Suitable measures to achieve Limit Class B for suppression of radio interference include:
¢ Installation of the HMI device in a grounded cabinet
e Use of filters in electrical supply lines

Individual acceptance is required.

Spare Parts and Repairs (Page 11-3)

24 Electromagnetic Compatibility

Introduction

The HMI device fulfills requirements of the EMC directive of the domestic European market
and other requirements.

EMC-compliant Mounting of HMI Devices

EMC-compliant mounting of the HMI device and the use of interference-proof cables will
ensure trouble-free operation. The "Directives for interference-free installation of PLCs" and
the "PROFIBUS Networks" manual also apply for the installation of the HMI device.

Pulse-shaped Interference

2-4

The table below shows the electromagnetic compatibility of modules in relation to pulse-
shaped interference. This requires the HMI device to meet the specifications and directives
for electrical installation.

TP 277, OP 277 (WinCC flexible)
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2.4 Electromagnetic Compatibility

(high-speed transient
interference)
conforming to

IEC 61000-4-4

Pulse-shaped Tested with Corresponds to test
interference intensity
Electrostatic discharge Air discharge: 8 kV 3
conforming to Contact discharge: 6 kV

IEC 61000-4-2

Burst pulses 2 KV power supply cable 3

2 KV signal cable, > 30 m
1 KV signal cable, <30 m

High-power surge pulses conforming to IEC 61000-4-5, external protective circuit required (refer to
S7 300 PLC, Installation, chapter “Lightning and Overvoltage Protection”).

Asymmetric coupling 2 kV power cable 3
DC voltage with protective elements
2 KV signal/data cable, > 30 m,
with protective elements as required

Symmetric coupling 1 kV power cable 3

1 KV signal cable, > 30 m,

DC voltage with protective elements

with protective elements as required

Sinusoidal Interference

The table below shows the EMC properties of the modules with respect to sinusoidal
interference. This requires the HMI device to meet the specifications and directives for

electrical installation.

(electromagnetic fields)
according to
IEC 61000-4-3

Sinusoidal interference Test values Corresponds to
test intensity
HF radiation e 80% amplitude modulation at 1 kHz 3

with 10 V/m in the range of 80 MHz to 1 GHz
with 3 V/m in the range 1.4 GHz to 2 GHz
with 1 V/m the range 2 GHz to 2.7 GHz

e 10 V/m with 50 % pulse modulation at 900 MHz
10 V/m with 50 % pulse modulation at 1.89 GHz

RF interference current
on cables and cable
shielding conforming to
IEC 61000-4-6

Test voltage 10 V at 80% amplitude modulation of 3
1 kHz in the range from 9 kHz to 80 MHz

Emission of Radio Interference

The table below shows the emission values of electromagnetic interference conforming to
EN 55011, limit value class A, Group 1, measured at a distance of 10 m:

From 30 to 230 MHz

<40 dB (V/m) quasi-peak

From 230 to 1000 MHz

< 47 dB (V/m) quasi-peak

Additional Measures

If you wish to connect an HMI device to the public network, ensure that it is compliant to
Limit Class B conforming to EN 55022.

TP 277, OP 277 (WinCC flexible)
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2.5 Transport and Storage Conditions

2.5

Transport and Storage Conditions

Mechanical and Climatic Transport and Storage Conditions

The transport and storage conditions of this HMI device exceed requirements conforming to
IEC 61131-2. The following specifications apply to the transport and storage of an HMI
device in its original packing.

The climatic conditions comply to the following standards:

e |EC 60721-3-3, Class 3K7 for storage

e |EC 60721-3-2, Class 2K4 for transport

The mechanical conditions are compliant with IEC 60721-3-2, Class 2M2.

Type of condition Permitted range
Drop test (in transport package) <1m
Temperature from —20 to +60 °C
Air pressure from 1080 hPa to 660 hPa,
corresponds to an elevation of -1,000 m to 3,500 m
Relative humidity from 10% to 90%, no condensation
Sinusoidal vibration conforming to 510 9 Hz: 3.5 mm
IEC 60068-2-6 9 to 500 Hz: 9.8 m/s?
Shock conforming to IEC 60068-2-29 250 m/s2, 6 ms, 1,000 shocks
Notice

Ensure that no condensation (dewing) develops on or inside the HMI device after
transporting it at low temperatures or after it has been exposed to extreme temperature
fluctuations.

The HMI device must have acquired room temperature before it is put into operation. Do not
expose the HMI device to direct radiation from a heater in order to warm it up. If dew has
developed, wait approximately four hours until the HMI device has dried completely before
switching it on.

Proper transport and storage, installation and assembly as well as careful operation and
maintenance are required to ensure trouble-free and safe operation of the HMI device.

The warranty for the HMI device will be deemed void if these stipulations are not heeded.

TP 277, OP 277 (WinCC flexible)
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Planning Application

3.1 Mounting Information

Mechanical and Climatic Conditions of Use

The HMI device is designed for use in a location protected from the weather. The conditions
of use are compliant with requirements to DIN IEC 60721-3-3:

e Class 3M3 (mechanical requirements)

e Class 3K3 (climatic requirements)

Use with additional measures

Do not use the HMI device in the following locations, for example, without additional

measures:

¢ In locations with a high degree of ionizing radiation

¢ In locations with extreme operating conditions, for example due to:

— Corrosive vapors, gases, oils or chemicals
— Electrical or magnetic fields of high intensity

¢ In plants requiring special monitoring features, for example:

— Elevator systems

— Systems in especially hazardous rooms

Mechanical Ambient Conditions

The mechanical ambient conditions for the HMI device are specified in the table below in
terms of sinusoidal vibration.

Frequency range in
Hz

Constant

Occasional

10=f<58

Amplitude 0.0375 mm

Amplitude 0.075 mm

58 =< f<150

Constant acceleration 0.5 g

Constant acceleration 1 g

TP 277, OP 277 (WinCC flexible)
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Planning Application

3.1 Mounting Information

Reduction of Vibration

If the HMI device is subjected to greater shocks or vibrations, you must take appropriate
measures to reduce acceleration or amplitudes.

We recommend fitting the HMI device to vibration-absorbent material (metal shock
absorbers, etc.).

Testing for Mechanical Ambient Conditions

The following table provides information on the type and scope of tests for mechanical
ambient conditions.

Tested for Test standard Comments

Vibrations Vibration test conforming to
IEC 60068, part 2-6

(sinusoidal)

Type of vibration:

Transitional rate of the frequency:
1 octave/minute.

10 < f < 58,

constant amplitude 0.075 mm

58 <f=< 150,

Constant acceleration 1 g
Vibration duration:

10 frequency cycles per axis in each of the three
mutually vertical axes

Shock Shock testing in accordance

with IEC 60068, Part 2-29

Type of shock: Half-sine
Shock intensity:
Peak value 5 g, duration 11 ms

Direction of impact:
3 shocks in * direction of axis in each of the
three mutually vertical axes

Climatic ambient conditions

The table below shows the climatic ambient conditions at which the HMI device may be
operated.

Ambient conditions

Permitted range

Comments

Temperature
o Vertical installation
¢ Inclined mounting

From 0° C to 50° C
from 0° Cto 40° C

See the "Mounting Positions and
Type of Fixation" section

Relative humidity

10 % to 90 %, no condensation

Air pressure

1080 to 795 hPa

Corresponds to an altitude of -
1,000 m to 2,000 m

Pollutant concentration

S0O2: < 0.5 ppm;
relative humidity < 60%, no
condensation

Check: 10 cm3/m3; 10 days

H2S: < 0.1 ppm;
relative humidity < 60%, no
condensation

Check: 1 cm3/m3; 10 days

TP 277, OP 277 (WinCC flexible)
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Planning Application

3.2 Mounting Positions and Type of Fixation

3.2 Mounting Positions and Type of Fixation

Mounting Position
The HMI device is designed for mounting in:
e Racks
e Cabinets
e Control boards
e Consoles

In the following, all of these mounting options are referred to by the general term "cabinet".

The HMI device is self-ventilated and approved for vertical and inclined mounting in
stationary cabinets.

Mounting position Deviation from the vertical
0] Inclined < 35°
® Vertical 0°

A Caution
Impermissible ambient temperatures

Do not operate the HMI device without auxiliary ventilation if the maximum permissible
ambient temperature is exceeded. The HMI device may otherwise get damaged and its
approvals and warranty will be void!

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO 3-3



Planning Application

3.3 Preparing for Mounting

Fixation

Metal mounting clamps are provided for mounting the device. The mounting clamps hook
into the recesses on the HMI device. The overall HMI device dimensions are not exceeded

by

@
@

this.

—®

Recessed head screw
Hooks

3.3 Preparing for Mounting

Selecting the Mounting Location for the HMI device
Points to observe when selecting the mounting location:

Position the HMI device so that it is not subjected to direct sunlight.

Position the HMI device to provide an ergonomic position for the operator. Choose a
suitable installation height.

Ensure that the air vents are not covered as a result of the mounting.

Observe the permissible mounting positions for the HMI device.

Degrees of Protection

The degrees of protection are only guaranteed when the following is observed for the

mo

unting cut-out:

Thickness of material at the mounting cut-out for protection classes IP65 or
NEMA 4X/NEMA 12 (indoor use only):
3 mmto 6 mm

Permitted deviation from plane at the mounting cut-out: <0.5 mm
This condition must be fulfilled for the mounted HMI device.

Permissible surface roughness in the area of the seal: < 120 pm (R: 120)

Dimensions of Mounting Cut-Out

The table below shows the dimensions of the required mounting cut-out:

3-4

Mounting cut-out TP 277 OP 277
Width 197+1 mm 281*' mm
Height 141+ mm 177+ mm
Depth 45 mm 59 mm

TP 277, OP 277 (WinCC flexible)
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Planning Application

3.4 Specifications for Insulation Tests, Protection Class and Degree of Profection

Maintaining Clearances

The HMI device must be installed with the following clearances:

¢ Above and below the mounting cut-out 50 mm respectively for ventilation

e To the right and left of the mounting cut-out 15 mm respectively for fitting the mounting

clamps

e Atleast 10 mm clearance in addition to the depth of the HMI device is required at the rear

Notice

Ensure that the maximum ambient temperature is not exceeded when mounting the

device in a cabinet and especially in a closed enclosure.

34 Specifications for Insulation Tests, Protection Class and Degree of
Protection
Test Voltages

Insulation strength is demonstrated in the type test with the following test voltages

conforming to IEC 61131-2:

Circuits with a rated voltage of Ue to other circuits | Test voltage
or ground
<50V 500 vDC

Protection class

Protection Class | conforming to IEC 60536, i.e. equipotential bonding conductor to profile

rail required!

Protection against Foreign Objects and Water

Degree of protection conforming to Explanation
IEC 60529
Front When mounted:
e |P65
o NEMA 4X/NEMA 12 (indoor use only)
Rear IP20
Protection against touch with standard test fingers.
There is no protection against ingress by water.

The degree of protection provided by the front can only be guaranteed when the mounting
seal lies completely against the mounting cut-out.

TP 277, OP 277 (WinCC flexible)
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Planning Application

3.5 Rated Voltages

3.5

Rated Voltages

The table below shows the rated voltage and the corresponding tolerance range.

Rated voltage

Tolerance range

+24 VDC

20.4 10 28.8 V (=15 %, +20 %)

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting 4

4.1 Checking the Package Contents

Check the package contents for visible signs of transport damage and for completeness.

Notice

Do not install parts damaged during shipment. In the case of damaged parts, contact your
Siemens representative.

Keep the supplied documentation in a safe place. The documentation belongs to the HMI
device and is required for subsequent commissioning.

4.2 Mounting the HMI Device

Requirement
All packaging components and protective foil should be removed from the HMI device.

You need the mounting clamps from the accessories kit for the installation. The mounting
seal must be available on the HMI device. If the mounting seal is damaged, order a
replacement seal. The mounting seal is part of the associated service pack.

Mounting

Notice

Always mount the HMI device according to the instructions in this manual.

Proceed as follows:
1. Check that the mounting seal is fitted on the HMI device.

Do not install the mounting seal turned inside out. This may cause leaks in the mounting
cut-out.

2. Insert the HMI device into the mounting cut-out from the front.

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting

4.2 Mounting the HMI Device

3. Insert a mounting clamp into a recess of the HMI device.

e

4. Tighten the mounting clamp with a Phillips screwdriver.
The permitted torque is 0.2 Nm.

5. Repeat step 3 and 4 for all mounting clamps.

Notice

Check the fit of the mounting seal on the front. The mounting seal must not protrude from
the HMI device.

If necessary, repeat steps working steps 1 to 5.

Positioning the mounting clamps for the TP 277

4-2

In total, you will need 7 mounting clamps for the installation.

The following figure shows the counting direction for the insertion of the mounting clamps.

=

V V

The following table shows the positions of the mounting clamps on the TP 277. Please note
the counting direction. The position indicated corresponds to the first recess occupied for
each mounting clamp in the counting direction. The inserted mounting clamp covers several
recesses.

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting

4.2 Mounting the HM/ Device

Page Number of mounting Mounting clamp Mounting clamp Mounting clamp
clamps position 1 position 2 position 3

Top 3 1 13 24

Right 2 1 8 -

Bottom No mounting clamp necessary.

Left 2 | 2 15 -

Positioning the mounting clamps on the OP 277

In total, you will need 12 mounting clamps for the installation.

The following figure shows the counting direction for the insertion of the mounting clamps.

—

V

—

V

The following table shows the positions of the mounting clamps on the OP 277. Please note
the counting direction. The position indicated corresponds to the first recess occupied for
each mounting clamp in the counting direction. The inserted mounting clamp covers several

recesses.
Page Number of mounting Mounting clamp Mounting clamp Mounting clamp Mounting clamp
clamps position 1 position 2 position 3 position 4
Top 4 1 7 18 30
Right 2 1 5 - -
Bottom 4 1 7 14 19
Left 2 2 10 - -

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting

4.3 Connecting the HMI Device

4.3 Connecting the HMI Device

431 Overview

Requirement

¢ The HMI device must be mounted according to the specifications of these operating
instructions.

o Always use shielded standard cables.
For further information, refer to the SIMATIC HMI catalog ST 80.

Connection sequence
Connect the HMI device in the following sequence:
1. Equipotential bonding
2. Power supply

Perform a power-up test to ensure the power supply is connected with the correct
polarity.

3. PLC
4. Configuration computer as necessary

5. 1/Os as necessary

Notice
Connection sequence

Always follow the correct sequence for connecting the HMI device. Failure to do so may
result in damage to the HMI device.

Disconnect the HMI device by completing the above steps in reverse order.

Connecting the Cables

When connecting the cables, ensure that you do not bend any of the contact pins. Secure
the connectors with screws.

The pin assignment of the ports is described in the specifications.

See also
Safety Instructions (Page 2-1)

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting

4.3 Connecting the HMI Device

432 Ports

The figure below shows the ports of the HMI device.

O] Chassis terminal for equipotential bonding
® Power supply connector

® RS 422/RS 485 interface (IF 1B)

@ Ethernet port

® USB port

Notice

Connecting external devices to the USB port

If you wish to connect external devices with 230V power supply to the USB port, ensure that
the installation is non-isolated.

See also
Power Supply (Page 12-6)
RS 422/RS 485 (IF 1B) (Page 12-6)
Ethernet (Page 12-7)
USB ((Page 12-7)

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting

4.3 Connecting the HMI Device

43.3 Connecting the Equipotential Bonding Circuit

Electrical potential differences

Differences in potential between spatially separated system parts may occur. The
differences in potential can lead to high equalizing currents over the data cables and
therefore to the destruction of their ports. Equalizing currents may arise if the cable shielding
is terminated at both ends and grounded at different system parts.

Differences in potential may develop when a system is connected to different mains.

General Requirements for Equipotential Bonding

Differences in potential must be reduced by means of equipotential bonding in order to
ensure trouble-free operation of the relevant components of the electronic system. The
following must therefore be observed when installing the equipotential bonding circuit:

4-6

The effectiveness of equipotential bonding increases as the impedance of the
equipotential bonding conductor decreases or as its cross-section increases.

If two system parts are connected to each other via shielded data lines with shielding
connected to the grounding/protective conductor on both sides, the impedance of the
additionally installed equipotential bonding cables may not exceed 10% of the shielding
impedance.

The cross-section of a selected equipotential bonding conductor must be capable of
handling the maximum equalizing current. The best results in practical applications for
equipotential bonding between two cabinets have been achieved with a minimum
conductor cross-section of 16 mm2,

Use equipotential bonding conductors made of copper or galvanized steel. Establish a
large surface contact between the equipotential bonding conductors and the
grounding/protective conductor and protect these from corrosion.

Clamp the shielding of the data cable on the HMI device flush and near the equipotential
busbar using suitable cable clamps.

Route the equipotential bonding conductor and data cables in parallel with minimum
clearance between these.

Notice
Grounding conductor

Cable shielding is not suitable for equipotential bonding. Always use the prescribed
equipotential bonding conductors. The minimum cross-section of a conductor used for
equipotential bonding is 16 mm2. When you install MPI and PROFIBUS DP networks,
always use cables with a sufficient cross-section. The interface modules may otherwise
be damaged or destroyed.

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting
4.3 Connecting the HMI Device

Wiring diagram

O)
[ w]
—_

10BRED
g@@ﬁﬁﬁ

=

@—
©
5

Chassis terminal on the HMI device (example)

Equipotential bonding conductor cross-section: 4 mm2
Cabinet

Equipotential bonding conductor cross-section: min. 16 mm?2
Ground connection

Cable clip

Voltage bus

CEONCNGNONCHECNC)

Parallel routing of the equipotential bonding conductor and data cable

See also
Electromagnetic Compatibility (Page 2-4)

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting

4.3 Connecting the HMI Device

434 Connecting the Power Supply

Wiring diagram
The figure below illustrates the connection between the power supply and the HMI device.

I & e =N
TP 277
N &aeE=r o =H
poooooooOooOODODOODODODODDODOO
000000000000000000028 OP 277

Note when connecting

The power terminal block is included in the assembly kit. It is designed for conductors with a
maximum cross-section of 1.5 mmz2.

Connecting the Terminal Block

Notice
Damage

Do not tighten the screws of the terminal block if it is plugged in. The pressure from the
screwdriver may otherwise damage the HMI device socket.

Always remove the terminal block to connect the wires.

The following figure shows the connection of the HMI device to the power supply.
L GND
+24 VDC
Do not confuse the lines. Refer to the label for the contact pins on the rear of the HMI device.

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting

4.3 Connecting the HMI Device

Reverse Polarity Protection
The HMI device is equipped with a reverse polarity protection circuit.

Connecting the Power Supply

Caution
Safety isolation

Use only power supply units with safety isolation complying with IEC 60364-4-41 or
HD 384.04.41 (VDE 0100, Part 410), for example according to the PELV standard, for the
24 VVDC supply.

The supply voltage must be within the specified voltage range. Any other voltage might lead
to failure of the HMI device.

Applies to floating system design:

Connect the connection for GND 24 V from the 24 V power supply output to equipotential
bonding for uniform reference potential. For this purpose, choose a connecting point that is
as close as possible to the center.

See also
Ports (Page 4-5)

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting

4.3 Connecting the HMI Device

435 Connecting the PLC

Wiring diagram

The figure below illustrates the connection between the HMI device and the PLC.

I & e it
TP 277
Hom O =h
poooDOoDODOODODODODDODDODDOODOOOT D
000000000000000000001 OP 277
SIMATIC S7
PROFINET -
— SIMATIC S7
RS 485
>— SIMATIC S5
RS 485
>— SIMATIC 500/505
RS 485
>— SIMATIC 500/505
RS 422
PLC
— from other
RS 422/RS 485 manufacturers
PLC
RS 485 - )— from other
RS 232 manufacturers
PLC
RS 422 - — from other
RS 232 manufacturers
Notice

Always use the approved cables to connect a SIMATIC S7 PLC.

Standard cables are available for the connection. More information can be found in the
SIMATIC HMI catalog ST 80.

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting
4.3 Connecting the HMI Device

Connecting PROFINET

Notice

Use a cross-cable for the PROFINET connection when using a point-to-point connection.

Notice
PROFINET IO
If you use PROFINET 10 direct keys, connect the HMI device with a switch. For detailed

instructions regarding the installation of PROFINET networks, please refer to the PROFINET
system description manual.

Only connect the HMI device to public Ethernet networks using a switch or comparable
device.

Configuring the RS 422 / RS 485 Port

A DIP switch for the configuration of the RS 422 / RS 485 port is located on the rear of the
HMI device.

In the factory state, the DIP switch is set for communication with the SIMATIC S7 controller
via RS 485.

Note
Note the diagrams of the DIP switch settings on the back of the HMI device.

The following table shows the settings of the DIP switch. The transmitting and receiving
direction is switched internally with the RTS signal.

Communications | Switch setting Meaning
RS 485 4321 No RTS on plug, for data transfer between PLC and HMI

Hi ON device

(factory state)

IS
w
N

1 RTS on pin 4, same as PLC,
for example for commissioning

ON

4321 RTS on pin 9, same as programming device,
ON for example for commissioning

RS 422 4321 RS 422 port is enabled.
on

See also
Ports (Page 4-5)

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO 4-11



Mounting and Connecting

4.3 Connecting the HMI Device

4.3.6

Wiring Diagram

Connecting a Configuration PC

The figure below illustrates the connection between the HMI device and the configuration

PC.

iy

[l
I

TP 277
‘l EE=]i oP 277
noooooooO0O0OO0OOOODE
pooooDooOOOCODODODODODODOOCLOGRD
USB
PROFINET
RS 485 RS 485
RS 485
RS232 | RS232

— PC
—| PC
>— RE
— PC

Use a cross-cable for the PROFINET connection when using a point-to-point connection.
To use the RS 485/RS 232 port, order a PC/PPI cable from Siemens AG.

4-12

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting

4.3 Connecting the HMI Device

Configuring a PC/PPI Cable
Use the DIP switches to configure the transfer rate of the PC/PPI cable.

Note

If the connection fails during the operating system update, set the system to a lower bit rate.
If you wish to communicate at high bit rate, you must used a PC/PPI cable of version 3 or
later. The version code is printed on the cable (e.g. "E-Stand 3" corresponds to version 3).

O] DIP switch
® LEDs

Set the DIP switches 1 to 3 to the same value as in WinCC flexible. DIP switches 4 to 8 must
be set to "0".

 BOEERREE— o

12345

@ DIP switch

The following table shows the adjustable bit rates.

Bit rate in Kbps DIP switch 1 DIP switch 2 DIP switch 3
115.2 1 1 0
57.6 1 1 1
38.4 0 0 0
19.2 0 0 1
9.6 0 1 0
4.8 0 1 1
2.4 1 0 0
1.2 1 0 1

The figure shows a bit rate of 115.2 Kbps.

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting

4.3 Connecting the HMI Device

Note when connecting

See also

4.3.7

Notice
USB Host-to-Host Cable

Use only the driver for the USB host-to-host cable which is included in the WinCC flexible
package. Do not use the driver which is supplied with the USB host adapter.
Updating the operating system

If there is no serviceable HMI device image on the HMI device, you can only update the
operating system with a bootstrap. Use the RS 422 / RS 485 port with the PC/PPI cable on
the HMI device.

Ports (Page 4-5)

Accessories (Page 1-4)

Connect USB devices

The following devices can be connected to the USB port of the HMI device:
e External mouse
e External keyboard

e Printer

Note when connecting

See also

4-14

Notice
Connecting external devices to the USB port

If you wish to connect external devices with 230V power supply to the USB port, ensure that
the installation is non-isolated.

Notice
Rated Load of the Port

Adhere to the values for the maximum load of the USB port. The values can be found in the
Specifications section. If USB devices overload the port, malfunctions might occur.

Connecting the Power Supply (Page 4-8)
Ports (Page 4-5)

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting
4.3 Connecting the HMI Device

43.8 Connect a printer

Wiring diagram

The figure below illustrates the connection between the HMI device and the printer.

T
S , 1P 277

[
{0

—
—a

Hl &= o =H
pooDODOOODODODODDODOOODOOOG D
00000000000000000001]  5p 077

~ 7
uUsB
PC
PROFINET

Note when connecting

Notice

Always use cables with metal shielding braid which is grounded on both ends between the
printer and HMI device.

Use a cross-cable for the Ethernet connection when using a point-to-point connection.

Some printers may require the ASCII character set used in the project to also be defined on
the printer.

The list of current printers and required settings for HMI devices can be found on the Internet
under "http://support.automation.siemens.com/WW/view/en/11376409".

Observe the printer documentation when you connect the printer.

See also
Ports (Page 4-5)
Connect USB devices (Page 4-14)

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting

4.4 Swifching on and Testing the HMI Device

44

Procedure

4-16

Switching on and Testing the HMI Device

Proceed as follows:

1. Switch on the power supply.

The display lights up after power is switched on. A progress bar is displayed during
startup.

If the HMI device does not start, it is possible the wires on the terminal block have been
crossed. Check the connected wires and change the connections, if necessary. The
Loader is displayed once the operating system has started.

Transfer

Skart

Contraol
Panel

Taskbar

The HMI device automatically switches to "Transfer" mode during initial startup under the
following conditions:

— No project is loaded on the device.
— At least one data channel has been configured.

During this process the following dialog appears:

Transfer ... .

Connecting ko hosk ...

Canecel

2. Touch "Cancel" to stop the transfer.

TP 277, OP 277 (WinCC flexible)
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Mounting and Connecting

4.4 Swifching on and Testing the HMI Device

Result
The Loader appears again.

Note

When restarting the system, a project may already be loaded on the HMI device. The system
then skips "Transfer" mode and starts the project.

Use the relevant operator control to close the project.

Further information on this may be available in your plant documentation.

Function Test
Perform a function test following commissioning. The HMI device is in proper working order,
if
e The "Transfer" dialog is displayed.
e The Loader appears.

o A project is started.

Switching off the HMI Device
Terminate the project at the HMI device before switching it off.
You have the following options for switching off the HMI device:
o Switch off the power supply.
¢ Disconnect the terminal block from the HMI device.

TP 277, OP 277 (WinCC flexible)
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4.4 Swifching on and Testing the HMI Device

TP 277, OP 277 (WinCC flexible)
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Operator Controls and Displays 5

5.1 Front-Side Operator Controls

TP 277

0] Display with touch screen

The TP 277 is operated with the touch screen. All operator controls required for operator
input are displayed on the touch screen once the HMI has started.

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO
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Operaftor Controls and Displays

5.1 Front-Side Operator Controls

OP 277

Display

Function keys

Function keys with LED
System keys - control keys
System keys - cursor keys

®@ 00 0006

System keys - alphanumeric keys

The OP 277 is operated using the system keys and the function keys.

The function assigned to a specific function key is defined during configuration. The function
keys have no function before a project has been opened.

Note when operating

5-2

Notice
Unintentional actions

Do not carry out several operations simultaneously. You may otherwise trigger unintentional
actions.

e Operation using the touch screen:
Always touch only one operator control on the screen.
e Operation using the keys:

Do not press more than two keys simultaneously.

TP 277, OP 277 (WinCC flexible)
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Operator Controls and Displays

See also

5.2

Introduction

5.2 Using a Memory Card with the HMI device

Notice
Damaging to the touch screen

Never touch the touch screen with pointed or sharp objects. Avoid applying excessive
pressure to the touch screen with hard objects. Otherwise, the touch screen might fail, or its
useful life might be considerably reduced.

Always operate the HMI touch screen with your fingers or with a touch pen.
Damage to the keyboard
Only use your fingers to operate the HMI device keys.

Pressing the keys with hard instruments considerably reduces the service life of the key
mechanism.

Design of the HMI Device TP 277 (Page 1-2)
Design of the HMI Device OP 277 (Page 1-3)

Using a Memory Card with the HMI device

The following can be saved on the memory card of the HMI device:
e Logs

e Recipes

e Operating system

e Applications

e Additional specifications

The memory card can be inserted and removed during operation. D not remove the memory
card while data is being accessed by an application, e.g. during backup or recipe transfer.

Notice
Multimedia card

The Multimedia card of the SIMATIC S7 controller cannot be used.

TP 277, OP 277 (WinCC flexible)
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5.2 Using a Memory Card with the HMI device

Procedure - Inserting a Memory Card
Proceed as follows:

Insert the memory card into the memory card slot.

®

@
®
®

O @4@

Memory card interlock
Memory card
Memory card slot

When inserting the memory card, please note that it can only be inserted as shown in the
diagram. The memory card is inserted correctly in the memory card slot when the card
interlock engages.

Using a Memory Card for the First Time

Notice
Data loss

The first time you use a memory card the HMI device will request that you format the card.
Save a backup copy of memory card data to a PC beforehand.

Do
1.

2
3.
4

5-4

the following in order to prevent data loss:

Cancel the formatting procedure by pressing "ESC".

. Save a backup copy of data which must not be lost, to a PC.

Format the memory card on the HMI device.

. Transfer the backup data from the PC to the memory card.

You can now transfer the backup data from the memory card to the HMI device.

TP 277, OP 277 (WinCC flexible)
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5.2 Using a Memory Card with the HMI device

Procedure - Ejecting a Memory Card

Notice
Data loss

All data on the memory card is lost, if you attempt to remove it while the HMI device is
accessing its data.

Do not remove the memory card while data is being accessed. Observe the corresponding
alarms on the screen.

0] Eject button
Proceed as follows:
1. Press the ejection button.

This ejects the memory card out of the slot.

Notice
Do not force the ejector, as this could damage the eject mechanism.

2. Store the memory card in a safe place.

See also
Backup and Restore with the Memory Card (Page 6-45)

TP 277, OP 277 (WinCC flexible)
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5.3 Labeling the OP 277 Function Keys

5.3 Labeling the OP 277 Function Keys

Introduction

You can label the function keys as required for your project. Use labeling strips to do so.

Notice

Do not write on the keyboard to label the function keys.

Printing Labeling Strips

WinCC flexible comes with a range of labeling strip templates. For more information on the
filing location of the templates, refer to the WinCC flexible online help.

Any printable and writable foil can be used as labeling strips. You can use transparency film,
the keyboard membrane of the HMI device is printed on the reverse side. Use transparent
foil so that the LEDs of the function keys can be seen. Permitted thickness of the labeling
strip: 0.13 mm. Paper should not be used as labeling strips.

Labeling strip dimensions

80

14.5 2 x45°
16 _1
19.5 42.8 18 18 18 7.8
177
2 x45°
16
19.5 7.8

5-6
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Procedure

5.3 Labeling the OP 277 Function Keys

Proceed as follows:

1.

Edit and then print the template.
You can also print blank templates and label them manually.
Spray the labeling strips with mounting spray.

The mounting spray will ensure that the text will be water resistant and not smear, and
that the printer ink will not bleed onto the keyboard membrane.

Cut out the labeling strip.

Ensure that the corners are cut according to the diagram shown above as this makes it
easier to slide them into the guide.

. Remove any previously existing labeling strips.

Note
Wait for the printed labeling strips to dry before you insert them.

. Slide the labeling strips @ into the guide @®.

®
@

Slide the labeling strips into the guide up to the stop.

The labeling strip will protrude approximately 3 cm out of the guide. The template
dimensions for the labeling strips are designed so that the labeling is correctly placed for
the function keys. An interlock is not required for the labeling strips.

When mounting the HMI device, ensure that the labeling strips do not become jammed
between the mounting cut-out and the HMI device.

TP 277, OP 277 (WinCC flexible)
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5.3 Labeling the OP 277 Function Keys
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Configuring the Operating System

6.1 Loader

Loader
The figure below shows the Loader.

Transfer

Skark

Conkral
Panel

Taskbar

The Loader buttons have the following functions:
e Use the "Transfer" button to set the HMI device to "Transfer" mode.

The "Transfer" mode can only be activated, if at least one data channel is released for
transfer.

e Press the "Start" button to start the project on the HMI device.

If you do not perform an operation, the project on the HMI device will automatically start
after a delay.

e Press "Control Panel" to open the HMI device Control Panel.

The Control Panel is used to configure various settings such as the transfer settings.

TP 277, OP 277 (WinCC flexible)
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Configuring the Operating System

6.1 Loader

e Press "Taskbar" to activate the taskbar with the open Windows CE start menu:

Transfer

e | Communication *
Favorites L E Command Prompt
< Documents  * nféi Softkeyboard

B Settings ¥ | (&) windows Explorer

TasFOar
Tan. | ]
|Load... [ 5 1400

¥ WindowsCE

Open Loader
The following options are available to open the Loader:
e The Loader appears briefly after starting the HMI device.
e The Loader appears when the project is closed.

If configured, use the relevant operator control to close the project. Further information on
this may be available in your plant documentation.

Operating the Keys in the Loader
The table below shows the shortcut keys for navigation in the Loader.

Shortcut key Function

Iz' IZ' The next or previous entry is selected.

The selected button is operated.

ENTER

Password Protection

Notice

If the password is no longer available, you can cancel password protection by updating the
operating system. All data on the HMI device will be deleted when you update the operating
system.

You can protect the Control Panel and taskbar from unauthorized access. When password
protection is enabled, the message "password protect" is displayed in the Loader.

If the password is not entered, only the "Transfer" and "Start" buttons are operable.

This prevents inadvertent operations and increases security for the plant or machine. You
can then no longer change the settings outside the current project.

TP 277, OP 277 (WinCC flexible)
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Operating the Keys of the User Interface

6.1 Loader

The table below shows the shortcut keys for navigation in the user interface.

Shortcut key

Function

TR
+

The task bar is activated with the open
Windows CE start menu.

+

The next active program is displayed.

+

The Task Manager is opened.

Operating the Keys in the Explorer

The table below shows the shortcut keys for navigation in the Explorer.

(7))
=2
o
=3
(2]
c
=3
3
<

Function

TAB

e Toggles the active window.

e Toggles between the Windows CE Desktop
and the window.

-

Selects the first entry.

n
H H
+
™
m
o
4 »>
.H

+

Selects the last entry.

Selects everything, if the left LED of the key
lights up

Activates the menu bar.

n >
&
4

Changes to the parent level.

ALT CTR

+

Opens the context menu.

ALT

+
m
z
5
m
Bl [

Displays the properties.

See also

Changing Password Protection (Page 6-18)

Switching on and Testing the HMI Device (Page 4-16)

Configuring the Data Channel (Page 6-33)
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6.2 Control Panel

6.2 Control Panel

6.2.1 Overview

Control Panel of the HMI Device

g
E.

i

s

Backup/Re... Communic... Date/Time InputPanel

Password Fegianal
Settings
il T
1 s
S7-Transfer  ScreenSaver Systerm Transfar
Settings
WinCC
Internet IS
Settings -

2
Wi i

Metwork op

Kevboard

At the HMI device Control Panel, adjust the following:

Date/time
Screen saver
Regional settings
Transfer settings
Network settings

Delay time

TP 277, OP 277 (WinCC flexible)
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6.2 Control Panel

Opening the Control Panel
The Control Panel can be opened as follows:
e During the startup phase:
Press "Control Panel" to open the HMI device Control Panel in the Loader.
¢ In the current project:
Operate the control object provided for the respective task, if configured.

On HMI devices with key panel, you can open the Control Panel from the Windows CE start
menu.

1. Open the Windows CE start menu by pressing the key combination + .
2. Open the Control Panel with "Settings > Control Panel".

6.2.2 Reference

Overview of Functions
The table below shows the options for settings available at the Control Panel of the HMI

device.

Function

Tab / entry

Backup and Restore with the Memory Card

Setting the Device Name of the HMI Device

"Device Name"

Activating the Direct Connection

"PC Connection "

Setting the Date and Time "Date/Time"
Configuring the Screen Keyboard -

Setting the character repetition of the screen keyboard "Repeat”
Setting the Double-Click "Double-Click"
Changing the Network Configuration "Adapters"
Setting the IP Address Dialog "Onboard LAN Ethernet" |"IP Address"

via "Properties" button

Setting the Name Server Dialog "Onboard LAN Ethernet"

via "Properties" button

"Name Servers"

Changing the Logon Data

"Identification"

5%

Backing up Registry Information

"Persistent Storage"

Changing Screen Settings "Display"
Displaying Information about the HMI device "Device"
Booting the HMI device "Device"
Calibrating the Touch Screen 2) "Touch"

B

Changing Password Protection

"Password Settings"

TP 277, OP 277 (WinCC flexible)
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6.2 Control Panel

Symbol Function Tab / entry

ri;,@ Changing the Printer Properties -

]

Zooen Changing the PROFINET IO Setting -

@ Changing Regional Settings "Regional "
Changing the Number Format "Number "
Changing the Time Format "Time "
Changing the Date Format "Date "

Iﬂﬂ Changing MPI Settings "MPI"
Changing PROFIBUS Settings "PROFIBUS"
Setting the Screen Saver -

; '?‘i Displaying the System Information "General"

= Displaying Memory Information "Memory"

= Configuring the Data Channel "Channel"

L Setting the Delay Time "Directories"

='-'" Changing e-mail Settings 3 "Email"

= Changing Settings for Proxy Server "Proxy"

N No function

2) TP 277 only

3) The WinCC flexible Internet Settings" dialog may contain other tabs. This depends on the options that have been

enabled for network operation in the project.

6.2.3 Operating the Control Panel

6.2.3.1 Overview

Operator Control Options

The hardware of the HMI device determines which of the following operator control options
are available:

e Touch screen

The operator controls shown in the dialogs are touch-sensitive. Touch objects are
basically operated in the same way as mechanical keys. You activate operator controls
by touching them with your finger. To double-click them, touch an operator control twice
in succession.

e HMI-device keyboard

The operator controls shown in the dialogs are selected and operated using the keys of
the HMI device.

e External USB keyboard

e External USB mouse

TP 277, OP 277 (WinCC flexible)
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6.2 Control Panel

Input with an External Keyboard

An external keyboard can be used to operate the Control Panel in exactly the same way as
the HMI device keyboard. Use the keys of the external keyboard which correspond to the
HMI keys in the description.

Operation with an External Mouse

An external mouse can be used to operate the Control Panel in exactly the same way as the
HMI-device touch screen. Click the described operator controls with the mouse.

6.2.3.2 Input with the Touch Screen

Introduction
The Control Panel is operated with the HMI-device touch screen.

Procedure
Proceed as follows to change settings in the Control Panel:
1. Close the project.

Use the provided operator control.

The Loader appears.

Open the Control Panel by clicking "Control Panel".

To open the required dialog, double-click its symbol.

Change as required by touching the tab.

o~ DN

Now make the necessary changes.

Touch the respective input object to make entries.

— Use the screen keyboard of the HMI device to enter the new values in the input fields.
— Touch a button to operate it.

— Touch the selection field to open a drop-down list. Touch the required entry from the
drop-down list.

— Touch the check box to activate or deactivate a check box.
— Touch a radio button to select it.

6. Confirm your entry by clicking or discard your entry by clicking .
The dialog closes.

7. Close the Control Panel by clicking [x].

8. Start the project by clicking "Start" in the Loader.

TP 277, OP 277 (WinCC flexible)
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6.2 Control Panel

Input with the Screen Keyboard

A special screen keyboard is available to enter information outside the open project, for
example, in the Control Panel. The screen keyboard is displayed as soon as you touch an
input field. You can also call the screen keyboard directly in the Control Panel.

Display Methods for the Screen Keyboard
You can change the display method for the screen keyboard and fix the position on the
screen. Confirm your entries with or discard your entries with . Either action closes
the screen keyboard.

e Numerical screen keyboard

g [o[]_]

7
4 15| 6 [Mum +
1

2| 3| -»m|ESC

o|-1.|+|*»

e Alphanumerical screen keyboard

J1fz]3]+[s]e]7]e]a]o]- [-[-[&_]
i L] -

Murl g [wle|r |ty |ulilolp|l]]
tlals|d|lflalh|ilk]|!I]:]|"']|=]|*|E3C
clfy z|x|c|w|b|ln|im|,|. |f +|+|+

The alphanumerical screen keyboard has several levels:
— Normal level
— Shift level

Reduced screen keyboard

Changing the display of the screen keyboard

Function

>
<

Switching between the numerical and alphanumerical keyboard

=

Switching between the normal level and Shift level of the alphanumerical screen
keyboard

Activation and deactivation of the numerical and alphanumerical keys of the
alphanumerical screen keyboard

8]

2| ElE

Switching from full display to reduced display

Switching from reduced display to full display

Closing of reduced display of the screen keyboard

B & i

TP 277, OP 277 (WinCC flexible)
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6.2 Control Panel

Moving the Screen Keyboard
To move the screen keyboard:

1. Touch the |

2. Touch and move the screen keyboard on the touch screen.

o

Release the |z

symbol when the required position is reached.

See also
Configuring the Screen Keyboard (Page 6-12)
Front-Side Operator Controls (Page 5-1)

6.2.3.3 Input with the Keyboard

Introduction
The Control Panel is operated with the system keys of the HMI.

Procedure
Proceed as follows to change settings in the Control Panel:
1. Close the project.
Use the provided operator control.
2. Open the Control Panel.
The Loader appears.

— Select the ""Control Panel™ button in the Loader using the cursor keys.

— Press

The Control Panel is opened.

3. Select the symbol of the required dialog with the cursor keys.
4. Press to open the dialog.

5. Change the tab as required.

Press until the name of the tab is selected. Now switch to the other tabs using the

cursor keys.

TP 277, OP 277 (WinCC flexible)
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6.2 Control Panel

Control Keys

. Press to return to the input area and make the necessary changes.

Select the respective input object by pressing the key to make entries.

Use the system keys of the HMI device to enter the new values in the input fields.

— To operate a button, select the button with the cursor keys and then press .

— Open the drop-down lists with the hotkeys + Izl
Select the required entry from the drop-down list using the cursor keys.

Confirm the selected entry by pressing .

{ }
— Press to activate or deactivate a check box.

— Select a radio button of a group using the cursor keys.

. Confirm your entries with or discard your entries with .

If you have selected an input object, you first have to complete entry.

The dialog closes.

8. Close the Control Panel.

Press . This opens the Control Panel menu.

— Select the "Close" entry using the cursor keys.

— Press

ENTER

The Loader appears.
9. Start the project.
— Select the "Start" button in the Loader using the cursor keys.

— Press

ENTER

The project is started.

The tables below show the control keys used to operate the Control Panel.

Selecting operator controls

Key

Function

Description

TAB

SHIFT| 4 | TAB

Tabulator

Selects the next or previous operator control in the
tab sequence.

«]»]

[v]a]

Cursor keys

Selects the next operator control, to the left or right
of, above or below the current screen object.

Navigates in the operator control.

TP 277, OP 277 (WinCC flexible)
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6.2 Confrol Panel
Operating operator controls
Key Function Description
4 Scroll back Scrolls one page back in a list.
HOME
4 Scroll to the beginning Scrolls in a list to the beginning.
+ |[HOME
Scroll forward Scrolls one page forward in a list.
END
Scroll to the end Scrolls in a list to the end.
.
EnTER ENTER key e Operates the selected button.
e Applies and closes the entry.
Esc Cancel e Deletes the input characters of a value and
restores the original value.
¢ Closes the active dialog.
Delete characters Deletes the character to the right of the current
cursor position.
Delete characters Deletes the character to the left of the current
cursor position.
arl Iz' Open the list box. Opens a list box.
. Apply value Accepts the selected value in the list box without
CTRL ENTER . .
+ closing the list.
Entering hotkeys
Key Function Purpose
Toggle key assignment Toggles the assignment for a key with multiple
assignment.
e NoLEDis lit:

The number assignment is enabled. Pressing
the button once toggles to letter assignment.

e AnLED is lit:

The left or right letter assignment is enabled.

Each time the key is pressed, the system toggles
among the left letter assignment, the right letter
assignment and the number assignment.

Toggle between uppercase | Use in key combinations, for example, for entering
and lowercase uppercase letters

Switch to additional key Some of the keys contain a blue imprinted key
assignment assignment , for example the "%" character.

Use in hotkeys for the blue key assignment.

— General control functions Use in hotkeys.

.

AT General control functions Use in hotkeys.

TP 277, OP 277 (WinCC flexible)
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6.3 Changing settings for Operation

See also
Front-Side Operator Controls (Page 5-1)

6.3 Changing settings for Operation

6.3.1 Configuring the Screen Keyboard

Introduction

Configure the appearance and position of the screen keyboard which is used for making
entries outside the open project.

Requirements

You have opened the "Siemens HMI InputPanel - Options" dialog with the "InputPanel"

button.

Siemens HMI Input Panel - Options m

£ Position and Size

% Currently close...

Open Input Panel I @

I @

0] Button for displaying the screen keyboard
® Button for saving the screen keyboard settings

TP 277, OP 277 (WinCC flexible)
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Procedure

Result

See also

6.3 Changing settings for Operation

Proceed as follows:

1.

2

Display the screen keyboard with the "Open Input Panel" button.
The "Siemens HMI Input Panel — Options" dialog changes its appearance.

Siemens HMI Input Panel - Options m

£#  Position and Size

. Currently open...

Cloze Input Panel I @

Save current size and position. ..

Save I @

©) Button for closing the screen keyboard
® Button for saving the screen keyboard settings

Click the key on the screen keyboard to toggle between the numerical and
alphanumerical keyboard.

Set the position of the screen keyboard by moving the screen keyboard on the screen.
Touch the "Save" button to save the settings.

Click the "Close Input Panel" button to close the screen keyboard.

Close the dialog.

The screen keyboard settings have been modified.

Input with the Touch Screen (Page 6-7)
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6.3.2 Setting the carachter repetition of the keyboard

Introduction
You can set the character repeat for the keyboard or screen keyboard in the Control Panel.

Requirement

You have opened the "Keyboard Properties" dialog by clicking "Keyboard " .

Keyboard Properties m

Repeat l
|7 cnable character repeat
[ Repeat delay: Long . Short )
q < — — >
)

[ Repeat rake:  Slow Fast )

A0 [y iy S )

Tap here and hold down a ke to

566 &

Check box for activating the character repeat

Slider control and buttons for the delay time before character repeat
Slider control and buttons for the rate of the character repeat

Test field

® e 00

Procedure
Proceed as follows:
1. Activate the "Enable character repeat" check box to enable the character repeat.

2. Use the buttons to set the delay and rate of the character repeat. You can also use the
slider control for this.

3. Verify your settings.
For HMI devices with touch screen operation.
— Touch the test field. The screen keyboard opens.
— Move the screen keyboard as needed.
— Touch any character and keep it pressed.
— Check the character repetition and the rate of the character repetition in the test field.

— Correct your setting if necessary.

TP 277, OP 277 (WinCC flexible)
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6.3 Changing settings for Operation

For HMI devices with key operation.
— Touch the test field.
— Press and hold an alphanumerical key.
— Check the character repetition and the rate of the character repetition in the test field.
— Correct your setting if necessary.
4. Confirm your entries.

The dialog closes.

Result
The character repeat for the keyboard is now set.

6.3.3 Setting the double-click

Introduction

You can start applications in the Control Panel and in Windows CE with a double-click. A
double-click is two brief touches in sequence.

In the "Mouse Properties" dialog, make the following adjustments for touch screen operation
and operation with external mouse:

¢ |nterval between touch contacts on the touch screen

e Interval between mouse clicks

Requirements
The "Mouse Properties" dialog has been opened with the "Mouse" %) button.

Double-Click |

Daouble-click this grid to set the double-click
sensitivity For both the speed and physical N
diskance bebween clicks,

Double-click this icon to test vour double-click,
settings. IF this icon doesn't change, adjust
wour settings using the grid abowe.

I

©) Pattern
® Symbol
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6.3 Changing settings for Operation

Procedure
Proceed as follows:
1. Double-click the pattern twice.

After one double-click the pattern is shown in inverse colors.

=

2. Double-click the symbol twice.
If the double-click is valid, the symbol is displayed as follows at the second click:

3. If the symbol remains unchanged, double-click the pattern again.
4. Confirm your entries.

The dialog closes.

Result
The double-click adjustment is completed.

6.34 Calibrating the Touch Screen

Introduction

Depending on the mounting position and viewing angle, it is possible that parallax may occur
when operating the touch screen. In order to prevent any operating errors as a result,
calibrate the touch screen again in the startup phase or during runtime.

Requirement

The "OP Properties" dialog, "Touch" tab, has been opened with the "OP" 4@ button.

Persistent Storage l Display l Device  Touch l

If wour windows CE device is not responding

:Trf/ propetly ko your kaps, you may need to

recalibrate yvour screen,

To start, kap Recalibrate,

Recalibrate @

0] Button for calibrating the touch screen
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Procedure
Proceed as follows:
1. Touch the "Recalibrate" button to open the following dialog:
Carefully press and briefly hold stylus on the center of
the target. Repeat as the target moves around the screen.
+ @
2. Briefly touch the middle of the calibration crosshairs @.
The calibration crosshairs is then displayed at four more positions. Touch the middle of
the calibration crosshairs for each position. If you do not touch the middle of the
calibration crosshairs, the procedure is repeated.
Once you have touched the calibration crosshairs for all positions, the following dialog
appears:
New calibration settings have been measured.
Tape the screen to register saved data.
Wait for 30 seconds to cancel saved data and
keep the current setting.
Time limit: 30 sec
3. Touch the screen within 30 seconds.
The new calibration is saved. If you wait longer than 30 seconds, the new calibration is
discarded and the original calibration remains in effect.
The "OP Properties" dialog , "Touch" tab is displayed again.
4. Close the dialog.
Result

The HMI device touch screen is now recalibrated.
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6.4 Changing Password Protection

6.4 Changing Password Protection

Introduction

Requirements

You can protect the Control Panel and Windows CE taskbar with a password.

The "Password Properties" dialog has been opened with the "Password " % button.

Password Properties m

Password Settings l

Password

%1\ Password: @
Confirm password: @

0] Password input field
® Input field for entering the password a second time

Notice

If the password is no longer available, you cannot do the following until you have updated
the operating system.

e Making changes to the Control Panel
e Operating the Windows CE task bar

All data on the HMI device will be overwritten when you update the operating system!

Procedure - Activating Password Protection

Result

6-18

Proceed as follows:

1. Enter a password in the "Password" input field.

2. Repeat the password entry in the "Confirm Password" input field.
3. Apply your entries.

The dialog closes.

Notice
The following characters cannot be used in passwords:
e Space character

e Special characters *? . % /\'"

You cannot open the Control Panel or Windows CE taskbar without entering a password.
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6.5 Changing HMI Device Settings

Procedure — Deactivating Password Protection
Proceed as follows:
1. Delete the entries in the "Password" and "Confirm Password" input fields.
2. Apply your entries.

The dialog closes.

Result
Password protection for the Control Panel and Windows CE taskbar is disabled.

6.5 Changing HMI Device Settings

6.5.1 Setting the Date and Time

Introduction

You can set the date and time on the HMI device. The HMI device must be restarted in the
following cases:

¢ You have changed the time zone setting.

¢ You have changed the setting of the "Daylight savings time currently in effect" check box .

Requirement

The "Date/Time Properties" dialog has been opened with the "Date/Time Properties" EIQQJ
button.
Datef Time l

Time Zone |(GMT) Greenwich Mean Time : Dublin, EdinblLl—

n Januar 2006 “ Current Time

MDMDTF 5 5 | |06:0%28 =

1
2 3 4 5 B 7 & - - -
Davylight savings kime
910 11 12 13 14 13 l—currentlyineffect
16 17 18 19 20 21 22
23 24 B e 27 28 29
a0 3t

5

apphy L
0] Time zone
® Time
® Date
@ "Daylight saving" check box
® Button for saving changes
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Procedure

Result

Proceed as follows:

1.
2.

Select the appropriate time zone for the HMI device in the "Time Zone" selection field.
Touch the "Apply" button to confirm your entry.

The time of day shown in the "Current Time" field is adjusted correspondingly to the
selected time zone.

Set the date in the selection field.

4. Set the current time of day in the "Current Time" input field.

5. If you wish to switch between daylight saving/standard time:

— Activate the ™Daylight savings time currently in effect”" check box.
— Touch the "Apply" button to confirm your entries.

The time is automatically adjusted by one hour on the respective days.
Touch the "Apply" button to confirm your entries.

The values you have set are now in effect.

Confirm your entries.

The dialog closes.

The settings for the date and time of day have now been changed.

Synchronizing the Date and Time with the Controller

The date and time of the HMI device can be synchronized with the controller if this has been
configured in the project and the controller program.

See also

6-20

Further information on this subject is available in the "WinCC flexible" system manual.

Notice

You have to synchronize the date and time when time-controlled responses are triggered in
the PLC by the HMI device.

Restarting the HMI Device (Page 6-26)
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6.5 Changing HMI Device Settings

6.5.2 Changing Regional Settings

Introduction

The display format of the date, time and decimal numbers etc. differ from region to region.
You can adjust the display format to meet the requirements of different regions.

The country-specific settings apply to the current project. If the project language is changed,
the country-specific settings are also changed.

Requirement

The "Regional Settings Properties" dialog has been opened with the "Regional Settings" @

button.
Regional Settings Properties m
Regional I Turnber ] Tirne ] Date l

Many programs support
s international settings, Changing
@ Regional Settings affects the way
these programs display and sort
dates, times, and numbers,

Reqgion: |German (Standard) L:_—®

0] Region selection box

Procedure
Proceed as follows:
1. Select the region in the "Region" selection box.

2. Change to the "Number", "Time" and "Date" tabs and make the required settings in the
selection fields.

3. Confirm your entries.

The dialog closes.

Result
The HMI regional settings have been changed.
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6.5.3 Backing up Registry Information

Registry Information and Temporary Data

You can install and uninstall your own programs on the HMI devices under Windows CE.
You must save the registry settings after installation or uninstallation.

You can save the following data to the flash memory:
o Registry information

e Temporary files

Restoring the File System of a Memory Card

Requirements

6-22

If memory cards are used, the file system on the memory card may be become damaged,
perhaps due to a power failure. The HMI device detects the defective file system on start-up
or when the memory card is inserted. The HMI device can restore the file system
automatically or on request.

The "OP Properties" dialog, "Persistent Storage" tab, has been opened with the “OP“éé

button.

Display l Device l Touch ]

Save actual registry settings to Flash,
System will start with saved regiskry Save Fegistry
sekkings nexk time.,

Save all files from kemporary memory
(&.g. the "\Program Files' directary) ko Sawe Files
flash. The files will be restored during
system starkup, The 1 Temp' directary

will nat be saved. e |

N Autornatically repair File swstem errors on storage
cards at syskem starbup and card insertion kime

@ Meaning of the text in the dialog:

Saves the current registry information to the flash memory. The HMI device loads the saved
registry information the next time it boots.

Button for saving registry information
Button for saving temporary files

® e 6

Meaning of the text in the dialog:

Saves all the files in temporary storage to the flash memory (for example, from the "Program
Files" directory). These files are written back when the HMI device is started. The "\Temp"
directory is not saved.

® Check box for automatically restoring the file system on the memory card when the HMI
device starts up and when a memory card is inserted.
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Procedure

Result

6.5.4

Introduction

6.5 Changing HMI Device Settings

Proceed as follows:
1. Select the "Save Registry" button to save the current registry settings.
2. Select the "Save Files" button to save temporary files.
3. Specify how the file system on the memory card should be restored.
— Activate the check box "Automatically Repair ..." to activate automatic restore.

— Deactivate the check box "Automatically Repair ..." if you wish to have the files system
restored only upon prompting.

4. Confirm your entries.

The dialog closes.

The HMI device uses the saved registry information the next time it starts. The temporary
files are copied back.

Setting the Screen Saver

You can set a period of time for automatic activation of the screen saver on the HMI device.
The screen saver is automatically activated if the HMI device is not operated within the
specified period of time.

The screen saver is deactivated when any key is pressed or when the touch screen is
touched. The function assigned to that operator control is not triggered.

Notice
Activating the Screen Saver

You should always activate the screen saver. Otherwise, the screen contents may leave a
burn-in effect in the background if they appear too long.

This effect is reversible.

TP 277, OP 277 (WinCC flexible)
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Requirements

Procedure

Result

You have opened the "Screen saver" dialog with the "ScreenSaver" I!\ button.

Screensaver m

Screensaver becomes active afker E — | _minutes @
=
(@ Standard () Blank Screen) @

Enter & 0" to disable the Function.
The minimum kime is 5 and the macximum is 71582 minutes,

O] Period of time in minutes before the screen is activated
® Screen saver setting

Proceed as follows:
1. Enter the number of minutes before the screen saver is to be activated.
The minimum time is 5 minutes and the maximum time is 71582 minutes.
Alternatively, deactivate the screen saver with entry "0".
2. Select either the standard screen saver or an empty screen.
— Select the "Standard" check box to activate the screen saver.
— Select the "Blank Screen" check box to activate a blank screen as the screen saver.
3. Confirm your entries.

The dialog closes.

The screen saver for the HMI device has now been set.

6.5.5 Changing the Printer Properties

Introduction

6-24

HMI devices can print on local printers or network printers. You can print hardcopies and
logs on a network printer. Line printing of messages is not possible on a network printer.

The list of current printers and required settings for HMI devices can be found on the Internet
under "http://support.automation.siemens.com/WW/view/en/11376409".

TP 277, OP 277 (WinCC flexible)
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Requirement

You have opened the "Printer Properties” dialog with the "Printer";

6.5 Changing HMI Device Settings

cp button.

Printer Properties m

Printer Language: |Epsnn9

|
=

Paort: |Network: —————{ : )
Mebwork: |'l,'l,server32'|,printer01 —@
Paper Size: |P.4 L:—4@
Orientation

@) Portrait () Landscape —l—@

[ ] oraft Mode [] - { : )

Procedure

®@e 606000

Printer selection field

Port

Network address of the printer
Paper size selection field
Orientation setting

Print quality setting

Proceed as follows:

1.
2.
3.

Select the printer in the "Printer Language" selection field.
Select the port for the printer in the "Port" selection field.

If you are printing over the network, enter the network address of the printer in the
"Network:" field.

Select the paper format in the "Paper Size" selection field.

5. Activated the required radio button in the "Orientation" group:

Result

"Portrait" for vertical format
"Landscape" for horizontal format
Select the print quality.
— Select the check box "Draft Mode" if you wish to print a draft.
— Deactivate the check box "Draft Mode" if you wish to print with higher quality.
Set the color mode.
— Select the check box "Color" if you wish to print in color.
Confirm your entries.

The dialog closes.

The settings for the printer have now been changed.

TP 277, OP 277 (WinCC flexible)
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6.5.6 Restarting the HMI Device

Introduction

VAN

Requirement

Procedure

Result

See also

6-26

The HMI device must be restarted in the following cases:

¢ You have changed the network settings.

¢ You have activated or deactivated the PROFINET IO direct keys.
¢ You have changed the time zone setting.

¢ You have changed the automatic daylight savings and standard setting.

Caution
Data loss when the HMI device is restarted

All volatile data is lost when the HMI device is rebooted.
Check the following:
e The project on the HMI device is not open.

o No data is being written to the flash memory.

You have opened the "OP Properties" dialog with the "OP" icon.

1. Change to the "Device" tab in the "OP Properties" dialog.
2. Restart the HMI device by selecting "Reboot".
A warning is displayed.

The HMI device reboots immediately if you confirm this warning.

The HMI device starts.

Enabling PROFINET IO (Page 6-36)
Overview of Network Operation (Page 6-37)
Setting the Date and Time (Page 6-19)
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6.5.7 Displaying Information about the HMI Device

Introduction
OP 270 information required when you contact A&D Technical Support.

Requirement

The "Device" tab of the "OP Properties" dialog has been opened with the "OP" 6@ button.
The following figure shows the "Device" tab of the "OP Properties" dialog of OP 277.

Persistent St Displ Devi
erslisten arage l ISplay EVICE l //@
Device: op 277 6" @
Image w01.00.00.00_01.14 —
Bootloader 0.05 @
Bootloader Rel Date: 10.1.2006 @
Flashsize: 32 MB
AsnsIZe \\@
MAC-Address: 08-00-06-29-d7-17
\
— T ®
O
0] HMI device name
® Version of the HMI device image
® Version of the boot loader
® Boot loader release date
® Size of the internal flash memory in which the HMI device image and project are stored
® MAC address of the HMI device
@ Button for restarting the HMI device

Procedure
Proceed as follows:
1. The device-specific information is displayed in the "Device" tab.

2. Close the dialog when the information is no longer required.

Note

The size of the internal flash memory does not correspond to the available working
memory for a project.
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6.5.8 Displaying System Properties

Introduction

The system-specific information provides you with information about the processor,
operating system and memory of the HMI device.

Requirements

The "System Properties" dialog has been opened with the "System" button.

Systemn Properties m

General I IEmnary l

MicrosoftE WindowsE CE
Version 3.0 (Build 126)
Copyright @ 1996-2000 Micrasoft Carp. All —®
rights reserved, This compuker program is
protected by U.5. and international copyright

Processar: ARM 920 ]
Memary: 48003 KB RaM @
Expansion card: J

Expansion card:
Reqgistered ka:

® Copyright to Microsoft Windows CE

® Information about the processor, size of the internal flash memory, and capacity of a memory
card when inserted

Displaying the system information
The system information is displayed. This dialog is read-only.

Close the dialog.

Procedure - Displaying Memory Information

Notice
"Memory" Tab

Do not change the memory distribution in the "Memory" tab.

TP 277, OP 277 (WinCC flexible)
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Proceed as follows:
1. Change to the "Memory" tab.

The memory information is displayed.

System Properties

Move slider ko the left For more memory to run programs,
Mowe it ko the right For more storage space,

Only unused RAM (blue portion of the slider bar) can be
adjusted.

Skorage Program
TNETNOFY MEMOrYy
S12kE  total 47496KE total

J32KE  inuse 3096KE  inuse

2. Close the dialog.

6.6 Setting the Delay Time

Introduction

Requirement

button.

Channel | Directories l

Project File lyx/v
|'|,FIash'l,Simatic'l, IS _

Project Backup

|'I,Stnrage Card MMC\Simatic),

Autostart application:

©

9

Path: Wit [sec]:

|'|,FIash'|,Simatic'l,HmiRTm.exe |3 =y

[r—]

Directory where the project file is saved

®© O

6.6 Setting the Delay Time

The project is opened following a delay time when the HMI device is switched on. The
Loader is displayed during the delay time.

=
The "Transfer Settings" dialog, "Directories" tab, has been opened with the "Transfer" s

Directory where the compressed source file of your project is saved

The external memory card or the network connection can be defined as the storage location.
During the next backup process, the project's source file is stored in the specified location.

Storage location and initialization file of the HMI device for process mode

Selection field for the delay time

TP 277, OP 277 (WinCC flexible)
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Notice
Settings in "Project File" and "Path"

Do not change the setting in the "Project File" and "Path" fields. The project may not open at
the next start of the HMI device if changes are made here.

Procedure - Setting the Delay Time
1. Select the desired delay time in seconds in the "Wait [sec]" selection field.

With the value "0", the project starts immediately. It is then no longer possible to call the
Loader after switching on the HMI device. If you still wish to access the Loader, an
operator control must be configured to close the project.

2. Confirm your entries.

The dialog closes.

Result
The delay time for the HMI device is now set.

6.7 Changing Communication Settings

6.7.1 Changing MPI/PROFIBUS DP Settings

Introduction

The communication settings for MPI or PROFIBUS DP are defined in the HMI-device project.
In the following cases, the communication settings might have to be changed:

e The first time the project is transferred

e If changes are made to the project but are only applied later

TP 277, OP 277 (WinCC flexible)
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Notice
Transfer Mode Using MPI/PROFIBUS DP

The bus parameters are read from the project currently loaded on the HMI device.

The settings for MPI/PROFIBUS DP transfer can be modified. The following steps are
required:

o Close the project.

e Change the settings on the HMI device.

e Then return to "Transfer" mode.

The changed MP/PROFIBUS DP settings will be overwritten in the following cases:
e The project is started again.

e A project is transferred.

Transfer settings

A project can only be transferred from the configuration computer to the HMI device when
at least one of the data channels is enabled on the HMI device.

If the HMI device is in "Transfer" mode while changes are made to the transfer settings,
the settings only go into effect after the transfer function is restarted.

Requirement

The "S7-Transfer Settings" dialog has been opened with the "S7-Transfer Settings" jﬂ

button.

S7-Transfer Settings m

W——@
—®

‘ Propetties. .. ——

©) Network selection
® Button for opening the properties dialog
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Procedure

6-32

Proceed as follows:

1.
2.

Select a network.
Open the "MPI" or "PROFIBUS" dialog with the "Properties" button:

MPI

Station Parameters

o] x|

[ Panel is the only master on the bus

Address: 1

Time-out: 1s

—

Mebwark Parameters

Transmission Rake: 187,5 kbits's 5

Highest Skation 126 [

Station Parameters

[ Panel is the only master on the bus

@ ©@ |0

®

Address: 45
Tirme-ouk: 1s =

Mebwark Parameters

Transmission Rake: 12 Mhikss =

®

@

Highest Station Address: |126
oP

Ll

Profile

|

Eus Parameters..

O®®®®e 00

The HMI device is the only master on the bus.

Bus address of the HMI device
Time-out

Data transmission rate in total network
Highest station address in the network

Profile

OONORONO

Button for displaying the bus parameters

If more masters are connected to the bus, deactivate the check box "Panel is the only
master on the bus".

Enter the bus address for the HMI device in the "Address" input field.

Notice

The bus address in the "Address" input field must be unique throughout the
MPI/PROFIBUS DP network.

5. Select the transmission rate in the "Transmission rate" input field.

6. Select the highest station address on the bus in the "Highest Station Address" or "Highest
Station" field.

TP 277, OP 277 (WinCC flexible)
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6.7 Changing Communication Settings

7. Select the desired profile from the "Profile" selection field.

8. The profile information is displayed when you select "Bus Parameters" button in the
PROFIBUS dialog. The "Profile" dialog is read-only.

Notice
The bus parameters must be the same for all stations in the MPI/PROFIBUS DP network.

Tslot: 300 Bt Troy: 11 it

Min Tsdr: 11 Bt | | Tidi: 37 1Bt
Max Tadr: 150 iBit | | Tidz: 130 Bit
Teet: 1 1Bit
Tqui: 0 iBit
Gap factor 10
Retry limit: 1

9. Close the "Profile” dialog.
10. Confirm your entries in the "MPI" or "PROFIBUS" dialog.

The dialog closes.

Result
The MPI/PROFIBUS DP settings of the HMI device have been changed.

6.7.2 Configuring the Data Channel

Introduction

If you block all data channels, the HMI device is protected against unintentional overwriting
of the project data and HMI device image.

Note

A project can only be transferred from the configuration computer to the HMI device when at
least one of the data channels is enabled on the HMI device.

TP 277, OP 277 (WinCC flexible)
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Requirement

Procedure

6-34

=
The "Transfer Settings" dialog has been opened with the "Transfer Settings" ¢ button.

Zhannel I Directories ]

Channel 1: @

Serial: [ ] Enable Channel

-

Channel 2:
@
ETHERMET |w | [w| Enable channel
Advanced @

[ Remote Contral

0] Group for data channel 1 (Channel 1)
® Group for data channel 2 (Channel 2)
® Button for the "MPI/DP - Transfer Settings" dialog or "Network Configuration"

Note
"Remote Control" for Channel 1

Only select the "Remote Control" check box in the "Channel 1" group, if serial transfer is in
progress. Clear the check box before changing to "Online" mode.

Proceed as follows:

1. Activate the required data channel with the respective "Enable Channel" check box in the
"Channel 1" or "Channel 2" group.

In the "Channel 1" group, the RS 422/RS 485 port is configured for the serial data
transfer.

— Activate the "Enable Channel" check box to enable the data channel.

— Deactivate the "Enable Channel" check box to lock the data channel.

2. Enable automatic transfer by activating the respective "Remote Control" check box in the

"Channel 1" or "Channel 2" group.

Warning
Unintentional Transfer Mode
Ensure that the configuration computer does not inadvertently switch the HMI device to

transfer mode during the open project. This could cause unintentional actions to be
triggered in the plant.
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3. Select the required protocol for "Channel 2" in the selection field.
4. Enter further parameters if required.
— Applies to "MPI/PROFIBUS DP":

Select the "Advanced" button if you wish to switch to the "S7-Transfer Settings" dialog.
You can change the settings for MPI/PROFIBUS DP there.

Confirm your entries.
The "S7-Transfer Settings" dialog closes.
— Applies to "ETHERNET":

Select the "Advanced" button if you wish to switch to the Network Configuration"
dialog. You can change the TCP/IP settings there.

Confirm your entries.
The "Network Configuration" dialog closes.
— Applies to "USB"
No further settings are required for "USB".
5. Confirm your entries.

The "Transfer Settings" dialog closes.

Result
The data channel is configured.

General Information

Note
Making Changes in "Transfer" Mode

If the HMI device is in "Transfer" mode while changes are made to the transfer settings, the
settings only go into effect after the transfer function is restarted.

This may occur if the Control Panel is opened to change the transfer properties in an active
project.

Notice
Transfer Mode via Channel 2

The bus parameters, for example HMI-device address, are read from the project currently
loaded on the HMI device.

You can change the settings for the transfer via Channel 2.
The following steps are required:

¢ Close the project.

e Change the settings on the HMI device.

e Then return to "Transfer" mode.

The next time the project is started on the HMI device, the settings will be overwritten by the
values from the project.
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See also

Changing MPI/PROFIBUS DP Settings (Page 6-30)
Changing the Network Configuration (Page 6-40)

6.7.3 Enabling PROFINET 10

PROFINET 10

Requirement

Procedure

6-36

If the HMI device is connected to the PLC via PROFINET, function keys or buttons, for
example, can be configured as PROFINET 10 direct keys. If PROFINET IO direct keys are
used in the project, they must be enabled.

Note

If you enable PROFINET IO direct keys, you cannot use the RS 422/RS 485 port for serial
communication.

PROFINET IO direct keys and PROFIBUS DP direct keys are mutually exclusive.

You have opened the "PROFINET" dialog with the "PROFINET" atece button.

W] PROFINET 10 enabled Soous @

Device name: (max, 255 characters)

|HMI—PanE| ——@
MAC-Adress: 08-00-06-2B-AC-93 —@

0] Check box for enabling or locking the PROFINET 10 direct keys
® Input field for the device name
® MAC address of the HMI device

1. Select the "PROFINET IO enabled" check box to enable PROFINET 10O direct keys.

2. Enter the device name of the HMI.

Notice

The device name must match the device name entered in the HW Config of STEP 7. This
device name is not the device name under Windows CE.

3. Confirm your entries.
The dialog closes.

4. Reboot the HMI after saving the settings.
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Result

See also

6.8

6.8.1

Introduction

Addressing

6.8 Configuring Network Operation

The PROFINET IO direct keys are enabled.

Restarting the HMI Device (Page 6-26)

Configuring Network Operation

Overview of Network Operation

Connect the HMI device to the PROFINET network, using the Ethernet port.
Connection to a network can offer the following advantages:

e Printing via a network printer

e Saving, exporting and importing recipe data records to or from a server
¢ Setting up of message and data archives

o Transferring projects

e Backing up data

If the HMI device is connected to a PC via a direct connection, you can only use the
peripheral equipment connected to the PC.

Notice
The HMI device can only be used in PROFINET networks.

The HMI device only has client functionality in the PC network. This means that users can
access files of a node with TCP/IP server functionality from the HMI device via the network.
However, it is not possible to access files on the HMI device via the network from a PC.

Note

Information on communication using SIMATIC S7 via PROFINET is provided in the "WinCC
flexible Communication" user manual.

Within a PROFINET network, computers are usually addressed using network names. These
network names are translated from a DNS or WINS server to TCP/IP addresses. This is why
a DNS or WINS server is needed for addressing via device names when the HMI device is in
a PROFINET network.

Appropriate servers are usually available in PROFINET networks.
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Note
The use of TCP/IP addresses to address PCs is not supported by the operating system.

Consult your network administrator if you have questions in this regard.

Printing via a Network Printer

Preparation

The HMI device's operating system does not support line by line alarm logging via a network
printer. All other printer functions, such as printing hardcopies or logs, are possible via the
network without restriction.

Before beginning the configuration, request the following network parameters from your
network administrator.

Does the network use DHCP for dynamic assignment of network addresses?
If not, get a new TCP/IP network address for the HMI device.

TCP/IP address of the default gateway

Address of the name server in a DNS network

Addresses of the name server in a WINS network

General Procedure for Configuring the Network

The HMI device must be configured prior to network operation. The configuration is basically
divided into the following steps:

See also

6-38

Proceed as follows:

1.

o M DN

Set the computer name of the HMI device.

Configure the network address.

Set the logon information.

Save the settings.

Restart the HMI device once the network is configured.
If your network address is assigned automatically:

Before switching the HMI device on, insert the network cable in the corresponding port. A
unique IP address for the HMI device is assigned during startup.

Restarting the HMI Device (Page 6-26)
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6.8.2 Setting the Device Name of the HMI Device

Introduction

Requirements

Procedure

Result

See also

The HMI device uses the device name to identify itself in the network.

The "Communications Properties" dialog has been opened with the "Communications”
button.
Communications Properties m

Device Mame ]PC Connection ]

‘our device uses this information to
identify itself to ather computers,

Device name {without spaces):

rMI_Panel

Device description:

®
[HM1 Device __@

0] Device name of the HMI device
® Description for the HMI device (optional)

Note

Change the device name for the HMI device in the "Device name" input field to activate the
network functions.

Proceed as follows:

1. Enter the device name for the HMI device in the "Device name" input field.
2. Enter a description for the HMI device in the "Device description” input field.
3. Confirm your entries.

The dialog closes.

The device name for the HMI device is now set.

Overview of Network Operation (Page 6-37)
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6.8.3 Changing the Network Configuration

Requirement

‘2{
The "Network Configuration” dialog has been opened with the "Network " =g button.

Metwork Configuration

Adapters |Identifiu:atic:n |

Lists the network, drivers installed on your device.

Asynchacl: AsvnciMacl MDISWaN Adapter
SMSCL00FD: Onboard LAM EERernet Driver

5o 4

MAC-Address: 03-00-06-2b-ad-c3 Properties I

@ Selection for Ethernet card
® MAC address of the HMI device
® Button for the properties dialog

Procedure
Proceed as follows:
1. Select the entry "SMSC100FD1: Onboard LAN Ethernet Driver".
2. Open the "Onboard LAN Ethernet Driver" dialog with the "Properties" button:

‘Onboard LAN Ethernet Dr... [{J
IP Address |Name Servers |

An IP address can be autornatically
assigned to this cormputar,

() Obtain an IP address wia DHCP
{®) Specify an IP address ]7
IP &ddress: I@
Subrnet Mask: 255,255,235 .0 —
Default Gateway: :

Sdoo

Address assignment setting
Input field for the IP address
Input field for the address of the subnet mask

® e 00

Input field for the address of the default gateway
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3. Select either automatic address assignment via DHCP or manual address assignment.

4. If you assign the address manually, enter the respective addresses in the input fields for
"IP Address", "Subnet Mask" and, if used, "Default Gateway".

5. If a name server is used in the network, change to the "Name Server" tab.

‘Onboard LAN Ethernet Dr... [l
-IF' Address | Mame Servers |

Marne server addresses

Primary DMNS: |:|
Secondary DMNS: |:|
Prirnary WIkS: |I|
Secondary WINS: I:|

6. Enter the respective addresses in the input fields.
7. Confirm your entries.

The dialog closes.
8. Reboot the HMI device.

Result
The network parameters for the HMI device have now been set.

See also
Overview of Network Operation (Page 6-37)

Restarting the HMI Device (Page 6-26)
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6.8.4 Changing the Logon Data

Introduction

Windows CE uses this information to gain access to the network resources. Enter the user
name, password and domain you have received from your administrator.

Requirements

*"‘
The "Network Configuration" dialog has been opened with the "Network " button.

MNetwork Configuration

windows CE uses this information to gain access ko
netwaork resources, Enter the user name, passward, and
domain provided by wour network adminiskrator,

User Marne: I
Password: I********
Darnain: I

Procedure

Proceed as follows:

1. Enter the user name in the "User name" input field.
Enter your password in the "Password" input field.

Enter the domain name in the "Domain" input field.

oD

Confirm your entries.

The dialog closes.

Result

The logon information has now been set.

See also
Overview of Network Operation (Page 6-37)
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6.8.5 Activating the Direct Connection

Requirements
The "Communications Properties" dialog, "PC Connection" tab has been opened with the

"Communications" button.

Communications Properties

Device Mame  PC Connection l

Q-EI,,_,— These settings contral the connection
J”&J_J between panel and deskiop computer,

[ Enable direct connections to the deskiop computer

‘Diesk_115200" Change... 4

Warning: Changing the connection may disable
communications with wour deskbop computer,

—®
—®

O] Check box for the activation of a direct connection
® Button for changing the desktop PC

Notice
"PC Connection" Tab

If you want to operate a project on the HMI device, the entries in the "PC Connection" tab
may not be changed.

Procedure
Proceed as follows:
1. Select the check box "Enable direct connections ...".
2. Confirm your entries.
The dialog closes.
See also

Overview of Network Operation (Page 6-37)
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6.8.6

Requirement

Changing e-mail settings and proxy server

The "WinCC flexible Internet Settings" dialog has been opened with the "WinCC flexible

-

Internet Settings" - button.

WinCC flexible Internet Settings ok}
Emnail l Proccy ]

SMTP server ) @

@ IJse the default of the project file

Ol

Mame

Sender: |5irnatic HMI Dewvice

Authentication: |

© ®

® Setting the SMTP server

® Name for the sender
® E-mail account
Note

Options

Additional tabs may appear in the "WInCC flexible Internet Settings" tab. This depends on
the options that have been enabled for network operation in the project.

Procedure — Changing E-mail Settings

6-44

Proceed as follows:
1. Specify the SMTP server.

— Activate the "Use the default of the project file" radio button if you want to use the
SMTP server configured in the project.

— Deactivate the "Use the default of the project file" radio button if you do not want to
use the SMTP server configured in the project.

— Specify the required SMTP server.
2. Enter the name for the sender in the "Sender" input field.
3. Enter the e-mail account for your e-mail in the "Authentication" input field.

Some e-mail providers only allow you to send mail if you specify the e-mail account. The
"Authentication" field can remain empty if your e-mail provider allows you to send mail
without checking the account.

TP 277, OP 277 (WinCC flexible)
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Procedure — Changing Proxy Settings
Proceed as follows:

1. Change to the "Proxy" tab.

WiNCC flexible Internet Settings x|
Email @ Proxy I

[ TOs provey server
Priocey . Park:

hittp: | [ —

/
o

O] Check box for using the proxy server
® Port
® Address of the proxy server

2. Activate the check box "Use proxy server" if you want to use a proxy server.
3. Specify the address of the proxy server and the port.
4. Confirm your entries.

The dialog closes.

Result
The Internet settings have now been changed.

See also
Overview of Network Operation (Page 6-37)

6.9 Backup and Restore with the Memory Card

Introduction

Backup involves copying the operating system, applications and data from the internal flash
memory of the HMI device to a memory card.

A restore operation deletes the old data from flash memory of the HMI device on
confirmation. The data stored on the memory card is then copied to the internal flash
memory.

A Caution
All data on the HMI device will be deleted during a restore operation. Existing licenses are
retained.

TP 277, OP 277 (WinCC flexible)
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Requirements

A memory card with sufficient free capacity is inserted in the HMI device. The size of the
internal flash memory is displayed with information about the HMI device. A warning is
displayed if the available space is insufficient and backup is aborted.

You have opened the "Backup/Restore" dialog with the "Backup/Restore" ® button.

Backup (ko memaory card)

BACKLP @

Restare (Fram memaory card)

RESTORE @

@
@

Button for backup to memory card
Button for restore from memory card

Procedure — Backup

Proceed as follows:

1.
2.

6-46

Select "BACKUP" to start backup.
The HMI device checks the memory card.
If no memory card is inserted in the card slot or if the memory card is damaged:
— The following warning is displayed:
"No storage card detected! "
— Acknowledge the warning and the following message "Backup aborted".
The Control Panel is displayed again.

A message is displayed if the memory card already contains data. Follow the instructions
of the HMI device.

. The following messages and dialogues are displayed in sequence during backup.

"Checking Registry"
"Backup Progress"
"Saving CE-Image"
A progress bar shows the status of the backup process.
If backup was successful, the following message is displayed:
"Backup successfully completed. Click "OK" and remove your storage card. "
Click "OK" button to acknowledge the message.

Remove the memory card.

TP 277, OP 277 (WinCC flexible)
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Result

6.9 Backup and Restore with the Memory Card

The HMI device data is now saved on the memory card.

Requirements

The memory card with the backup is inserted in the HMI device.

Procedure — Restore

Proceed as follows:

1.

Select "RESTORE" to start restore.

The HMI device checks the memory card.

If no memory card is inserted in the card slot or if the memory card is damaged:
— The following warning is displayed:

"Storage card couldn't be detected. Try restore again? Insert storage card and Press
'OK' or abort restore with 'CANCEL". "

— Exchange the defective memory card and restart restore with "OK".
The data to be restored is checked.
The following messages are displayed in sequence during the check.
"Starting Restore"
"Checking data".
When the data has been checked, the following prompt for confirmation is displayed:

"You are starting RESTORE now. All files (except files on storage cards) and the registry
will be erased. Are you sure? "

At this point you can abort the restore if required in order to prevent the data on the HMI
device from being deleted.

Start to restore the data by selecting "Yes".

The following messages are displayed in sequence during the restore:
"Deleting files on flash"
"Restore CE Image"

A progress bar shows the status of the restore of the CE image.

After successful restore of the Windows CE image, the following message is displayed:
"Restore of CE Image is finished. The device will reboot now. Do not remove the storage
card"

Acknowledge this message.

. The HMI device starts. The operating system boots, opening the "Loader" and "Restore"

dialog in sequence.

TP 277, OP 277 (WinCC flexible)
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8. The restore process is resumed. All data stored on the flash file system is restored. After
successful restore, the following message is displayed: "Restore successfully finished.
Click "OK" and remove your storage card and reboot your device"

Remove the memory card.
Acknowledge this message.
9. The HMI device reboots.

Result
The data from the memory card is now on the HMI device.

See also
Using a Memory Card with the HMI device (Page 5-3)
Displaying Information about the HMI Device (Page 6-27)
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Commissioning a Project 7

7.1 Overview

Configuration and Process Control Phase

HMI devices can be used to operate and monitor tasks in process and production
automation. The plant screens on the HMI devices are used to provide a clearer overview of
active processes. The HMI device project, which includes the plant screens, is created
during the configuration phase.

Once the project is transferred to the HMI device, current processes can be operated and
monitored in the process control phase. The HMI device is connected to a PLC in the plant
and exchanges values with this PLC.

Configuration phase Configuration PC Create project
Test the project
Simulate the project
(HMI-device dependent)
Save the project

0}

Transfer the project

Process control phase

| HMI device Operate the project

)

Connection to the PLC

U

Figure 7-1 Configuration and process control phases

| PLC

Transferring the Project to the HMI Device
You can transfer a project to an HMI device as follows:
¢ Transfer the project from the configuration computer
¢ Restore the project from a PC using ProSave

In this case, an archived project is transferred from a PC to the HMI device. The
configuration software need not be installed on this PC.

TP 277, OP 277 (WinCC flexible)
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7.2 Operating Modes

Commissioning and Recommissioning
o When the HMI device is commissioned there is no project at first.
The HMI device is also in this state after the operating system has been updated.

¢ When recommissioning, any project already on the HMI device is replaced.

7.2 Operating Modes

Operating Modes
The HMI device may be in the following operating modes:
o Offline
¢ Online
e Transfer

"Offline mode" and "Online mode" can be set on both the configuration computer and the
HMI device. To set these modes on the HMI device, use a corresponding operator control of
the project.

Changing the Operating Mode

The configuration engineer must have configured an appropriate operator control to allow a
change of the operating mode on the HMI device during ongoing operation.

Further information on this may be available in your plant documentation.

"Offline" Operating Mode

In this mode, there is no communication between the HMI device and PLC. Although the
HMI device can be operated, it cannot exchange data with the PLC.

"Online" Operating Mode

In this mode, the HMI device and PLC communicate. You can operate the plant on the HMI
device according to your system configuration.

"Transfer" Mode

In this mode, you can transfer a project from the configuration computer to the HMI device or
backup and restore HMI device data, for example.

The following options are available for setting "Transfer" mode on the HMI device:
o When the HMI device starts up

Start "Transfer" mode manually in the HMI device Loader.
¢ During ongoing operation

Start the "Transfer" mode manually within the project using an operator control. The HMI
device toggles to "Transfer" mode when automatic mode is set and a transfer is initiated
on the configuration computer.

TP 277, OP 277 (WinCC flexible)
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7.3 Reusing Existing Projects

7.3 Reusing Existing Projects

The table below shows how you can reuse existing projects, while observing the screen size:

HMI device in the existing project New HMI device
TP 270 6" TP 277 6"

OP 270 6" OP 277 6"

MP 270 6" Touch TP 277 6" "

R If you have set options on the MP 270 6" Touch, you must use the MP 277 8" Touch as the

sSuccessor.

The following cases are possible:

1. An old project in ProTool is available:

Migrate the project to WinCC flexible and then switch the HMI device.

2. An old project in WIinCC flexible is available:
Switch the HMI device in WinCC flexible.

For more information, please see the online help for WinCC flexible or the "WinCC flexible

Migration" user manual.

7.4 Data Transmission Options

Overview

The table below shows the options for data transfer between TP 277 or OP 277 and the

configuration computer.

Type Data channel TP 277 OP 277
Backup Serial ) Yes Yes
MPI/PROFIBUS DP Yes Yes
USB Yes Yes
Ethernet Yes Yes
Restore Serial " Yes Yes
MPI/PROFIBUS DP Yes Yes
uUSB Yes Yes
Ethernet Yes Yes
Updating the operating system | Serial, with bootstrapping ") Yes Yes
Serial ) Yes Yes
MPI/PROFIBUS DP Yes Yes
USB Yes Yes
Ethernet Yes Yes

TP 277, OP 277 (WinCC flexible)
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Type Data channel TP 277 OP 277
Transferring a project Serial " Yes Yes
MPI/PROFIBUS DP Yes Yes
uSB Yes Yes
Ethernet Yes Yes
Installing or removing an option | Serial " Yes Yes
MPI/PROFIBUS DP Yes Yes
uUSB Yes Yes
Ethernet Yes Yes
Transferring license keys and Serial ) Yes Yes
uploading license keys MPI/PROFIBUS DP Yes Yes
USB Yes Yes
Ethernet Yes Yes

R Applies when PC/PPI cable is used

7.5 Transfer
7.5.1 Overview
Transfer

Transfer the executable project from the configuration computer to the HMI device.
You can start the "Transfer" mode manually or automatically on the HMI device.

Transferred data is written directly to the internal flash memory on the HMI device. For the
transfer, you use a data channel which you have to configure before starting a transfer.

Upload

You have the option to transfer the compressed project file together with the runtime project
to the HMI device. If necessary, the compressed project file can be retransferred and edited.

The HMI device must be equipped with an external memory card to which the compressed
project file can be saved.

Notice
Compressed project file

WinCC flexible does not check whether the compressed project file stored on the HMI device
corresponds to the existing runtime project.

TP 277, OP 277 (WinCC flexible)
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7.5 Transfer

7.5.2 Starting Manual Transfer

Introduction

Requirements

Procedure

Result

See also

You can manually switch the HMI device to "Transfer" mode as follows:

With a configured operator control during ongoing operation.
In the Loader of the HMI device.

The project "*.hmi" is opened in WinCC flexible.
The HMI device is connected to a configuration computer.
The data channel is configured on the HMI device.

The HMI device is in "Transfer" mode.

Proceed as follows:

1.

On the configuration computer, select the "Transfer settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Select devices for transfer" dialog opens.

2. Select the HMI device in the left area of the dialog.

3. Select the type of connection between the HMI device and the configuration computer.

Set the connection parameters.

Set the transfer parameters in the right area of the dialog.

5. If you wish to transfer the compressed project file together with the runtime project to the

HMI device:

Select the "Activate Upload" check box.

. Start transfer in WinCC flexible with "Transfer".

The configuration computer checks the connection to the HMI device. The project is
transferred to the HMI device. If the connection is not available or is defective, an error
message is displayed on the configuration computer.

When the transfer is completed successfully, the project can be found on the HMI device.
The transferred project is then started automatically.

Operating Modes (Page 7-2)

Configuring the Data Channel (Page 6-33)

Data Transmission Options (Page 7-3)

Overview (Page 7-4)
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7.5 Transfer

753 Starting Automatic Transfer

Introduction

The HMI device can be automatically switched to "Transfer" mode during runtime as soon as
transfer is started on the configuration computer connected.

Automatic transfer is particularly suited for the test phase of a new project since transfer is
completed without interfering with the HMI device.

Automatic transfer is available for the following data channels:

Requirements

7-6

Serial
MPI/PROFIBUS DP
uUsSB

Ethernet

Notice

If the automatic transfer has been activated on the HMI device and a transfer is initiated
on the configuration computer, the project currently running is automatically stopped. The
HMI device then automatically switches to "Transfer" mode.

After the commissioning phase, deactivate the automatic transfer so that the HMI device
cannot be inadvertently switched to Transfer mode. The transfer mode can trigger
unintentional actions in the device.

You can set a password for the Loader of the HMI device to restrict access to the transfer
settings and thus avoid unauthorized modifications.

The project *.hmi is opened in WinCC flexible.

The HMI device is connected to a configuration computer.

The data channel is configured on the HMI device.

The automatic transfer is activated in the data channel for the transfer.

The project is started on the HMI device.

TP 277, OP 277 (WinCC flexible)
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Procedure

Result

See also

7.5 Transfer

Proceed as follows:

1.

On the configuration computer, select the "Transfer settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Select devices for transfer" dialog opens.

Select the HMI device in the left area of the dialog.

3. Select the type of connection between the HMI device and the configuration computer.

Set the connection parameters.

Set the transfer parameters in the right area of the dialog.

5. If you wish to transfer the compressed project file together with the runtime project to the

HMI device:
Select the "Activate Upload" check box.

. Start transfer in WinCC flexible with "Transfer".

The configuration computer checks the connection to the HMI device. The HMI device
ends the current project and automatically switches to "Transfer" mode The project is
transferred to the HMI device. If the connection is not available or is defective, an error
message is displayed on the configuration computer.

When the transfer is completed successfully, the project can be found on the HMI device.
The transferred project is then started automatically.

Data Transmission Options (Page 7-3)

Configuring the Data Channel (Page 6-33)

Operating Modes (Page 7-2)

Overview (Page 7-4)

754 Testing a Project

Introduction

There are two options to test a project:

Test the project on the configuration PC

You can test a project at a configuration PC, using a simulator. For detailed information,
refer to the "WinCC flexible" user manual and to the WinCC flexible Online Help.

Offline testing of the project on the HMI device

Offline testing means that communication between the HMI device and PLC is down
while the test is being carried out.

TP 277, OP 277 (WinCC flexible)
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7.5 Transfer

¢ Online testing of the project on the HMI device

Online testing means that the HMI device and PLC communicate with each other during
testing.

Perform the tests, starting with the "Offline test", followed by the "Online test".

Note
You should always test the project on the HMI device on which the project will be used.

Check the following:

1. Check the correct layout of the screens.
2. Check the screen structure.

3. Check the input objects.

4. Enter the tag values.

The test increases the certainty that the project will run error-free on the HMI device.

Requirements for Offline Testing
e The project has been transferred to the HMI device.

e The HMI device is in "Offline" mode.

Procedure

In "Offline" mode, you can test individual project functions on the HMI device without them
being affected by the PLC. PLC tags, therefore, are not updated.

Test the operator controls and visualization of the project as far as possible without
connecting to the PLC.

Requirements of Online Testing
e The project has been transferred to the HMI device.

e The HMI device is in "Online" mode.

Procedure
In "Online" mode, you can test individual project functions on the HMI device without them
being affected by the PLC. PLC tags are updated in this case.
You have the option to test all communication-dependent functions, e.g. messages, etc.
Test the operator controls and views of the project.

See also

Operating Modes (Page 7-2)

TP 277, OP 277 (WinCC flexible)
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7.5 Transfer

755 Starting Upload

Requirements

Procedure

Result

See also

No project is open in WinCC flexible.

The HMI device is connected to a configuration computer.
The data channel is configured on the HMI device.

The HMI device is in "Transfer" mode.

The memory card containing the compressed project file is inserted into the HMI device.

Proceed as follows:

1.

On the configuration computer, select the "Communication settings" command in the
menu "Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuration computer.

Set the connection parameters.

4. Close the dialog with "OK".

5. Select the "Transfer" > "Upload" command in the "Project” menu.

The "Upload" dialog opens.
Click "OK" to start the upload process.

The configuration computer checks the connection to the HMI device. The compressed
project file is uploaded from the HMI device to the configuration PC. If the connection is
not available or is defective, an error message is displayed on the configuration
computer.

After successful upload, the project is opened on the configuration PC in WinCC flexible.

Overview (Page 7-4)
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Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO 7-9



Commissioning a Project

7.6 Backup and Resfore

7.6 Backup and Restore

7.6.1 Overview

Backup and Restore

Notice
License Keys

License keys are not taken into account for backups and restores. License keys are saved in
the working memory of the HMI device and cannot be deleted.

You can back up and restore the following data found in the internal flash memory of the HMI
device with a PC:

¢ Project and HMI device image

e Password list

e Recipe data

Use one of the following tools for backup and restore:
e WinCC flexible

e ProSave

General Information

Notice
Power failure

If a complete restore operation is interrupted due to power failure on the HMI device, the
operating system of the HMI device may be deleted! The operating system then has to be
updated.

Compatibility conflict

If a message is output on the HMI device warning of a compatibility conflict during the
restore operation, the operating system must be updated.

7.6.2 Backup and Restore Operations with WinCC flexible

Requirements
e The HMI device is connected to a configuration computer.
e No project is open in WinCC flexible.

e The data channel is configured on the HMI device.

TP 277, OP 277 (WinCC flexible)
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Procedure — Backup

7.6 Backup and Resfore

Proceed as follows:

1.

On the configuration computer, select the "Communication settings" command in the
menu "Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuration computer.

Set the connection parameters.
Close the dialog with "OK".

5. Select the "Backup" command in the menu "Project > Transfer" in WinCC flexible.

The "Backup Settings" dialog opens.

6. Select the data to be backed up.

7. Select a destination folder and a file name for the

Result

"k

.psb" backup file.
Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the HMI device automatically
sets "Transfer" mode when a backup is initiated.

Start the backup operation in WinCC flexible with "OK" on the configuration computer.
Follow the instructions in WinCC flexible.

A status view opens to indicate the progress of the operation.

The system outputs a message when the backup is completed.

The relevant data is now backed up on the configuration computer.

Procedure — Restore
Proceed as follows:

1.

On the configuration computer, select the "Communication settings" command in the
menu "Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuration computer.

Set the connection parameters.
Close the dialog with "OK".

5. Select the "Restore" command in the menu "Project > Transfer" in WinCC flexible.

The "Restore Settings" dialog opens.

. Select the "*.psb" backup file to be restored from the "Open" dialog.

You can see the HMI device for which the backup file was created and the type of backup
data the file contains.

TP 277, OP 277 (WinCC flexible)
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Result

See also

7.6.3

. Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when a restore operation is initiated.

. Start the restore operation in WinCC flexible with "OK" on the configuration computer.

Follow the instructions in WinCC flexible.

A status view opens to indicate the progress of the operation.

When the restore is successfully completed, the data backed up on the configuration
computer is now on the HMI device.

Overview (Page 7-10)

Operating Modes (Page 7-2)

Data Transmission Options (Page 7-3)

Configuring the Data Channel (Page 6-33)

Backup and Restore with the ProSave

Requirements

The HMI device is connected to a PC on which ProSave is installed.

The data channel is configured on the HMI device.

Procedure — Backup
Proceed as follows:

7-12

1.
2.
3.

From the Windows Start menu, start ProSave on the PC.
Select the HMI device type in the "General" tab.
Select the type of connection between the HMI device and the PC.

Set the connection parameters.

4. Select the data to be backed up in the "Backup" tab.

5. Select a destination folder and a file name for the

ni

.psb" backup file.

6. Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the HMI device automatically
sets "Transfer" mode when a backup is initiated.

Start the backup operation in ProSave with "Start Backup".
Follow the instructions in ProSave.

A status view opens to indicate the progress of the operation.

TP 277, OP 277 (WinCC flexible)
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Result

7.6 Backup and Resfore

The system outputs a message when the backup is completed.

The relevant data is now backed up on the PC.

Procedure — Restore

Proceed as follows:

1.
2.
3.

Result

From the Windows Start menu, start ProSave on the PC.

Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC.
Set the connection parameters.

Select the "*.psb" backup file to be restored from the "Restore" tab.

You can see the HMI device for which the backup file was created and the type of backup
data the file contains.

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when a restore operation is initiated.

Start the restore operation in ProSave on the PC with "Start Restore".
Follow the instructions in ProSave.

A status view opens to indicate the progress of the operation.

When the restore is successfully completed, the data backed up on the PC is now on the
HMI device.

See also

Overview (Page 7-10)

Operating Modes (Page 7-2)

Data Transmission Options (Page 7-3)
Configuring the Data Channel (Page 6-33)
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7.7 Updating the Operating System

7.71 Overview

Updating the Operating System

A compatibility conflict may occur when transferring a project to the HMI device. This is
caused by different versions of the configuration software used and the HMI device image
available on the HMI device. If there are different versions, the transfer is aborted. A
message indicating a compatibility conflict is displayed on the configuration computer.

There are two ways to match the versions:

Update the HMI device image if the project was created with the most recent version of
the configuration software.

Transfer a matching older version of the HMI device image if you do not want to adapt the
project to the most recent version of the configuration software for the project.

Notice
Data Loss

All data on the HMI device, such as the project, passwords and licenses, will be deleted
when you update the operating system.

Data channels

An operating system update resets all parameters for the data channels. The transfer can
only be started in the Loader following reconfiguration of the data channels.

7.7.2 Bootstrapping

Bootstrapping

In ProSave or WinCC flexible, you can update the operating system with or without
bootstrapping.

7-14

Updating the operating system without bootstrapping

First, set "Transfer" mode on the HMI device or use the automatic transfer function if the
project is active. Then start the operating system update in ProSave or WinCC flexible.

Updating the operating system with bootstrapping

First, start the operating system update in ProSave or WinCC flexible and switch the
power on the HMI device off and on again when prompted.

TP 277, OP 277 (WinCC flexible)
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Note

You have to perform an operating system update with bootstrapping if the HMI device
does not yet have an operating system or if the operating system of the HMI device is
corrupt.

Point-to-point coupling with a PC/PPI cable is necessary in order to update the operating
system with bootstrapping.

7.7.3 Updating the Operating System Using WinCC flexible

Requirement

Procedure

The HMI device is connected to a configuration computer.
No project is open in WinCC flexible.
Relevant only to operating system update without bootstrapping:

The data channel is configured on the HMI device.

Proceed as follows:

1.

Relevant to operating system update with bootstrapping:
Switch off power to the HMI device.

. On the configuration computer, select the "Communication settings" command in the

menu "Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

3. Select the type of HMI device.

4. Select the type of connection between the HMI device and the configuration computer,

then set the connection parameters.

5. Close the dialog with "OK".

6. In WIinCC flexible, select the command "Update operating system" in the "Project >

Transfer" .

Select whether to update the operating system with or without bootstrapping by setting
the "Bootstrap” check box accordingly.

In "Image path," select the HMI device image file, "*.img".

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.

In the output area, you are provided information on the version of the HMI device image
file after it is opened.
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Result

See also

7.74

10.

1.

12.

Applies only when updating without bootstrapping:
Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when an update is initiated.

In WinCC flexible, select "Update OS" on the configuration PC to run the operating
system update.

Applies only when updating with bootstrapping:
Switch on the power supply to the HMI device.
Follow the instructions in WinCC flexible.

During the operating system update a status view opens to indicate progress.

A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device.

Overview (Page 7-10)

Operating Modes (Page 7-2)

Data Transmission Options (Page 7-3)
Configuring the Data Channel (Page 6-33)

Updating the Operating System Using ProSave

Requirement

Procedure

7-16

The HMI device is connected to a PC on which ProSave is installed.
When updating the operating system without bootstrapping:

The data channel is configured on the HMI device.

Proceed as follows:

1.

When updating the operating system with bootstrapping:
Switch off power to the HMI device.

From the Windows Start menu, start ProSave on the PC.
Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC, then set the
connection parameters.

TP 277, OP 277 (WinCC flexible)
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Select the "OS Update" tab.

Select whether to update the operating system with or without bootstrapping by setting
the "Bootstrap" check box accordingly.

7. In"Image path," select the HMI device image file, "*.img".

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.

In the output area, you are provided information on the version of the HMI device image
file after it is opened.

8. Applies only when updating without bootstrapping:
Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when an update is initiated.

9. Select "Update OS" on the PC to run the operating system update.
10. Applies only when updating with bootstrapping:

Switch on the power supply to the HMI device.
11. Follow the instructions in ProSave.

During the operating system update a status view opens to indicate progress.

Result
A message is displayed when the operating system update is successfully completed.
This operation has deleted the project data from the HMI device.

7.8 Installing and Removing Options

7.8.1 Overview

Installing and Removing Options

You can install options on the HMI device, for example, additional programs developed
especially for the HMI device.

You can also remove the option from the HMI device again.

Note
License key

A license key may be needed to run an option. The license key unlocks the option for use.

TP 277, OP 277 (WinCC flexible)
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7.8.2 Installing and Removing Options Using WinCC flexible

Requirements

The HMI device is connected to a configuration computer.
No project is open in WinCC flexible.

The data channel is configured on the HMI device.

Procedure - Installing an Option
Proceed as follows:

1.

On the configuration computer, select the "Communication settings" command in the
menu "Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

w

N o o &

Result

Select the type of connection between the HMI device and the configuration computer,
then set the connection parameters.

Close the dialog with "OK".

Select the "Options" command in the menu "Project > Transfer" in WinCC flexible.
Select the desired option under "Available options."

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the installation of an option is initiated.

Start the installation of the option in WinCC flexible on the configuration computer with
the ">>" button.

Follow the instructions in WinCC flexible.

A status display appears indicating the progress of the installation.

The option has now been installed on the HMI device.

Procedure — Removing an Option

Proceed as follows:

1.

On the configuration computer, select the "Communication settings" command in the
menu "Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuration computer,

then set the connection parameters.

4. Close the dialog with "OK".

5. Select the "Options" command in the menu "Project > Transfer" in WinCC flexible.

6. Select the desired option under "Installed options."
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7. Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the removal of an option is initiated.

8. Start the removal of the option in WinCC flexible on the configuration computer with the
"<<" button.

Follow the instructions in WinCC flexible.

A status display appears indicating the progress of the removal.

Result

The option has now been removed on the HMI device.
See also

Overview (Page 7-10)

Operating Modes (Page 7-2)

Data Transmission Options (Page 7-3)

Configuring the Data Channel (Page 6-33)
7.8.3 Installing and Removing Options Using ProSave

Requirements
e The HMI device is connected to a PC on which ProSave is installed.

e The data channel is configured on the HMI device.

Procedure - Installing an Option
Proceed as follows:
1. From the Windows Start menu, start ProSave on the PC.
2. Select the HMI device type in the "General" tab.

3. Select the type of connection between the HMI device and the PC, then set the
connection parameters.

4. Select the "Options" tab.
5. Select the desired option under "Available options."
6. Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the installation of an option is initiated.

7. Start the installation of the option in ProSave with the ">>" button.
Follow the instructions in ProSave.

A status display appears indicating the progress of the installation.
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Result
The option has now been installed on the HMI device.

Procedure — Removing an Option
Proceed as follows:
1. From the Windows Start menu, start ProSave on the PC.
2. Select the HMI device type in the "General" tab.

3. Select the type of connection between the HMI device and the PC, then set the
connection parameters.

4. Select the "Options" tab.
5. Select the desired option under "Installed options."
6. Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the removal of an option is initiated.

7. Start the removal of the option in ProSave with the "<<" button.
Follow the instructions in ProSave.

A status display appears indicating the progress of the removal.

Result

The option has now been removed on the HMI device.
See also

Overview (Page 7-10)

Operating Modes (Page 7-2)

Data Transmission Options (Page 7-3)

Configuring the Data Channel (Page 6-33)
7.9 Transferring and Uploading License Keys
7.9.1 Overview

Transferring and Uploading License Keys

With the purchase of an optional package, you obtain a specific user license with an
associated license key. Once you have installed an option, transfer a license key to the HMI
device. The license key unlocks an option for use.

You can also upload the license key from the HMI device to a license diskette.

TP 277, OP 277 (WinCC flexible)
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Note

License keys can only be uploaded and transferred with the Automation License Manager or
WinCC flexible.

7.9.2 Transferring and Uploading License Keys

Requirements

The HMI device is connected to a configuration computer.
When uploading and transferring using WinCC flexible:
No project is open in WinCC flexible.

The data channel is configured on the HMI device.

The license diskette with the license key to be transferred must be inserted in the floppy
drive of the configuration computer.

Procedure — Transferring a License Key

Proceed as follows:

1.
2.

Switch to "Transfer" mode on the HMI device.
When transferring using WinCC flexible:

Select the "License Keys" command in the menu "Project > Transfer". The
Automation License Manager opens.

When transferring using the Automation License Manager:
Start the Automation License Manager via the Windows Start menu.

In the Automation License Manager, select the command "Connect HMI device" in the
menu "Edit > Connect Target System".

The "Connect Target System" dialog opens.

4. Under "Device Type," select the appropriate device type.

5. Select the type of connection in the "Connection" field and set the connection parameters.

Select "OK".

The connection to the HMI device is established. The connected HMI device is displayed
in the left window of the Automation License Manager.

In the left window, select the source drive.
The right window displays the available license keys.

Drag one or more license keys from the right window and drop them on the HMI device in
the left window.

The license keys are then transferred to the HMI device.
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Result

The license key has now been transferred from the license diskette to the HMI device.

Procedure — Uploading a License Key

Proceed as follows:

1.
2.

Switch to "Transfer" mode on the HMI device.
When uploading using WinCC flexible:

Select the "License Keys" command in the menu "Project > Transfer". The
Automation License Manager opens.

When uploading using the Automation License Manager:
Start the Automation License Manager via the Windows Start menu.

In the Automation License Manager, select the command "Connect HMI device" in the
menu "Edit > Connect Target System".

The "Connect Target System" dialog opens.

Under "Device Type," select the appropriate device type.

5. Select the type of connection in the "Connection" field and set the connection parameters.
6. Select "OK".

Result

The connection to the HMI device is established. The connected HMI device is displayed
in the left window of the Automation License Manager.

. In the left window, select the HMI device.

The right window displays the available license keys.

Drag one or more license keys from the right window and drop them on the HMI device in
the left window.

The license keys are then uploaded to the license diskette.

The license key has now been uploaded from the HMI device to the license diskette.

See also

Overview (Page 7-10)

Operating Modes (Page 7-2)

Data Transmission Options (Page 7-3)

Configuring the Data Channel (Page 6-33)
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8.1 Overview

Configuration and Process Control Phase

HMI devices can be used to operate and monitor tasks in process and production
automation. The plant screens on the HMI devices are used to provide a clear overview of
the active processes.

The HMI device project, which includes the plant screens, is created during the configuration
phase. The configuration engineer defines which tasks the HMI device has in the process.
He defines the following in detail:

e Which process data is displayed on the individual HMI device.
¢ Which plant components are controlled by this HMI device.

He stores this information in the project's screens. The project is transferred to the HMI
device during commissioning.

After transfer to the HMI device, current processes can be operated and monitored in the
project's screens. Operating states, current process data and alarms of a plant, for example,
can be monitored with the screens. Operator control elements which are used to operate the
process, for example buttons, 10 fields and alarm windows, are displayed in the screens.

Operator Control Options

The hardware of the HMI device determines which of the following operator control options
are available:

e Touch screen

The operator controls shown in the dialogs are touch-sensitive. Touch objects are
basically operated in the same way as mechanical keys. You activate operator controls
by touching them with your finger. To double-click them, touch an operator control twice
in succession.

¢ HMI-device keyboard

The operator controls shown in the screens are selected and operated using the keys of
the HMI device.

e External keyboard, connected via USB

e External mouse, connected via USB

TP 277, OP 277 (WinCC flexible)
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8.1 Overview

VAN

Caution

Do not use any pointed or sharp objects when operating the touch screen. Otherwise this
may damage the plastic membrane of the touch screen.

The following provides instructions for operating a project with the touch screen and the
keyboard.

Operating a Project with an External Keyboard

An external keyboard can be used to operate a project in exactly the same way as with the
HMI keyboard or screen keyboard.

Note
The function keys of the external keyboard are disabled.

Use the other keys of the external keyboard, which correspond to the HMI keys in the
description.

Operating a Project with an External Mouse

An external mouse can be used to operate a project in exactly the same way with the HMI
touch screen. Click the described operator controls with the mouse.

Unintentional Actions

VAN

Caution

Do not carry out several operations simultaneously. You may otherwise trigger unintentional
actions.

e Operation using the touch screen:
Always touch only one operator control on the screen.
e Operation using the keys:

Do not press more than two keys simultaneously.

Observing the Plant Documentation

Some operations with the project may require in-depth knowledge about the specific plant on
the part of the operator. It is therefore important to take special care, for example, in typing
mode. Further information on this may be available in your plant documentation.

Operation Feedback from Operator Controls

8-2

The HMI device provides optical feedback as soon as it detects that an operator control has
been selected. The operator control receives the focus and is selected. This selection is
independent of any communication with the PLC. Therefore this selection does not indicate
whether the relevant action is actually executed or not.

The configuration engineer can also configure the selection of an operator control so that it
deviates from the standard. Further information on this may be available in your plant
documentation.

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO



Operating a Project
8.2 Direct Keys

Optical Feedback from Operator Controls
The type of optical feedback depends on the operator control:
e Buttons

The HMI device outputs different views of the "Touched" and "Untouched" states,
provided the configuration engineer has configured a 3D effect:

"Touched" state:

"Untouched" state:

The configuration engineer defines the appearance of a selected field, for example, its
line width and color for the focus.

e |nvisible buttons

By default, invisible buttons are not displayed as touched when they are pressed. No
optical operation feedback is provided in this case.

The configuration engineer may, however, configure invisible buttons so that their outline
appears as lines when touched. This outline remains visible until you select another
operator control.

e 1/O fields

When you select an 10 field, the content of the 1O field is displayed against a colored
background. With touch operation, a screen keyboard is displayed for the entering of
values.

8.2 Direct Keys

Introduction
Direct keys set bits in the 1/O area of a SIMATIC S7 directly from the HMI device.

Direct keys enable key operations with quick reaction time, which is a requirement for typing
operations, for example.

Notice

Direct keys are also enabled when the HMI device is in "Offline" operating mode.

Notice

If you operate a function key with direct key functionality in a running project, the direct key
function is always executed, independent of the current screen contents.
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8.3 Setting the Project Language

Direct Keys

See also

Note

You can only use direct keys when there is a connection via PROFIBUS DP or
PROFINET IO.

Direct keys result in additional basic load on the HMI device.

The following objects can be configured as a direct key:
e Buttons
e Function Keys

HMI devices with touch operation allow for the definition of image numbers, so that the
project editor can configure the direct keys in such a manner that they are specific to the
image.

Further information on configuring direct keys can be found in the
"WinCC flexible Communication" system manual.

Enabling PROFINET IO (Page 6-36)
Bit Assignment of the Direct Keys (Page 12-5)

8.3 Setting the Project Language

Introduction

Requirements

8-4

The HMI device supports multilingual projects. You must have configured a corresponding
operator control which lets you change the language setting on the HMI device during
runtime.

The project always starts with the language set in the previous session.

¢ The required language for the project must be available on the HMI device.

¢ The language switching function must be logically linked to a configured operator control
such as a button.
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Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO



Operating a Project
8.4 Entering Values Using the Touch Screen

Selecting a Language

You can change project languages at any time. Language-specific objects are immediately
output to the screen in the new language when you switch languages.

The following options are available for switching the language:
¢ A configured operator control switches from one language to the next in a list.
¢ A configured operator control directly sets the desired language.

Further information on this may be available in your plant documentation.

See also
Changing Regional Settings (Page 6-21)

8.4 Entering Values Using the Touch Screen

841 Overview

Screen Keyboard

When you touch an operator control requiring input on the HMI touch screen, a screen
keyboard appears. The screen keyboard is displayed in the following cases:

e An |O field is selected for input.
e A password must be entered for accessing a password-protected function.
The keyboard is automatically hidden again when input is complete.

Based on the configuration of the operator control, the system displays different screen
keyboards for entering numerical or alphanumerical values.

Note

The screen keyboard display is independent of the configured project language.

General Procedure
The operator controls of a screen are operated by touching the touch screen.
Proceed as follows:
1. Touch the desired operator control within the screen.

2. Depending on the operator control, perform further actions. Detailed descriptions can be
found with the respective operator control.

Examples:
— /O field: Enter numerical, alphanumeric or symbolic values in the 10 field.
— Symbolic 10 field: Select an entry from the list box.

— Slider control: Move the slider control.
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Procedure for Input Fields

Values are entered in the project input fields. Based on your configuration, the values are
saved to tags and transferred, for example, to the PLC.

Proceed as follows:

1.

Touch the desired input field within the screen.
The screen keyboard opens.

Depending on your configuration, you can enter values in the input field in the following
manner:

— Numerical values, for example decimal numbers, hexadecimal numbers, binary values
— Alphanumerical values, for example digits and letters

— Date/time

. Enter the value.

Confirm your entry | -=— | or discard your entry with ESC |

8.4.2 Entering and Editing Numerical Values

Numerical Screen Keyboard

When you touch an operator control for numerical input on the HMI-device touch screen, the
numerical screen keyboard appears. This is the case, for example, for an input field. The
keyboard is automatically hidden again when input is complete.

Min: 50 Max: 78
| o]
A 1 2 3 ESC
B 4 5 b BSP
C Fi 8 9 +]-
D E F 0
& | —>| Hep <

Figure 8-1 Numerical screen keyboard

Note
Opened screen keyboard

When the screen keyboard is open, PLC job 51, "Select Screen" has no function.
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Formats for Numerical Values
You can enter values in numerical input fields based on the following formats:
e Decimal
e Hexadecimal

e Binary

Limit Value Test of Numerical Values

Tags can be assigned limit values. The current limit values are indicated in the numerical
screen keyboard. If you enter a value which lies outside these limits, the value is not
accepted, for example 80 where the limit value is 78. In this case a system alarm is output
on the HMI device when an alarm window is configured. The original value is displayed
again.

Decimal places for numerical values

The configuration engineer can define the number of decimal places for a numerical input
field. The number of decimal places is checked when you enter a value in this type of 10
field.

¢ Decimal places in excess of the limit are ignored.

e Empty decimal places are filled with "0".

Procedure

You can enter numerical and hexadecimal values character-by-character using the
numerical screen keyboard

Proceed as follows:
1. Touch the desired operator control within the screen.

The numerical screen keyboard opens. The existing value is displayed in the screen
keyboard and is selected.

2. Enter the value.

You can only operate keys that are required for the entry of the value. This means for
example that the character keys are disabled when a decimal value is entered. Which
keys can be operated can be seen from the appearance of the keys.

You have the following options to enter a value:

— The selected value is deleted when you enter the first character. Completely reenter
the value.

- Usethe €— | and —> | keys to move the cursor within the current value. You can
now edit the characters of the current value or add characters.

Use the BSPl key to delete the character to the left of the cursor. If the value is
selected, use this key to delete the selected part of the value.

— Usethe +!- | key to change the sign of the value.
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— Usethe Helpl key to display the info text of the 10 field.

This button is only enabled if info text has been configured for the 10 field or the
current screen.

3. Use the = | key to confirm your entry or cancel it with |ESC|. Either action closes the

screen keyboard.

Result

You have changed the numerical value or entered a new one.

8.4.3 Entering and Editing Alphanumerical Values

Alphanumerical Screen Keyboard

When you touch an operator control for alphanumerical input on the HMI-device touch
screen, the alphanumerical screen keyboard appears. This is the case, for example, for an
input field. The keyboard is automatically hidden again when input is complete.

Al B|C|D|E|F| G| H | J
K| LIM|N|O[P|Q|R| S| T
Ul vy W X| ¥ Z|! * = +
[ I I I
] 1 2 3 4 L & 7 & 9
Shift | | BSP| Help| ESC| &l
Figure 8-2  Alphanumerical screen keyboard, normal level
Note

Opened screen keyboard
When the screen keyboard is open, PLC job 51, "Select Screen" has no function.
Language change

Switching the language in the project has no effect on the alphanumerical screen keyboard.
This is why Cyrillic or Asian characters cannot be entered.
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Keyboard Levels
The alphanumerical screen keyboard has several levels:
e Normal level
e Shift level

When you toggle the level with the Shiﬂl key , the labels on the screen keyboard change.

Procedure

You can enter alphanumerical values character-by-character using the buttons on the
alphanumerical screen keyboard.

Proceed as follows:
1. Touch the desired operator control within the screen.

The alphanumeric screen keyboard opens. The existing value is displayed in the screen
keyboard and is selected.

2. Enter the value.
You have the following options to enter a value:

— The selected value is deleted when you enter the first character. Completely reenter
the value.

- Usethe €— | and —> | keys to move the cursor within the current value. You can

now edit the characters of the current value or add characters.

Use the BSPl key to delete the character to the left of the cursor. If the value is

selected, use this key to delete the selected part of the value.

— Usethe Shiftl key to toggle the screen keyboard levels. When you toggle the level,

the key labels on the screen keyboard change.

- Usethe Hﬂlpl key to display the info text of the 10 field.

This button is only enabled if info text has been configured for the 10 field or the
current screen.

3. Use the = | key to confirm your entry or cancel it with ESC |. Either action closes the

screen keyboard.

Result

You have changed the alphanumerical value or entered a new one.
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8.4.4

Entering the Date and Time

Entering the Date and Time

See also

8.4.5

List box

Procedure

Result

8-10

Enter the date and time in the same way you enter alphanumerical values.

Note

When entering the date and time, please note that the format is determined by the
configured project language.

Entering and Editing Alphanumerical Values (Page 8-8)
Setting the Project Language (Page 8-4)

Entering Symbolic Values

Operator controls for entering symbolic values offer you a list from which you can select the
input values. When you touch a symbolic 1O field on the HMI-device touch screen, the
following list box opens.

Figure 8-3  Symbolic IO field after touch, example

Proceed as follows:

1. Touch the required operator control.

The list box of the operator control opens. Select =l and |to scroll in the list box.

2. Touch the required entry in the drop-down list.

The selected entry is accepted as an entry.

You have changed the symbolic value or entered a new one.

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO



Operating a Project
8.4 Entering Values Using the Touch Screen

8.4.6 Displaying Info Text

Purpose

The configuration engineer uses info text to provide additional information and operating
instructions. The configuration engineer can configure info text on screens and operator
controls.

The info text of an IO field may contain, for example, information on the value to be entered.

Enter termperature setpoint for Tank_1
{Range 40...80 =C)

Figure 8-4  Info text for an IO field, example

Opening Info Text for Operator Controls
1. Touch the required operator control.

The screen keyboard opens. You can see from the appearance of the Hﬂlpl key whether
info text has been configured for the operator control or the current screen.

2. Touch the Hﬂlpl key on the screen keyboard.

The info text for the operator control is displayed. If there is no info text for the selected
screen object, the info text for the current screen is displayed, if it has been configured.

You can scroll through the contents of long info text with »jand .}.

Note
Switching between Displayed Info text

The configuration engineer can configure info text for an IO field and the associated
screen. You can switch between two info texts by touching the info text window.

3. Close the displayed info text by pressing .

Alternative Procedure

Depending on your configuration, info text can also be called via a configured operator
control.

Further information on this may be available in your plant documentation.

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO 8-11



Operating a Project

8.5 Entering Values Using the Keys

8.5 Entering Values Using the Keys

8.5.1 Control Keys

Introduction

The tables below show the control keys used to operate the project. Detailed descriptions
can also be found with the individual operator controls.

Selecting Operator Controls

Key

Function

Description

TAB

SHIFT
+

Tabulator

Selects the next or previous operator control in the
tab sequence.

>[a]
v]

\4

Cursor keys

Selects the next operator control, to the left or right
of, above or below the current screen object.

Navigates in the operator control.

Operating operator controls

A

ey

Function

Description

+

+

<Ay

Positioning the cursor

Positions the cursor within an operator control, for
example in the 10 field.

Scroll back

Scrolls one page back in a list.

+
5
Srp
m

Scroll to the beginning

Scrolls in a list to the beginning.

Scroll forward

Scrolls one page forward in a list.

+
m
H

Scroll to the end

Scrolls in a list to the end.

m m I 2] %) 2] 1)

2 il z n Opp B s I B

o = = z H 5 T 5 T

o [l 4 4 3 4
+

ENTER key

e Operates buttons.

e Applies and closes the entry.

e Opens a list box.

e Toggles within an input field between character
mode and normal mode.

An individual character is selected in character
mode. In this mode you can use the cursor
keys to move forward in the character set.
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Key Function Description

£ Cancel e Deletes the input characters of a value and
restores the original value.

¢ Closes the active dialog.

Delete characters Deletes the character to the right of the current
cursor position.
Delete characters Deletes the character to the left of the current

cursor position.

. Iz' Open the list box. Opens a list box.

Apply value Accepts the selected value in the list box without
closing the list.

CTRL ENTER
+

Entering shortcut keys
Key Function Purpose
Toggle key assignment Toggles the assignment for keys with multiple
assignments.
e No LED is lit:

The number assignment is enabled. Pressing
the button once toggles to letter assignment.

e AnLEDislit:

The left or right letter assignment is enabled.

Each time the key is pressed, the system toggles
among the left letter assignment, the right letter
assignment and the number assignment.

Toggle between uppercase | Use in key combinations, for example, for entering
and lowercase uppercase letters.

Switch to additional key Some of the keys contain a blue imprinted key
assignment assignment , for example the "%" character.

Use in shortcut keys for the blue key assignment.

e General control functions Use in shortcut keys.

.

AT General control functions Use in shortcut keys.

Acknowledge alarms

Key Function Description

e Acknowledging Acknowledges the currently displayed error
message or all the alarms of an alarm group as
group acknowledgment.

The LED is lit as long as there are
unacknowledged error messages.

TP 277, OP 277 (WinCC flexible)
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Displaying info text

Key

Function

Description

HELP

Displaying info text

Opens a window with the configured info text for
the selected object, for example message or 10
field. The LED is lit if info text is available for the

selected object.

Multiple key operation
Unwanted actions may be triggered, if the operator unintentionally actuates a key

VAN

8.5.2

combination.

Caution

Unintentional actions

In "Online" mode, simultaneous operation of more than two keys may cause unintentional
actions in the plant.

Never press more than two keys simultaneously.

Example: Entering Characters with the Alphanumerical Keyboard

You can enter up to 6 different characters using the same keys of the alphanumerical
keyboard. The input result depends on which combination of keys you press.

The values "5", "M", "m", "N", "n" and "%" are entered using the same key on the

keyboard. Toggle between the different assignments using the keys , and .

The table below shows the input options with .

Key Key Key Result
No LED is lit Not relevant Not pressed 5
The left LED is lit. Not pressed Not pressed m
The left LED is lit. Pressed Not pressed M
The right LED s lit. Not pressed Not pressed n
The right LED is lit. Pressed Not pressed N
Not relevant Not relevant Pressed %

TP 277, OP 277 (WinCC flexible)
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8.5.3 Function keys

Function keys

Function key assignment is defined during configuration. The configuration engineer can
assign function keys globally and locally.

Function keys with Global Function Assignment

A globally assigned function key always triggers the same action on the HMI device or in the
PLC irrespective of the screen displayed. An example of such an action is the activation of a
screen or the closing of an alarm window.

Function keys with Local Function Assignment

A function key with local function assignment is screen-specific and is therefore only
effective within the active screen.

The function assigned locally to a function key can vary from screen to screen.

The function key of a screen can be assigned one function only, either a global or local one.
The local assignment function takes priority over the global setting.

The configuration engineer can also assign function keys so that you can use the function
keys to operate operator controls. for example the Alarm view, Trend view, Recipe view or
Status/Force.

854 General Procedures

Introduction
The control keys and function keys are available for keyboard control.

General Procedure
The operator controls of a screen are operated using the HMI-device control keys.

Proceed as follows:

1. Press or the cursor keys until the desired operator control is selected within the
screen.

2. Depending on the operator control, perform further actions. Detailed descriptions can be
found with the respective operator control.

Examples:
— /O field: Enter numerical, alphanumeric or symbolic values in the IO field.

— Slider control: Move the slider control.

3. Confirm your operation with or cancel operation with .

TP 277, OP 277 (WinCC flexible)
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8.5.5 Entering and Editing Numerical Values

Formats for Numerical Values
You can enter values in numerical input fields based on the following formats:
e Decimal
e Hexadecimal

e Binary

Limit Value Test of Numerical Values

Tags can be assigned limit values. If you enter a value which lies outside these limits, the
value is not accepted, for example 80 where the limit value is 78. In this case a system alarm
is output on the HMI device when an alarm window is configured. The original value is
displayed again.

Procedure

You can enter numerical and hexadecimal values character-by-character using the system
keys.

Proceed as follows:

1. Select the desired input field within the screen with .
The existing value is selected in the input field.

2. Enter the value using the numeric keypad.
You have the following options to enter a value:

— The existing value is deleted when you enter the first character. Completely reenter
the value.

— Press and a cursor key simultaneously. The selection of the field content is
cancelled. Move the cursor in the existing value. You can now edit the characters of

the current value or add characters.

Use the key to delete the character to the right of the cursor. Use the key to
delete the character to the left of the cursor.

To enter the hexadecimal characters "A" to "F" switch the numerical keypad to letter

assignment with the key.

~ Ifthe LED of the ["#| key is lit, info text is available for the selected object or the

current screen.

Use the key to display the info text for the operator control or the current screen.

3. Select [ to confirm your entry.

TP 277, OP 277 (WinCC flexible)
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Result
You have changed the numerical value or entered a new one.

8.5.6 Entering and Editing Alphanumerical Values

Procedure
You can enter alphanumerical values character-by-character using the system keys.
Proceed as follows:
1. Select the desired input field within the screen with .
The existing value is selected in the input field.
2. Enter the value using the system keys.

You have the following options to enter a value:

— The existing value is deleted when you enter the first character. Completely reenter
the value.

— Press and a cursor key simultaneously. The selection of the field content is
cancelled. Move the cursor in the existing value. You can now edit the characters of
the current value or add characters.

Use the key to delete the character to the right of the cursor. Use the key to
delete the character to the left of the cursor.

To enter characters, switch the numerical keypad to character assignment with the
key.

— Ifthe LED of the key is lit, info text is available for the selected object or the
current screen.

Use the key to display the info text for the operator control or the current screen.
3. Select to confirm your entry.
Result

You have changed the alphanumerical value or entered a new one.

TP 277, OP 277 (WinCC flexible)
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8.5.7 Entering the Date and Time

Entering the Date and Time
Enter the date and time in the same way you enter alphanumerical values.

Note

When entering the date and time, please note that the format is determined by the
configured project language.

See also
Entering and Editing Alphanumerical Values (Page 8-17)

Setting the Project Language (Page 8-4)

8.5.8 Entering Symbolic Values

List box
When you select a symbolic IO field, a list box opens.
Figure 8-5  Symbolic IO field, example
Procedure
Symbolic values are selected from the entries of a list box.
Proceed as follows:
1. Select the desired symbolic input field input field within the screen with .
2. Select to open the list box. The list box opens.
3. Select the required entry using the cursor keys IZI |z| or IEI
4. Select "™ to confirm your entry.
Result

You have changed the symbolic value or entered a new one.

TP 277, OP 277 (WinCC flexible)
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8.5.9 Displaying Infotext

Purpose
The configuration engineer uses info text to provide additional information and operating
instructions. The configuration engineer can configure info text on screens and operator
controls.
The info text of an IO field may contain, for example, information on the value to be entered.
Info text
Enter termperature setpoint for Tank_1
(Range 40...80 =C)
Figure 8-6  Info text for an IO field, example
If the LED of the key is lit, an info text for the selected operator control or the current
screen has been configured.
Procedure

1. Press .

The info text for the selected operator control is displayed. If there is no info text for the
selected screen object, the info text for the current screen is displayed, if it has been
configured.

You can scroll through the contents of long info text with buttons Izl and IZI

Note
Switching between Displayed Info Text

The configuration engineer can configure info text for an IO field and the associated

screen. You can toggle between two info texts by pressing the || key.

2. Close the info text by pressing .

Alternative Procedure

Depending on your configuration, info text can also be called via a function key or a provided
operator control.

Further information on this may be available in your plant documentation.

TP 277, OP 277 (WinCC flexible)
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8.6 Bars and Gauges

8.6

Bar

Layout

Gauge

Layout
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Bars and Gauges

The bar is a dynamic display object. The bar displays a value from the PLC as a rectangular
area. The bar allows you recognize the following at a glance:

e The distance of the current value from the configured limit values
o Whether a set point value has been reached

The bar can display values such as fill levels or batch counts.

100

&0
30
o

The layout of the bar depends on the configuration.
e The bar may feature a scale of values.
e The configured limit values can be indicated by lines.

¢ Color changes can signal when a limit value has been exceeded or has not been
reached.

The gauge is a dynamic display object. The gauge displays numeric values in analog form
by means of a pointer. This enables an operator at the HMI device to see at a glance if the
boiler pressure is in the normal range, for example.

The layout of the gauge depends on the configuration.

¢ A trailing pointer can display the maximum value reached so far on the scale. The trailing
pointer is reset when the screen is reloaded.

e The label on the scale can show the measured variable, for example boiler pressure and
the physical unit, for example bar

TP 277, OP 277 (WinCC flexible)
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Operation

The bar and the gauge are for display only. Both objects cannot be controlled by the
operator.

8.7 Operating Switches

Introduction
A switch is an operator control and display object with two predefined states: "on" and "off."
Switches can signal the status of a system component, for example a motor. You can also
use the switch to change the status of the respective system component at the HMI device,
for example from "on" to "off".

Layout

The layout of the switch depends on the configuration.
¢ Switch with slider

The two states are displayed by the position of the slider.

Swyitch

©) Slider
¢ Switch with text or graphic
The two states are displayed by the label on the slider.

Depending on the switching state, the switch is labeled with one of two texts or one of two
graphics.

Examples:

"Backward" or "Forward"

Procedure with Touch Operation
e Switch with slider
Proceed as follows:
Move the slider to the other position or double-click the slider area.
o Switch with text or graphic
Proceed as follows:

Touch the switch.

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO 8-21



Operating a Project
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Procedure with Keyboard Operation
Proceed as follows:

1. Select the desired switch within the screen with .

2. Press .

Result
The switch changes its appearance. The associated value is switched.

8.8 Operating Slider Controls

Introduction

The slider control can be used to monitor and change process values within a defined range.
The slider control can also be configured without a slider. In this case, you cannot enter a
value. The slider control is then only used for displaying values.

SIMATIC

100

50—

Figure 8-7  Slider control — example

0] Slider control for entering values
® Value display with current value

Layout
The layout of the slider control depends on the configuration.
e The slider control can contain a label and a setting range, for example.

e The current value can be displayed below the area of the slider control.

TP 277, OP 277 (WinCC flexible)
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Procedure with Touch Operation
Proceed as follows:
1. Touch the slider of the desired slide control.
2. Move the slider to the required value.
If a value display has been configured, you can check the exact value that has been set.

3. Release the slider.

Keyboard Control
The table below shows the control keys used to set the slide to a desired value:

Shortcut key Description

N IZ' or N IE' Increase value by 1
. Iz' or . IE' Reduce value by 1
Increase value in 5% increments.
HOME
Decrease value in 5% increments.
END
. Set maximum value
HOME
\ Set minimum value
FN +
END

Procedure with Keyboard Operation
Proceed as follows:
1. Select the desired slider control within the screen with .

2. Set the slider to the required value.

If a value display has been configured, you can check the exact value that has been set.

Result
The set value is applied.

TP 277, OP 277 (WinCC flexible)
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8.9 Operating the Trend View

8.9 Operating the Trend View

Trends

Trend view

Trends continuously display the current process data or process data from a log.

Trends are displayed in the Trend view. A Trend view can display several trends
simultaneously.

100 ﬁﬂf100

D_:"'I"'I' '|"'|"'|:‘|:I

Trend Yalue b il

ul

*| I

Figure 8-8  Trend view, example

@ Ruler
® Trend value in the value table

Layout and Operation

Value Table
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The layout and operation of the Trend view depends on the configuration. The configuration
engineer defines the following:

e Appearance of the Trend view, the axes, value ranges and labels.
e Operating options of the Trend view

e Limit values for the trend values

e The change of color of the trend in the event of limit violation

Further information on this may be available in your plant documentation.

The trend values can be read from the value table if this is configured.

e When the ruler is displayed, the trend values are shown at a position of the ruler in the
value table.

e When the ruler is hidden, the latest trend values are displayed in the value table.

TP 277, OP 277 (WinCC flexible)
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Ruler
When configured, a ruler is available to provide an exact reading of the trend values in the
value table.
You can move the ruler to the desired position of the Trend view.

Operation

The trend view can be operated as follows:

¢ Enlarge or reduce the display of time intervals
e Scroll forward or back by one display width

e Stop or continue the trend recording.

¢ Move the ruler

o Hide and display the ruler

The configuration engineer can configure function keys or operator controls used to operate
the Trend view.

Further information on this may be available in your plant documentation.

8.10 Operating Status Force

8.10.1 Overview

Application

You read or write access values of the connected controller directly with status force. Status
force allows you to monitor or change operations of the controller program, etc. You don't
need to connect an additional programming device or additional PC to the controller.

Note
Status force can only be used in combination with SIMATIC S5 or SIMATIC S7.

TP 277, OP 277 (WinCC flexible)
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Layout
The layout of status force depends on the configuration.

The figure shows the general layout of status force. A value can be monitored or controlled
on every line.

CDnnectiDnl Typel Oﬂ‘aetl FDrmatl Control Yalue | [l
FLC_1 il 120 | DEC 33
FLC_1 T 40 T 24,00
FLC_1 o} 50 DEC of.—
FLC_1 o} 50 HEX 000
4] | ;IJ
A

Figure 8-9  Status force, example
The configuration engineer specifies which columns appear in status force.

The table shows the significance of all configurable columns.

Column Function

"Connection" The PLC whose address ranges must be displayed.
"Type", "DB Number", "Offset", The address range of the value

"Bit"

"Data Type", "Format" The data type of the value

"Status Value" The value read from the specified address.

"Control Value" The value to be written to the specified address.

Further information on this may be available in your plant documentation.

Operator Controls

Depending on your configuration, you can operate the Trend view using the following
buttons:

Buttons Function

G "Read" button

Updates the display in the "Status Value" column.

This button engages when it is pressed. You cannot operate any input fields until
the button is actuated again and the refresh is stopped.

o "Write" button

Applies the new value in the "Control Value" column. The control value is written
to the controller.

TP 277, OP 277 (WinCC flexible)
8-26 Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO




Operating a Project

8.10 Operating Status Force

8.10.2 Touch Operation

Operator Control Options
Status force can be operated as follows:
e Change the column sequence
¢ Read the status values of the connected controller

e Enter values and transfer them to the controller

Change Column Sequence
Depending on the configuration, you can change the column sequence of status force.
Proceed as follows:
1. Touch the column header which you wish to exchange with a different column header.

2. Keeping the touch screen pressed, move the column heading to the column heading you
wish to exchange it with.

Result
The columns are displayed in the modified sequence.

Procedure - Reading the Status Value
Proceed as follows:

1. Enter the address and the desired format of a value for each line. Touch the respective
columns to display the screen keyboard.

2. Once you have entered all of the desired values, touch the &’ button.

Result

All values are read cyclically by the controller and entered in the "Status Value" column until

the sl button is touched again.

Requirements for Forcing
The following requirements must be fulfilled in order to force values:
e The "Control Value" column must be available.

e The "Write" button must be available.

Procedure - Forcing a Value
Proceed as follows:

1. Enter the address of a value for each line. Enter the desired value in the "Control Value"
column. Touch the respective columns to display the screen keyboard.

2. Once you have entered all of the desired values, touch the b button.
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Result

The values from the "Control Value" column are transferred once to the controller.

8.10.3 Keyboard Control

Operator Control Options

Status force can be operated as follows:

e Change the column width

¢ Read the status values of the connected controller

e Enter values and transfer them to the controller

Keyboard Control

The following table lists the key combinations for operating the status force:

Function

Operates the "Read" button.

CTRL ENTER
+

Operates the "Write" button

+

+

Selects the first/last field in the current line

+

Selects the first/last field in the current column

INS
DEL

+

5 S| =

T || =

— — 1 L — 1 L
+

Deletes the current row
Otherwise:
Do not select a controller in the "Connection" column.

Opens selection field

cTRL| | ALT
+ +

Increases the width of the current column.

[a]|[v]

+
+

Decreases the width of the current column.

Optimizes column width.
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Procedure - Reading the Status Value
Proceed as follows:

1. Enter the address and format of the status value for each status value you wish to read in
one line. Select the respective fields and enter the values using the keyboard.

{ 1}
2. Press + .

Result

All values are read cyclically by the controller and entered in the "Status Value" column until

[
the + buttons are pressed again.

Requirements for Forcing
The following requirements must be fulfilled in order to force values:
e The "Control Value" column must be available.

e The "Write" button must be available.

Procedure - Forcing a Value
Proceed as follows:

1. Enter the address of a value for each line. Enter the desired control value in the "Control
Value" column. Select the respective fields and enter the values using the keyboard.

2. Once you have entered all of the desired control values, press the [CTRY + [FN=R| key.

Result
The values from the "Control Value" column are transferred once to the controller.

Alternative Procedure

Alternatively, you can also select the sl and A buttons with the key

and operate them with .
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8.11 Operating the Sm@rtClient View

8.11

8.11.1

Application

Layout

Monitoring Mode

Operation
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Operating the Sm@rtClient View

Overview

The Sm@rtClient view enables you to monitor and remotely operate the current project of a
remote HMI device. With the correct configuration, several democratic HMI devices can
access a remote HMI device.

Note

If another HMI device accesses your HMI device via the Sm@rtClient view, this leads to an
additional load on your HMI device.

In the Sm@rtClient view, the remote HMI is displayed with the complete layout.
Depending on the configuration, you can monitor and also operate this screen.

You can also operate the function keys like buttons on an HMI device with a touch screen.

On a Sm@rtClient view which is configured for monitoring mode, you can only monitor the
remote HMI device. You cannot control its operation.

Note

It is not possible to operate the direct keys of the remote HMI device from the local HMI
device.

The available operator controls depend on the HMI devices used:
e Same type of HMI devices

You can operate the project of the remote HMI device with the operator controls of your
HMI device.

o Key operation from a local touch screen

All the keys of the remote HMI device are displayed as buttons on the touch screen. You
can also touch them to operate them.

e Touch operation from a local HMI device using keys

You operate the buttons in the usual manner.
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8.11.2 Touch Operation

Operator Control Options
The Sm@rtClient view can be operated as follows:

Starting remote control
Forcing permission

Ending remote control

Procedure — Starting Remote Operation
Proceed as follows:

1.

On the HMI device change to the screen with the Sm@rtClient view.

The following options are available for establishing the connection to the remote HMI
device:

— The connection is established automatically.
— The connection must be established by touching the appropriate button.

Depending on the configuration, you may be required to enter the address of the
remote HMI device and a password.

The current screen of the project running on the remote device is displayed on the screen
of your HMI device.

You can now monitor and control this screen depending on your configuration.

Scroll bars are displayed if the screen of the remote HMI device is larger than that of the
current HMI device.

Procedure - Forcing Permissions

If several HMI devices have access to a HMI device, only one HMI device has operating
permission at any one time.

Two cases must be distinguished for this case:

If another HMI device is already controlling the remote HMI device, if configured
accordingly, you can force operating permission for the remote HMI device.

— You are trying to operate the remote HMI device.

— A dialog appears in which you are prompted to enter the appropriate password for
forcing remote control.

— You are now authorized to operate the remote HMI device.

If another HMI device is accessing your HMI device via the Sm@rtClient view, you can
force local operating permission for your HMI device.

— Touch the screen of your HMI device five times consecutively.

— You are given permission to operate your local HMI device.
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Procedure — Ending Remote Control

You can end monitoring and control of a remote HMI device with one of the following
methods depending on the configuration:

e Touch a button configured for this action.
e Exit the screen containing the Sm@rtClient view.

e If configured, a menu is displayed after you have touched an empty space over a longer
period. Touch the menu item "Close".

Further information on this may be available in your plant documentation.

8.11.3 Keyboard Control

Operator Control Options
The Sm@rtClient view can be operated as follows:
¢ Starting remote control
e Forcing permission

e Ending remote control

Procedure — Starting Remote Operation
Proceed as follows:
1. On the HMI device change to the screen with the Sm@rtClient view.

The following options are available for establishing the connection to the remote HMI
device:

— The connection is established automatically.

— Press until the Sm@rtClient view is selected.

Depending on the configuration, you may be required to enter the address of the
remote HMI device and a password.

The connection is established. The current screen of the project running on the remote
device is displayed on the screen of your HMI device.

2. You can now monitor and control this screen depending on your configuration.

3. Scroll bars are displayed if the screen of the remote HMI device is larger than that of the
current HMI device. Move the scroll bars in the desired direction using + IZI or

-9
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Procedure - Forcing Permissions

If several HMI devices access an HMI device, only one HMI device has permission to
operate.

Two cases must be distinguished for this case:

¢ If another HMI device is already controlling the remote HMI device, if configured
accordingly, you can force operating permission for the remote HMI device.

— You are trying to operate the remote HMI device.

— A dialog appears in which you are prompted to enter the appropriate password for
forcing remote control.

You are now authorized to operate the remote HMI device.
¢ If another HMI device is accessing your HMI device via the Sm@rtClient view, you can
force local operating permission for your HMI device.

- Press five times consecutively.

You are given permission to operate your local HMI device.

Procedure — Ending Remote Control

You can end monitoring or control of a remote HMI device with one of the following methods
depending on the configuration:

e Press the key configured for this.

¢ Exit the screen containing the Sm@rtClient view.

e If configured, display a menu with + . Select the desired menu command with
and the respective identification letter.

Further information on this may be available in your plant documentation.
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8.12 Project Security

8.12 Project Security

8.12.1 Overview

Design of the Security System

The configuration engineer can protect the operation of a project by implementing a security
system.

The security system is based on authorizations, user groups and users.

If operator controls protected by a password are operated, the HMI device first requests that
you log on. A logon screen is displayed in which you enter your user name and password.
After logging on, you can operate the operator controls for which you have the necessary
permissions.

The logon dialog can be set up by the configuration engineer via an individual operator
control.

In the same way, the configuration engineer can set up an operator control to log off. After
logging off, objects assigned password protection can no longer be operated; to do so, log
on again.

Further information on this may be available in your plant documentation.

User Groups and Permissions

Project-specific user groups are created by the configuration engineer. The "Administrators"
and "PLC User" groups are included in all projects by default. User groups are assigned
permissions. Permission required for an operation is specifically defined for each individual
object and function in the project.

Users and Passwords

Logoff Times

8-34

Each user is assigned to exactly one user group.

The following people are allowed to create users and assign them passwords:
e The configuration engineer during configuration

e The administrator on the HMI device

o A user with user management permission on the HMI device

Irrespective of the user group, each user is allowed to change his own password.

A logoff time is specified in the system for each user. If the time between any two user
actions, such as entering a value or changing screens, exceeds this logoff time, the user is
automatically logged off. The user must then log on again to continue to operate objects
assigned password protection.
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Backup and Restore

The user data is encrypted and saved on the HMI device to protect it from loss due to power
failure.

The users, passwords, group assignments and logoff times set up on the HMI device can be
backed up and restored. This prevents you having to enter all of the data again on another
HMI device.

Notice

The currently valid user data is overwritten in the following cases:

e Depending on the transfer settings, when the project is transferred again.
e Upon restore of a backed-up project.

e Upon import of the user administration via an operator control. Further information on this
may be available in your plant documentation.

The retransferred or restored user data and passwords are valid with immediate effect.

Limits for Users, Password and User Views

8.12.2

Application

Layout

Number of characters
Length of user name, maximum 40
Length of password, minimum 3
Length of password, maximum 24
Entry in user view, maximum 50

User View

The user view is used to display the users on the HMI device.

o All users on the HMI device are displayed in the user view to the administrator or to a
user with administrator permissions.

e If you are a user without user management permission, you can only see your personal
user entry.

The permissions of a user after logging on depends on the user group to which the user is
assigned.

Further information on this may be available in your plant documentation.

The configuration engineer can implement simple or enhanced user view.

The two user views offer the same functions. They differ only in the display of information.
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8.12 Project Security

Simple User View

If you are not logged on to the HMI device, the only entry contained in the simple user view
is "<ENTER>".

If you are logged on to the HMI device, the simple user view only displays the user name
and user group.

Group (9%
PLC User Group (1)
Uzer 1 Group (1)
<hew Lisers>

Enhanced User View

8.12.3

Logon Dialog

8-36

The enhanced user view displays information about the users.

Group (9%

PLC Llger || ****wrss | Group (1) 5

User 1 | **wwswsrss | Group (1) 5

1| [ E

The enhanced user view contains the following columns:
e User

e Password

e Group

e Logoff time

The passwords are encrypted by appear as asterisks.

User Logon

Use the logon dialog to log on to the security system of the HMI device. Enter your user
name and password in the logon dialog.

=
Liser: I
Password: I
Ok | Cancel
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8.12 Project Security

The logon dialog opens in the following cases:

You are operating an operator control with password protection.

You are operating an operator control that was configured for displaying the logon dialog.
Activate the "<ENTER>" entry in the simple user view.

Activate a blank entry in the extended user view.

The logon dialog will be automatically displayed when the project is started, depending on
the configuration.

Further information on this may be available in your plant documentation.

Requirements

The logon dialog is open.

Procedure with Touch Operation

Proceed as follows:

1.

2.

Enter the user name and password.
Touch the corresponding input field. The alphanumerical screen keyboard is displayed.
Select "OK" to confirm logon.

Procedure with Keyboard Operation

Proceed as follows:

1.
2.

Select the input field "User" within the logon dialog with .

Enter the user name using the system keys.

To enter characters, switch the numerical keypad to character assignment with the
key.

Select the input field "Password" with .

Enter the password using the system keys.

5. Confirm your entries with "OK".

Result

Note
The user name is not case-sensitive.

The password is case-sensitive.

After successful logon to the security system, you can execute password-protected functions
on the HMI device for which you have permissions.

If you enter a wrong password, an error message is displayed when an Alarm window has
been configured.
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8.12 Project Security

8.12.4 User Logoff

Requirements
You have logged into the security system of the HMI device.

Procedure
You have the following options for logging off:
¢ You operate an operator control that was configured for logoff.
¢ You will be logged off automatically if you are not operating the project and if the logoff
time has been exceeded
You will also be automatically logged off if you enter an incorrect password.
Result

You are no longer logged into the project. In order to operate an operator control with
password protection, you must first log on again.

8.12.5 Creating Users

8.12.5.1 Creating Users with Touch Operation

Requirement
You have opened a screen containing the user view.

You have user management permission or you are the administrator.

Notice
The following characters cannot be used in passwords:
e Space character

e Special characters *? . % /\"'"
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8.12 Project Security

Procedure - Creating a User in the Simple User View
Proceed as follows:
1. Touch the "<New User>" entry in the user view.

The following dialog opens:

N x|
Lser: I
Password: I
(04 | Cancel |

2. Enter the desired user name and password.
Touch the corresponding input field. The alphanumerical screen keyboard is displayed.
3. Touch the "OK" button.

The following dialog opens:

DN x|
Group: |Group (1) |

Logoff time: |5

(04 I Cancel |

4. Assign the user to a group.

Use »|to open the list box "Group”. Select | and «|to scroll in the list box.
5. Touch the required entry in the drop-down list.

The selected entry is then accepted as input.
6. Touch the input field "Logoff time". The screen keyboard is displayed.

7. Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for "no
automatic logoff."

8. Confirm your entries with "OK".

Procedure - Creating a User in the Enhanced User View
Proceed as follows:
1. Touch the desired field in the blank line of the user view.
The appropriate screen keyboard is displayed.
2. Enter the respective user data in the field:
— Assign the user to one of the groups from the list box.

— Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for
"no automatic logoff."
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8.12 Project Security

Result

The new user is created.

8.12.5.2 Creating Users with Key Operation

Requirement

You have opened a screen containing the user view.

You have user management permission or you are the administrator.

Notice
The following characters cannot be used in passwords:
e Space character

e Special characters *? . % /\"'"

Procedure - Creating a User in the Simple User View

8-40

Proceed as follows:

1. Select the user view with the key or with the cursor keys.

2. Select the entry "<New user>" in the user view with the cursor keys and confirm with |[*N™*

The following dialog opens:
RN x|

Liser: I

Password: I

Ok | Cancel |

3. Enter the desired user name using the system keys.

4. Select the next input field with the key and enter a password using the system keys.

5. Confirm your entries with "OK".

The following dialog opens:

O x|
Gravip: |Group (1) |
Logoff time: |5

Cancel |
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8.12 Project Security

Select the selection field "Group" with .

Assign the user to a group.

— Select [*"™"| to open the list box. The list box opens.

— Select the required entry using IZI or Izl

— Confirm the selection by pressing the key.

Select the input field "Logoff time" with .

Enter the desired logoff time using the system keys.

Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for "no
automatic logoff."

10.Confirm your entries with "OK".

Procedure - Creating a User in the Enhanced User View

Proceed as follows:

1.

2.

Result

Select the user view with the key via the configured tab order.

Select a blank line with the IZ' or Iz' keys.

Select the desired field in the blank line of the user view with the IE' or IE' keys.

Confirm the selection by pressing the key.
Enter the desired user data:

— Enter the data using the system keyboard. To enter characters, switch the numerical

keypad to character assignment with the key.

— Assign the user to one of the groups from the list box. Open the list box with the

key and select the desired entry with the |Z| or Izl keys.

— Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for
"no automatic logoff."

. Select [*'™"| to confirm your entry.

The new user is created.
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8.12 Project Security

8.12.6 Changing User Data

8.12.6.1 Changing user data with touch operation

Requirements
You have opened a screen containing the user view.
Which data you are allowed to change depends on your permission:

¢ You are an administrator or a user with user management permission. In these cases you
are allowed to change the data for all the users on the HMI device in the user view:

User name

Group assignment

Password

Logoff time

e You are a user without user management permission. In this case you are only allowed to
change your personal user data:

— Password

— Logoff time, if configured

Note
You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging
on via the PLC

Procedure - Changing User Data in the Simple User View
Proceed as follows:
1. In the user view, touch the user whose user data you want to change.

2. When entering the data, use exactly the same procedure as for creating a user.

Procedure - Changing User Data in the Enhanced User View
Proceed as follows:
1. In the user view, touch the user whose user data you want to change.

2. When entering the data, use exactly the same procedure as for creating a user.

Result
The user data for the user is changed.
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8.12 Project Security

8.12.6.2 Changing User Data with Key Operation

Requirements

You have opened a screen containing the user view.

Which data you are allowed to change depends on your permission:

¢ You are an administrator or a user with user management permission. In these cases you
are allowed to change the data for all the users on the HMI device in the user view:

User name
Group assignment
Password

Logoff time

e You are a user without user management permission. In this case you are only allowed to
change your personal user data:

Password

Logoff time, if configured

Note
You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging
on via the PLC

Procedure - Changing User Data in the Simple User View
Proceed as follows:

1. Select the user view with the key.

2. In the user view, use the cursor keys to select the user whose user data you want to

change. Confirm by pressing the [*'"=| key.

3. When entering the data, use exactly the same procedure as for creating a user.

Procedure - Changing User Data in the Enhanced User View

Proceed as follows:

1. Select the user view with the key.

2. Use the cursor keys to select the field the data of which you want to change. Confirm by

pressing the [} key.

3. When entering the data, use exactly the same procedure as for creating a user.
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8.13 Closing the Project

Result
The user data for the user is changed.

8.12.7 Deleting a User

Requirements
You have opened a screen containing the user view.

To delete a user, you must be an administrator or have user management permission.

Note
The "Admin" and "PLC_User" users exist by default. These users cannot be deleted.

Procedure
To delete a user, delete the user name entered.

Result
The user has been deleted and may no longer log onto the project.

8.13 Closing the Project

Procedure
Proceed as follows:
1. Use the configured operator control to close the project.
Wait for the Loader to open after you closed the project.

2. Switch off power to the HMI device.
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9.1 Overview

Alarms

Alarm Classes

Alarms indicate events and states on the HMI device which have occurred in the system, in
the process or on the HMI device itself. A status is reported when it is received.

An alarm could trigger one of the following alarm events:
¢ Incoming

¢ Outgoing

e Acknowledge

The configuration engineer defines which alarms must be acknowledged by the user.
An alarm may contain the following information:

e Date

e Time

e Alarm text

e Location of fault

e Status

e Alarm class

e Alarm number

e Alarm group

o Diagnostics capability

Alarms are assigned to various alarm classes:
e Error

Alarms in this class must always be acknowledged. Error alarms normally indicate critical
errors within the plant such as "Motor temperature too high".

e Operation
Warning alarms usually indicate states of a plant such as "Motor switched on".
e System

System alarms indicate states or events which occur on the HMI device.
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Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO 9-1



Operating Alarms

9.2 Recognizing Pending Alarms

Alarm Groups

Alarm Buffer

Alarm Report

Alarm Log

o SIMATIC diagnostic alarms

SIMATIC diagnostic alarms show states and events of the SIMATIC S7 or SIMOTION
controllers.

e User-specific alarm classes
The properties of this alarm class must be defined in the configuration.

Further information on this may be available in your plant documentation.

The configuration engineer can group alarms into alarm groups. When you acknowledge an
individual alarm of an alarm group, you acknowledge all alarms which belong to the same
alarm group.

The alarm events are stored in an internal buffer. The size of this alarm buffer depends on
the HMI device type.

The configuration engineer can activate alarm logging on the project. In this case, alarm
events are output directly on the connected printer.

The configuration engineer can define whether each individual alarm is logged. An alarm of
this type is printed when the alarm events "Incoming" and "Outgoing" occur.

If you want to print alarms of the "System™ alarm class, you have to print the contents of the
associated alarm buffer. For this case the configuration engineer has to configure an
operator control for printing the alarm buffer.

Alarm events are stored in an alarm log, provided this log file is configured. The capacity of
the log file is limited by the storage medium and system limits.

9.2 Recognizing Pending Alarms

Introduction

9-2

You can recognize the presence of alarms which must be acknowledged by the following:

e For an HMI device with keys: The LED in the key is lit.
¢ Depending on the configuration: An alarm indicator is displayed on screen.

The configuration determines whether an alarm has to be acknowledged. This is also
defined by the alarm class which an alarm belongs to.
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9.3 Displaying Alarms

LED in the "ACK" Key

Alarm Indicator

An LED in the is found on an HMI device with keys. The LED is lit if there are alarms

requiring acknowledgment which must still be acknowledged.

The LED goes out when you acknowledge all alarms requiring acknowledgment.

The alarm indicator is a graphic symbol indicating queued alarms or alarms requiring
acknowledgment, depending on the configuration.

/N

3

Figure 9-1 Alarm indicator with three queued alarms

The alarm indicator flashes as long as alarms are queued for acknowledgment. The number
displayed indicates the number of queued alarms. The configuration engineer can assign
functions to be executed when the alarm indicator is operated.

Usually, the alarm indicator is only used for error alarms. Further information may be
available in your plant documentation.

9.3 Displaying Alarms

Displaying Alarms

Alarm View

Alarms are indicated in the alarm view or in the alarm window on the HMI device.

Depending on the configuration, the alarm view is displayed as follows:

e As a single line. Alarm numbers and alarm texts are displayed as single lines.
e As simple Alarm view

e As enhanced Alarm view

In the simple or enhanced Alarm views the configuration engineer specifies the alarm
information to be displayed.

Depending on the configuration, alarms from alarm logs are also displayed in the Alarm
view.
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9.3 Displaying Alarms

Simple Alarm View

19.04.2005 11:41:37 ! 1

Motor 23 too hot

- | |»|P

_?| J

The buttons have the following functions:

Button Function

Displaying info text for an alarm.

Process alarm.

Acknowledge alarm.

Select the next or previous alarm in the list

To scroll one page up or down

=EEER

Enhanced Alarm View

| |No. |Time |Date |Status
11 12:04:59 19.04.2005 K

i\/lotor 23 too hot

& | F |

The buttons have the following functions:

I

Button Function

Displaying info text for an alarm.

Process alarm.

Acknowledge alarm.

1.

Changing the Column Sequence and Sorting in the Enhanced Alarm View

Depending on the configuration, you can change the column sequence and sorting order on
HMI devices with touch operation.

e Change column sequence
— Touch the column header which you wish to exchange with a different column header.

— Keeping the touch screen pressed, move the column heading to the column heading
you wish to exchange it with.
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9.4 Displaying an Alarm Info Text

e Change sorting order

To change the sorting order of the alarms, touch the respective column header on the
touch screen.

Alarm Class Layout

The various alarm classes are identified in order to distinguish between them in the Alarm

view.

Symbol Alarm class

! Error

Without a symbol Operation

Symbol depending on the configuration | User-defined alarm classes

S7 SIMATIC or SIMOTION Diagnostic Alarms
$ System

The configuration engineer can change the symbols for the alarm classes. Further
information on this may be available in your plant documentation.

Alarm Window

The alarm window is independent of the process screen. Depending on the configuration,
the alarm window opens automatically as soon as a new alarm is queued for
acknowledgment. The alarm window can be configured so that it only closes after all the
alarms have been acknowledged.

The layout and the operation of the alarm window are the same as for the Alarm view.

Further information on this may be available in your plant documentation.

9.4 Displaying an Alarm Info Text

Displaying Info Text

The configuration engineer can also provide info text for alarms.

Procedure with Touch Operation
Proceed as follows:
1. Touch the desired alarm in the Alarm view or the alarm window.
The alarm is selected.

2. Touch the j button in the simple Alarm view or in the enhanced Alarm view.

If configured, the info text assigned to this alarm is displayed.

3. Close the window displaying the info text with [x].
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9.5 Acknowledge Alarm

Procedure with Keyboard Operation
Proceed as follows:

1. Selected the desired alarm in the Alarm view.

2. Press .

If configured, the info text assigned to this alarm is displayed.

3. Close the info text by pressing .

See also
Displaying Alarms (Page 9-3)

9.5 Acknowledge Alarm

Requirements
The message to be acknowledged is displayed in the alarm window or the Alarm view.

Procedure with Touch Operation
Proceed as follows:
1. Touch the desired alarm in the Alarm view or the alarm window.
The alarm is selected.

2. Touch the J button in the simple Alarm view or 5 | in the enhanced Alarm view.

Procedure with Keyboard Operation

The alarm view and the alarm window have a tab sequence with which you can select
operator controls and the last selected alarm using the keyboard.

1. Select the desired alarm view or alarm window with .

2. Select the desired alarm. Use the , , |z| or |Z| keys.
3. Press .

Alternative Operation

Depending on the configuration, you can also acknowledge an alarm with a function key.
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9.6 Edit Alarm
Result
The alarm is acknowledged. If the alarm belongs to an alarm group, all the messages of the
associated group are acknowledged.
More information on acknowledgment and on available alarm groups may be found in your
plant documentation.
See also

Displaying Alarms (Page 9-3)

9.6 Edit Alarm

Introduction

The configuration engineer can assign additional functions to each alarm. These functions
are executed when the alarm is processed.

Note
When you edit an unacknowledged alarm, it is acknowledged automatically.

Requirement

The alarm to be edited is displayed in the alarm window or the Alarm view.

Procedure with Touch Operation
Proceed as follows:

1. Touch the desired alarm in the Alarm view or the alarm window. The alarm is selected.

2. Touch the ﬂ button in the simple Alarm view or & | in the enhanced Alarm view.

Procedure with Keyboard Operation
Proceed as follows:

1. Select the desired alarm view or alarm window with .

2. Select the desired alarm. Use the , , |Z| or |z| keys.
3. Press until the ﬂ button is selected in the simple Alarm view or & | is

selected in the enhanced Alarm view.

4. Perform the operation with the [ key.
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9.6 Edit Alarm

Result
The system executes the additional functions of the alarm. Further information on this may
be available in your plant documentation.

See also

Displaying Alarms (Page 9-3)
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10.1 Overview

Introduction

Recipes are used when different variants of a product are manufactured with the same
process. In this case, the product variants differ in terms of their type and quantity of the
components, but not in terms of the manufacturing process sequence. The configuration
engineer can store the combination of each individual product variant in a recipe.

Field of Application

Recipes can be used everywhere the same product components are used in variable
combinations to create different product variants.

Examples:

e Beverage industry

e Food processing industry
e Pharmaceutical industry

e Paint industry

¢ Building materials industry

e Steel industry

10.2 Structure of a Recipe

Recipes

The recipe collection for the production of a product family can be compared to a file cabinet.
A recipe which is used to manufacture a product corresponds to a drawer in a file cabinet.

Example:

In a plant for producing fruit juice, recipes are required for different flavors. There is a recipe,
for example, for the flavors orange, grape, apple and cherry.
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10.2 Structure of a Recijpe

©

®

©

®

v/
v/
. o
' 4
<« /
| [
@ File cabinet Recipe collection
@ Drawer Recipe
® Drawer Recipe
@ Drawer Recipe
® Drawer Recipe

Recipe Data Records

®

Recipes for a fruit juice plant
Orange flavored drinks
Grape flavored drinks

Apple flavored drinks
Cherry flavored drinks

The drawers of the file cabinet are filled with suspension folders. The suspension folders in
the drawers represent records required for manufacturing various product variants.

Example:

Product variants of the flavor apple might be a soft drink, a juice or nectar, for example.

ONONONO

>

Drawer

® 00

10-2

Suspension folder
Suspension folder
Suspension folder

Recipe

Product variants of apple flavored drinks

Recipe datarecord  Apple drink
Recipe datarecord  Apple nectar
Recipe datarecord  Apple juice

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO



Operating Recipes

Elements

10.3 Recipes in the Project

In the figure showing the file cabinet, each suspension folder contains the same number of
sheets. Each sheet in the suspension folder corresponds to an element of the recipe data
record. All the records of a recipe contain the same elements. The records differ, however, in
the value of the individual elements.

Example:

All drinks contain the same components: Water, concentrate, sugar and flavoring. The
records for soft drink, fruit juice or nectar differ, however, in the quantity of sugar used in
production.

10.3 Recipes in the Project

Overview

If recipes are used in a project, the following components interact:

Recipe view / recipe screen

On the HMI device, recipes are displayed and edited in the recipe view or in a recipe
screen.

— The recipe data records from the internal memory of the HMI device are displayed and
edited in the recipe view.

— The values of the recipe tags are displayed and edited in the recipe screen

Depending on the configuration, the values displayed in the recipe view are synchronized
with the values of recipe tags.

HMI-device recipe memory

Recipes are saved in the form of data records in the HMI-device recipe memory.
The recipe data can also be saved in recipe tags.

Recipe tags

The recipe tags contain recipe data. When you edit recipes in a recipe screen, the recipe
values are stored in recipe tags. Depending on the configuration, the values of the recipe
tags are exchanged with the PLC.

The recipe tags can be synchronized with the recipe data records so that the same
values are saved in both.

Memory card

The memory card is an external storage medium for recipe data records. The recipe data
records are exported from the HMI-device recipe memory and are saved on the memory
card in a *.csv file. The records can be reimported from the memory card to the recipe
memory.
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10.4 Displaying Recipes

Data Flow
The following figure shows the data flow in a project with recipes.

HMI device m
Recipe view @ w

Recipe 1
Recipe 2

=0 @ Recipe 3

1. ©
Recipe tag
Recipe
screen @ k _/

© s [

Memory card

Editing, saving or deleting a recipe data record
Display recipe data record

Synchronize or do not synchronize recipe tags
Display and edit recipe tags in the recipe screen

Write records from the recipe view to the PLC or read records from the PLC and
display them in the recipe view.

Recipe tags are for online or offline control

Q©® O© 00

Export or import recipe data record to memory card

10.4 Displaying Recipes

Displaying Recipes
You can display and edit recipes on the HMI device with a recipe view or recipe screen.

Recipe View

A recipe view is a screen object used to manage recipe data records. The recipe view shows
recipe data records in tabular form.

Depending on the configuration, the recipe view is displayed as follows:
¢ As enhanced recipe view
o As simple recipe view

The configuration engineer also defines which operator controls are displayed in the recipe
view.
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10.4 Displaying Recipes

Enhanced Recipe View
The figure below shows an example of the enhanced recipe view.

Fecipe Mame:

Mo,
( >7|Orange j |1 4@
Mo,

Data Record Mame:

@7|Nectar j|2 4@

Entry Marme Yalue -
@7 Water 40—4@)
Concentrate 0™

oo0_Com

Selection field for the recipe
Selection field for the recipe data record

Element name
The element name designates a specific element in the recipe data record.

Display field

This show the number of the selected recipe or the selected recipe data record.
Value of the element

Buttons for editing a recipe data record

Status bar for display of the status messages

Qe & 00

Simple Recipe View
The simple recipe view consists of three areas:
e Recipe list
e Record list
e Element list

In the simple recipe view, each area is shown separately on the HMI device. Depending on
the configuration, the simple recipe view starts with the recipe list.

The figure below shows an example of the record list.

=

Juice

2 Beverage -
Nectar
—

3

0]
@
®
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10.4 Displaying Re

Display of Values

cipes

Notice
Changing the recipe data record in the background

Applies to the processing of a recipe data record:
If values of the corresponding recipe data record are changed by a control job, the recipe
view is not updated automatically.

To update the recipe view, reselect the respective recipe data record.

Recipe Screen

10-6

A recipe screen allows the correlation between the plant and the recipe data to be displayed
in graphic form. The configuration engineer combines 10 fields and screen objects to form a
custom input screen. The configuration engineer can distribute the 10 fields of a recipe over
several recipe screens, thus allowing recipe elements to be arranged by subject. The recipe
screen can be operated using buttons configured accordingly.

The figure below shows an example of the recipe list.

N N
40 - Recipe name No.:
70 - |Orange Tl 1
30 - Data record name No.:
30 -) | Nectar W 2 J)

-~
Save |

~
Data from the PLC |

Load | Data to PLC

® QD
Element name and associated values

The element name designates a specific element in the recipe data record.
Buttons for editing a recipe data record

Modified recipe view

Buttons for transferring recipe data

)

®e0 O

The values displayed or entered in the recipe screen are saved in recipe tags. The recipe
values are exchanged with the PLC immediately or later via these tags.

A configured recipe view can itself be a component of a recipe screen You must synchronize
the tags in order to synchronize data between the tags of the recipe screen and the recipe
data records displayed in the recipe view. Synchronization of tags is only possible in the
enhanced recipe view.

Further information on this may be available in your plant documentation.
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10.5 Recipe Values in the HMI Device and the PLC

Introduction

You can change the values of a recipe on the HMI device and therefore influence the
manufacturing process or a machine.

Depending on the configuration, the recipe values are displayed, edited and saved in
different ways.

o If you are editing recipes with a recipe view in your project, the values are saved in recipe
data records.

o If you are editing recipes in a recipe screen in your project, the values are saved in recipe
tags.

Differences may occur between the display values in the recipe view and the values saved in
the associated tags in an ongoing project when you edit recipes with a recipe view and in a
recipe screen. To prevent this, the recipe data record values must be synchronized with the
values of the recipe tags.

You have however the option to completed operation fro synchronization at any time.
Synchronization takes only place, if the configuration engineer has activated the respective
settings for a recipe.

Note

Recipe tags can only be synchronized in the enhanced recipe view.

Synchronizing Recipe Tags
Synchronization of the recipe tags depends on the configuration:
¢ Automatic synchronization:

The values of the recipe view are synchronized with the associated recipe tags In this
case, changes to values in the recipe view have an immediate effect on the values of the
associated recipe tags. The values are only synchronized, when an operator control that
is outside the recipe view is operated.

e Synchronization by the user:

The values of the recipe view and the associated recipe tags are not synchronized
automatically. The configuration engineer has assigned the same function to the él
button or a different operator control in the recipe view. The recipe tags and the recipe
view are only synchronized when you operate the buttons or the appropriate operator

control.

TP 277, OP 277 (WinCC flexible)
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Recipe Tags Online / Offline

The configuration engineer can configure a recipe so that changes to the values of the recipe
tags do not have an immediate effect on the current process.

Synchronization of the recipe values between the HMI device and the PLC depends on
whether the configuration engineer has selected the settings "Tags online" or the setting
"Tags offline" for a recipe.

"Tags online":
This setting has the following effect:

— When you change recipe values in the recipe screen, these changes are applied
immediately by the PLC and immediately influence the process.

— If recipe values are changed in the PLC, the changed values are displayed
immediately in the recipe screen.

"Tags offline":

With this setting, changed recipe values are not synchronized immediately between the
HMI and the PLC.

In this case, the configuration engineer must configure operator controls for transferring
the values to the PLC or reading them from the PLC in a recipe screen. The recipe values
are only synchronized when you operate the appropriate operator control.

10.6 Operating the Recipe View

10.6.1 Overview

Operation

The recipe view can be operated as follows:

10-8

Enter values for the recipe elements

Create recipe data records

Save recipe data records or save them under a new name

Delete recipe data records

Synchronize values of the recipe view with the associated recipe tags

Transfer recipe data records from the PLC and to the PLC

TP 277, OP 277 (WinCC flexible)
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Operator Controls of the Recipe View

10.6 Operating the Recipe View

The table below shows the operator controls of the recipe view.

Hotkeys

Function

{1

Creates a new recipe data record.
If a start value is configured, it is shown in the input field.

CTRL| ENTER
+

Saves the displayed values of the recipe data record.
The storage location is predefined by the project.

+

The recipe data record is saved under a different name
irrespective of the recipe view. A dialog box opens in which
the name is entered.

-
=
py)
—
+

The displayed recipe data record is deleted.

0O
=
)
P

o] =] l=]o]E

+

The values of the recipe view are synchronized with the
associated recipe tags The values changed during editing are
written to the associated recipe tags. Subsequently all the
values of the tags are read out and updated in the table.

CTR

The recipe values from the PLC are displayed in the recipe
view.

&l
3
[@E @E

The values of the set recipe data record displayed in the
recipe view are transferred to the PLC.

Operating the Recipe Screen

You operate the recipes in a recipe screen with the operator controls provided by the

configuration engineer.

Further information on this may be available in your plant documentation.

10.6.2 Creating a Recipe Data Record

Introduction

You create a new recipe data record by modifying an existing record. You then save the
modified data record under a new name.

Requirements

A screen with a recipe view is displayed.

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO

10-9



Operating Recipes

70.6 Operating the Recipe View

Procedure with Touch Operation
Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe for which you want to create
a new recipe data record.

. Touch El

A new recipe data record with the next available number is created.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

. Enter values for the elements of the data record.

The elements of the recipe data record can be assigned default values depending on the
configuration.

Touch E

Enter a name for the data record.
The data record is saved under the new name.

If the recipe data record already exists, a dialog is opened. In this dialog, specify whether
the existing data record is to be overwritten.

Procedure with Keyboard Operation
Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe for which you want to create
a new recipe data record.

{ }
. Press +.

A new recipe data record with the next available number is created.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

Enter values for the elements of the data record.

The elements of the recipe data record can be assigned default values depending on the
configuration.

5. Enter a name for the data record.

6. Confirm your entry.

Result

The data record is saved under the new name.

If the recipe data record already exists, a dialog is opened. In this dialog, specify whether
the existing data record is to be overwritten.

The new recipe data record is saved to the selected recipe.

10-10
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See also

70.6 Operating the Recipe View

Recipes in the Project (Page 10-3)

10.6.3 Editing a Recipe Data Record

Introduction

Edit the values of the recipe data records and save them in a recipe view.

Synchronization with the PLC

If you want to display the current recipe values from the PLC in the recipe view, you first

have to read the current values from the PLC with El

The values changed in the recipe view only take effect in the PLC when you transfer the

changed record to the PLC with El

Requirement

A screen with a recipe view is displayed.

Procedure with Touch Operation
Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

Select the recipe data record you want to change.

3. Change the data record as required.

. Save your changes with El

If you want to save the recipe data record under a different name, touch the El key.

The recipe data record is saved.

Procedure with Keyboard Operation
Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

Select the recipe data record you want to change.

3. Change the data record as required.

Save your changes with + [ENTER|
If you want to save the recipe data record under a different name, press + _

The recipe data record is saved.

TP 277, OP 277 (WinCC flexible)
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Result
The edited recipe data record has now been saved in the selected recipe.

See also
Recipes in the Project (Page 10-3)

10.6.4 Deleting a Recipe Data Record

Introduction
You can delete all the data records of a recipe which are not required.

Requirements
A screen with a recipe view is displayed.

Procedure with Touch Operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to delete.

3. Touch ﬂ

Procedure with Keyboard Operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to delete.

INS
3. Press + .

Result
The recipe data record is deleted.

See also
Recipes in the Project (Page 10-3)

TP 277, OP 277 (WinCC flexible)
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10.6.5 Synchronizing Tags

Introduction

The values of the recipe elements can be saved to recipe tags, depending on the
configuration.

Differences may occur between the display values in the recipe view and the actual values of
tags in an ongoing project. Synchronize the tags to equalize such differences.

Synchronization always includes all the variables which belong to a recipe data record.

Notice
Changed Tag Name
Tags and the value of the recipe data record cannot be assigned to each other if the tag

name of the tag to be synchronized has been changed. The tags in question are not
synchronized.

Note

Recipe tags can only be synchronized in the enhanced recipe view.

Requirements
A screen with a recipe view is displayed.

Procedure with Touch Operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to synchronize.

3. Touch J

Procedure with Keyboard Operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to synchronize.

3. press ]+ [F]

Result
The elements of the recipe data record are synchronized with the recipe tags

If the values of the recipe view and the tag do not match, the more current value is accepted.

TP 277, OP 277 (WinCC flexible)
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70.6 Operating the Recipe View

See also

Recipes in the Project (Page 10-3)

10.6.6 Reading a Recipe Data Record from the PLC

Introduction

In the current project, the values which are also stored in the recipes in the HMI device can

be changed directly in the plant. This is the case, for example, if a valve was opened further
directly at the plant than is stored in the recipe. The values of the recipe data records saved
in the HMI device possibly no longer match the values in the PLC.

To synchronize the recipe values, read the values from the PLC and display them in the
recipe view.

Requirements

A screen with a recipe view is displayed.

Procedure with Touch Operation
Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

Select the recipe data record to which you want to apply the values from the PLC.

. Touch El

The values are read from the controller.

If you want to save the display values in the HMI device, touch the El button.

Procedure with Keyboard Operation
Proceed as follows:

1.

10-14

If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

Select the recipe data record to which you want to apply the values from the PLC.

oo -+ []

The values are read from the controller.

If you want to save the display values in the HMI device, touch the + keys.

TP 277, OP 277 (WinCC flexible)
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Result

The values were read from the controller, displayed on the HMI device and saved to the
selected recipe data record.

See also
Recipes in the Project (Page 10-3)

10.6.7 Transferring a Recipe Data Record to the PLC

Introduction

In order for an edited recipe data record to take effect in the process, you must transfer the
values to the PLC.

The display values in the recipe view are always transferred to the PLC.

Requirements
A screen with a recipe view is displayed.

Procedure with Touch Operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record whose values you want to transfer to the PLC.

3. Touch El

Procedure with Keyboard Operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record whose values you want to transfer to the PLC.

3 Press ]+ [7]

Result

The display values in the recipe view were transferred to the PLC and take effect in the
process.

See also
Recipes in the Project (Page 10-3)
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10.7 Operating the Simple Recipe View

10.71 Overview

Introduction

The simple recipe view consists of three areas:

e Recipe list

e Record list

o Element list

You can use the context menu to operate each of these display areas.
Operation

The simple recipe view can be operated as follows:

e Enter values for the recipe elements

o Create recipe data records

e Save recipe data records or save them under a new name

e Delete recipe data records

o Transfer recipe data records from the PLC and to the PLC

Operator Controls of the Simple Recipe View

Toggle between the display areas and the context menus to operate the simple recipe views.

The table below shows the operation of the display area.

Touch operation Keyboard control

Function

Touching an entry

The next lower display area opens.

'1—| ESC

The next higher display area opens.

] -]

The context menu of the display area opens.

The table below shows the operation of the context menu.

Touch operation Keyboard control

Function

'1—| ESC

The menu is closed.
The display area opens.

Touch the menu command | Input of the number of
the menu command

The menu command is executed.

10-16
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10.7 Operating the Simple Recipe View

A number is assigned to each menu command which you can use to call the menu
command with keyboard operation.

With touch operation, touch the menu command to execute it.

Some menu functions can also be called directly in the lists of the simple recipe view using

the keys.

¢ Recipe list

No. Menu command Shortcut key Function

0 New A new recipe data record is created for the
selected recipe.
If a start value is configured, it is shown in the
input field.

1 Displaying info text The info text configured for the simple recipe view
is displayed.

2 Open The record list of the selected recipe opens.

e Record list

No. Menu command Shortcut key Function

0 New A new recipe data record is created for the
selected recipe.

If a start value is configured, it is shown in the
input field.

1 Delete The displayed record is deleted.

2 Save as The selected record is saved under a different
name irrespective of the simple recipe view. A
dialog box opens in which the name is entered.

3 Rename The selected record is renamed. A dialog box

opens in which the name is entered.

e Element list

No. Menu command Shortcut key Function
0 Save The selected record is renamed.
To PLC The display values of the selected record are

transferred from the HMI device to the PLC.

2 From PLC The recipe values from the PLC are displayed on
the HMI device in the recipe view.

3 Save as The selected record is renamed. A dialog box
opens in which the name is entered.

Touch Operation of the Menu

Touch the desired menu command. The command is executed.

TP 277, OP 277 (WinCC flexible)
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10.7 Operating the Simple Recipe View

Key Operation of the Menu

Select the desired menu command entry by pressing Izl or IZI Press .
Alternatively, press the numerical key with the number of the desired menu command.

The command is executed.

Operating the Recipe Screen

You operate the recipes in a recipe screen with the operator controls provided by the
configuration engineer.

Further information on this may be available in your plant documentation.

10.7.2 Creating a Recipe Data Record

Introduction

Create a new recipe data record in the recipe list or in the record list. Then enter the values
for the new record in the element list and save the record.

Requirements

A screen with a simple recipe view is displayed.

Procedure
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe for which you want to create a
new recipe data record.

2. Open the recipe list menu.
3. Select the menu command "0 New".
Creates a new record
The element list of the new record opens.
4. Enter values for the elements of the data record.
The tags of the record can be assigned default values depending on the configuration.
5. Open the element list menu and select the menu command "0 Save".
6. Enter a name for the new record.
7. Confirm your entries.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

Result
The new recipe data record is saved to the selected recipe.

TP 277, OP 277 (WinCC flexible)
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10.7 Operating the Simple Recipe View

See also
Recipes in the Project (Page 10-3)

10.7.3 Editing a Recipe Data Record

Introduction
Edit the values of the recipe data records in a simple recipe view.

Synchronization with the PLC

If you want to display the current recipe values from the PLC in the simple recipe view, you
first have to read the current values from the PLC with the menu command "2 from PLC" in
the element list .

The values changed in the recipe view only take effect in the PLC when you transfer the
edited data record to the PLC with the menu command "1 To PLC" .

Requirements
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

Open the data record list.
Select the recipe data record you want to change.
Open the element list.

Change the values of the records as required.

o g k0w N

Save your changes with the menu command "0 Save".

The recipe data record is saved.

Result
The edited recipe data record has now been saved in the selected recipe.

See also
Recipes in the Project (Page 10-3)
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10.7.4 Deleting a Recipe Data Record

Introduction
You can delete all the data records which are not required.

Requirements
A screen with a simple recipe view is displayed.

Procedure with Touch Operation
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

Open the data record list.
Select the data record you want to delete.

Open the menu.

o > 0N

Select the menu command "1 Delete".

Procedure with Keyboard Operation
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Open the data record list.

3. Select the data record you want to delete.

INS
4. Press .

Result
The data record is deleted.

See also
Recipes in the Project (Page 10-3)
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10.7.5 Reading a Recipe Data Record from the PLC

Introduction
The values of recipe elements are exchanged with the PLC via tags.

In the current project, the values which are also stored in the recipes in the HMI device can
be changed directly in the plant. This is the case, for example, if a valve was opened further
directly at the plant than is stored in the recipe. The values of the tags on the HMI device
possibly no longer match the values in the PLC.

To synchronize the recipe values, read the values from the PLC and display them in the
recipe view.

Requirements
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows:
1. If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.
2. Select the element list of the recipe data record to which you want to apply the values
from the PLC.
3. Open the menu.
4. Select the menu command "2 From PLC".
The values are read from the controller.
5. If you want to save the display values in the HMI device, select the menu command "0
Save".
Result
The values were read from the controller, displayed on the HMI device and saved to the
selected recipe data record.
See also

Recipes in the Project (Page 10-3)
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10.7.6 Transferring a Recipe Data Record to the PLC

Introduction

In order for an edited recipe data record to take effect in the process, you must transfer the
values to the PLC.

The display values in the recipe view are always transferred to the PLC.

Requirements
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the element list of the recipe data record whose values you want to transfer to the
PLC.

3. Open the menu.

4. Select the menu command "1 To PLC".

Result

The values of the recipe data record were transferred to the PLC and take effect in the
process.

See also
Recipes in the Project (Page 10-3)
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10.8 Exporting a Recipe Data Record

Introduction

You can export one or more recipe data records to a CSV file, depending on the
configuration. After export the values in the recipe data record can be manipulated in a
spreadsheet program such as MS Excel. The degree to which you can influence the export
depends on the configuration:

Requirement
e A screen with a recipe view is displayed.
¢ An operator control with the function "Export record" has been configured.

e The following tags are configured equally in the recipe view and for the "Export record"
button.

— Recipe number

— Data record number

Procedure
Proceed as follows:
1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.
2. Select the recipe data record you want to export.
3. Operate the operator control element which was configured for export, for example the
"Export data record" button.
The data record is exported as a CSV file to an external data medium.
Further information on this may be available in your plant documentation.
Result
The recipe data record is exported.
See also

Recipes in the Project (Page 10-3)
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10.9 Importing a Recipe Data Record

Introduction

You can import values from a CSV file to a recipe data record, depending on the
configuration.

Requirements

¢ An operator control with the function "Import data record" has been configured, for
example a button.

e A screen with a recipe view is displayed.

Procedure
Proceed as follows:
1. If the recipe view contains several recipes: Select the recipe which contains the recipe
data record to be imported.
2. Operate the operator control with the function "Import data record".
The record is imported from an external data medium as a CSV file and then displayed in
the recipe view after import.
Result

The imported recipe data record is saved on the HMI device.

Deviating Structures

If the structure of the CSYV file differs from the structure of the recipe, deviations are handled
as follows:

¢ Any additional values in the CSV file will be rejected.

e The system applies the configured default value to the recipe data record if the CSV file
contains an insufficient number of values.

o If the CSV file contains values of the wrong data type, the configured default value is set
in the recipe data record.

Example:
The imported CSV file contains values that were entered as floating point numbers.

However, the corresponding tag expects an integer value. In this case, the system
discards the imported value and uses the configured default.

See also
Recipes in the Project (Page 10-3)
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10.10 Examples

10.10.1  Entering a Recipe Data Record

Introduction

You would like to enter production data on the HMI device without interrupting the process in
the machine or plant. Therefore the production data should not be transferred to the PLC.

Procedure
Proceed as follows:
1. Call the recipe view or a recipe screen.
2. Select the desired recipe data record.
3. Enter the values of the elements.
4. Save the recipe data record.
The recipe data record is saved in the internal data store of the HMI device.

The following figure shows the data flow schematically.

HMI device m
Recipe view @ w

Recipe 1
Recipe 2
s ©)
1 ©
Recipe tag

Recipe 3
Recipe

screen @ v

>
©

PLC

Display recipe data record

Save recipe data record

Tags are synchronized

Display and edit recipe tags in the recipe screen
Tags are offline

GCECNONONC,
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10.10.2 Manual Production Sequence

Introduction
You request production data of different workpieces from the PLC and display them on the
screen of the HMI device for inspection. You want to correct the transferred production data
in the recipe view or the recipe screen if necessary.

Procedure

A scanner connected to the controller reads the barcode of a workpiece. The barcode names
correspond to the names in the recipe data record. Based on the barcode name, the
controller can read the required recipe data record. The recipe data record is displayed for
inspection on the HMI device. You can now edit and save the recipe data record. Then
transfer the edited recipe data record to the PLC again.

The following figure shows the data flow schematically.

HMI device m
Recipe view @ u
o—o
1 ©
Recipe tag

Recipe

screen @ v

The recipe data record is read from the controller and written to the controller again
following changes

Display and edit recipe tags in the recipe screen
Tags are synchronized

®e 60 o6

Recipe data records are saved in the recipe memory of the HMI device.
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11.1 Maintenance and care

Scope of maintenance

The HMI device is designed for maintenance-free operation. The touch screen and keyboard
membrane should nevertheless be cleaned regularly.

Preparation

A Caution
Faulty operation

Always switch off the HMI device before cleaning it. This will ensure that you do not trigger
unintended functions when you touch the keys.

Requirement

Use a cleaning cloth dampened with a cleaning agent to clean the equipment. Only use
water with a little liquid soap or a screen cleaning foam.

Caution

Do not clean the HMI device with compressed air or steam jet blowers. Never use
aggressive solvents or scouring powder.

Procedure
Proceed as follows:
1. Switch off the HMI device.
2. Spray the cleaning solution onto a cleaning cloth.
Do not spray directly onto the HMI device.
3. Clean the HMI device.

When cleaning the display wipe from the screen edge inwards.

TP 277, OP 277 (WinCC flexible)
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11.2 Cleaning Screen on TP 277

Cleaning Screen

VAN

The HMI touch screen can be cleaned when it is switched on and a project is running. An
operator control must be available in the project with which the cleaning screen can be
called. Once the cleaning screen is activated, touch screen operation is locked for a
configured period of time. The time can be set between 5 and 30 seconds. The time
remaining for the lockout is indicated by a progress bar.

Warning
Locking Operator Controls

Always open the cleaning screen or switch off the HMI device before you clean the touch
screen while the system is running!

Pay attention to the end of the operating lock by the cleaning screen function. Ignoring this
instruction may lead to inadvertent wrong operation.

11.3 Protective Foil

Protective Foil

Protective foil is available for the HMI-device touch screens. The relevant ordering
information is provided in the Siemens Catalog ST 80. The protective foil is not included in
the HMI device's package.

The self-adhesive foil prevents the screen from being scratched and soiled. The mat surface
of the foil reduces reflections under unfavorable lighting.

The protective foil can be removed without leaving any adhesive residue on the screen.

Caution
Installing and removing the protective foil
Always shut down the HMI device before installing the protective foil. Otherwise, there is a

risk that functions are inadvertently activated. This also applies when removing the protective
foil.

Never use sharp or pointed tools, such as a knife, to remove the protective foil. This may
damage the touch screen.

TP 277, OP 277 (WinCC flexible)
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114 Spare Parts and Repairs

Repairs

Service Pack

In case of repair, the HMI device must be shipped to the Return Center in Fiirth. Repairs
may only be carried out at the Return Center in Firth.

Depending on the work necessary to repair the device, the Center might decide to give you a
credit not. In this case, it is your responsibility to order a new device.

The address is:

A&D Return Center
Siemensstr. 2

90766 Firth, Germany

A service pack for maintenance is available with order number 6AV6671-3XA01-0AX0.
The service pack includes:

¢ Mounting seal

¢ Mounting clamps

e Labeling strips

e Terminal block, 2-pin

The service pack can be ordered from your Siemens representative.

Service & Support on the Internet

Service & Support provides additional comprehensive information on SIMATIC products
through online services at "http://www.siemens.com/automation/suppori™:

Information about on-site services, repairs, spare parts, and much more is available on our
"Services" pages.

TP 277, OP 277 (WinCC flexible)
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12.1 Dimension Drawings

1211 Dimension Drawings of the TP 277
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12.2 Specifications

12.1.2 Dimension Drawings of the OP 277
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12.2 Specifications

12.2.1 Specifications of the TP 277

HMI device
‘ Weight without packing approx. 780 g

Display

Type LCD-TFT

Display area, active 115.18 mm x 86.38 mm (5.7")

Resolution 320 x 240 pixels

Colors, displayable 256

Backlighting CCFL

Half brightness life, typical 50,000 h

TP 277, OP 277 (WinCC flexible)
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12.2 Specifications
Input unit
‘ Type Touch screen, analog, resistive
Memory
‘ Application memory 4 Mbytes
Ports
1 x RS 422/RS 485 Max. 12 Mbps

1x USB

e USB host; conforms to USB standard 1.1 (supporting
low-speed and full-speed USB devices)

e Maximum load 100 mA

1 x Ethernet

RJ45 10/100 Mbps

Supply Voltage

Rated voltage
Range, permissible

+24 VDC
20.41t028.8 V (-15 %, +20 %)

Transients, maximum permissible

35V (500 msec)

Time between two transients, minimum

50s

Current consumption

o Typical

e Constant current, maximum
e Power on current surge 2t

e approx. 670 mA
e approx. 740 mA
e approx. 0.5 A%s

Fuse, internal Electronic
Miscellaneous
‘ Real-time clock, unbuffered ‘ Yes

12.2.2 Specifications of the OP 277

HMI device

‘ Weight without packing

approx. 1,190 g

TP 277, OP 277 (WinCC flexible)
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12.2 Specifications

Display

Type

LCD-TFT

Display area, active

115.18 mm x 86.38 mm (5.7")

Resolution 320 x 240 pixels
Colors, displayable 256
Backlighting CCFL

Half brightness life, typical 50,000 h

Input unit

Type

Membrane keyboard

Function keys

24, of which 18 with LED

Memory
‘ Application memory 4 Mbytes
Ports

1 x RS 422/RS 485 Max. 12 Mbps

1 x USB

e USB host; conforms to USB standard 1.1 (supporting
low-speed and full-speed USB devices)

e Maximum load 100 mA

1 x Ethernet

RJ45 10/100 Mbps

Supply voltage

Rated voltage
Range, permissible

+24 VDC
20.4V1028.8V (-15 %, +20 %)

Transients, maximum permissible

35V (500 msec)

Time between two transients, minimum

50s

Current consumption

e Typical

e Constant current, maximum
e Power on current surge |2t

e approx. 670 mA
e approx. 740 mA
e approx. 0.5 A%s

Fuse, internal Electronic
Miscellaneous
‘ Real-time clock, unbuffered Yes

12-4
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12.3 Bit Assignment of the Direct Keys

12.3 Bit Assignment of the Direct Keys

The figures below show the assignment of the keys and LEDs to the bytes in the process
image of the PLC.

Further information may be available in your plant documentation.

Bit assignment of the direct keys for the OP 277

| Button bits | LED bits
7 6 5 4 3 2 1 0 byte 7 6 5 4 3 2 1 0
F8 | F7 |F6 | F5 | F4 | F3 | F2 | F1 n Fe | F7 |F6 | F5 | F4 | F3 | F2 | F1

K2 | KI |F14 | F1I3 [ F12 | F11 | F10 | F9 n+1 K2 | K1

K10 [ K9 [ K8 K7 | K6 | K5 | K4 | K3 n+2 K10 [ K9 | K8 K7 | K6 | K&
ACK | ALT [CTRL|SHIFT] n+3

K4 | K3

ACK | A-Z| | A-Zr|HELP

Note

Do not use the LED bits "ACK", "A-Z I", "A-Z r" and "HELP" when a project is running on the
HMI device.

Bit assignment of the direct keys for the TP 277

| Touch assignment |

7 6 5 4 3 2 1 0 Byte
7 6 5 4 3 2 1 0 n
15 | 14 B|12 | 1 10 9 8 n+1

23 122 21|20 | 19 | 18 17 | 16 n+2
31 30 | 29 | 28 | 27 | 26 | 25 | 24 n+3

See also
Direct Keys (Page 8-3)

TP 277, OP 277 (WinCC flexible)
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12.4 Description of the Ports

12.4 Description of the Ports

12.4.1 Power Supply

Plug connector, 2-pin

1 2

]

Figure 12-1  Power supply pin assignment

Pin  Assignment

1 +24 VDC

2 GND 24 V

12.4.2 RS 422/RS 485 (IF 1B)

Sub-d socket, 9-pin, with screw lock

5 1

AL

9 6

Figure 12-2  Pin assignment of the RS 422/RS 485 interface

Pin  Assignment for the RS 422

Assignment for the RS 485

1 n. c. n. c.
2 GND 24 V GND 24V
3 TxD+ Data channel B (+)
4 RD+ RTS "
5 GND 5V, floating GND 5V, floating
6 +5 VDC, floating +5 VDC, floating
7 +24 VDC, out (max. 100 mA) +24 VDC, out (max. 100 mA)
8 TxD- Data channel A (-)
9 RxD- RTS"
g On pin 4 or pin 9, can be set with DIP switch on the rear of the device

12-6
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12.4.3 USB

USB standard connector

=]

Figure 12-3  Pin assignment of the USB port

Pin Assignment

+5 VDC, out (max. 100 mA)
USB-DN

USB-DP

GND

AW IN|=-

124.4 Ethernet
RJ45 plug connector

[ ]

nnnnnng
1 8
Figure 12-4  Pin assignment of the RJ45 connector

Pin Assignment
TX+

TX-

RX+

n.c.

n.c.
RX-

n.c.

O |IN|[OO|O|~|WIN]|-

n.c.

TP 277, OP 277 (WinCC flexible)
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Appendix

A

A1 ESD Guidelines

What does ESD mean?

Abbreviations

Labeling

All electronic modules are equipped with highly integrated modules or components. Based
on their design, these electronic components are highly sensitive to overvoltage and thus to
discharge of static electricity. These electronic components are therefore specially identified
as ESD.

The following abbreviations are commonly used for electrostatic sensitive devices:
e ESD - Electrostatic Sensitive Devices

e ESD - Electrostatic Sensitive Device as common international designation

ESD modules are labeled with the following symbol:

Electrostatic Charge

Caution
Electrostatic Charge

ESDs may be destroyed by voltages well below the perception threshold of persons
Voltages of this kind develop when a component or an assembly is touched by a person who
is not grounded against static electricity. Usually, it is unlikely that damage to an ESD as a
result of overvoltage is detected immediately but may become apparent only after a longer
period of operation.

Prevent electrostatic charge of your body before you touch the ESD!

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO A-1



Appendix

A. 1 ESD Guidelines

Anyone who is not connected to the electrical potential of their surroundings is subjected to
electrostatic charge.

The figure below indicates the maximum electrostatic charge anyone is subjected to when
coming into contact with the materials shown. These values correspond with specifications to
IEC 801-2.

Voltage

SNWhOOTON®O

: T T T T T T
510 20 30 40 50 60 70 80 90 100 [%]
Relative humidity

0] Synthetic materials
® Wool
®

Antistatic materials such as wood or concrete

Protective Measures against Discharge of Static Electricity

Caution
Observe grounding measures

When working with electrostatic sensitive devices, make sure that the person, the workplace
and the packaging are properly grounded. This helps to avoid electrostatic charge.

As a rule, only touch the ESD if this is unavoidable , for example for maintenance. When you
touch modules, make sure that you do not touch the pins on the modules or the PCB tracks.
This prevents any discharge of static electricity to sensitive component and thus avoids
damage.

Discharge electrostatic electricity from your body if you are performing measurements on an
ESD. To do so, touch a grounded metallic object.

Always use grounded measuring instruments.

TP 277, OP 277 (WinCC flexible)
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A2

System Alarms

Introduction

A.2 System Alarms

System alarms on the HMI device provide information about internal states of the HMI device

and PLC.

The overview below shows the causes of system alarms and how to eliminate the cause of

error.

Depending on scope of functions, only parts of the system alarms described in this section

apply to the various HMI devices.

Note

System alarms are only indicated if an alarm window was configured. System alarms are
output in the language currently set on your HMI device.

System Alarm Parameters

System alarms may contain encrypted parameters which are relevant to troubleshooting
because they provide a reference to the source code of the Runtime software. These
parameters are output after the text "Error code:"

Meaning of the System Alarms

Number | Effect/cause Remedy

10000 | The print job could not be started or was canceled | Check the printer settings, cable connections and the
due to an unknown error. Faulty printer setup. Or: power supply.
No permission is available for accessing the Set up the printer once again. Obtain a network printer
network printer. authorization.
Power supply failure during data transfer. If the error persists, contact the Hotline!

10001 | No printer is installed or a default printer has not Install a printer and/or select it as the default printer.
been set up.

10002 | Overflow of the graphics buffer for printing. Up to Allow sufficient intervals between successive print jobs.
two images are buffered.

10003 | Images can now be buffered again. —

10004 | Overflow of the buffer for printing lines in text mode | Allow sufficient intervals between successive print jobs.
(e.g. alarms). Up to 1000 lines are buffered.

10005 | Text lines can now be buffered again. —

10006 | The Windows printing system reports an error. Repeat the action if necessary.
Refer to the output text and the error ID to
determine the possible causes. Nothing is printed
or the print is faulty.

20010 | An error has occurred in the specified script line. Select the specified script line in the configuration.
Execution of the script was therefore aborted. Note | Ensure that the tags used are of the allowed types.
the system alarm that may have occurred prior to Check system functions for the correct number and types
this. of parameters.

TP 277, OP 277 (WinCC flexible)
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A.2 System Alarms
Number | Effect/cause Remedy
20011 | An error has occurred in a script that was called by | In the configuration, select the script that has been called

the specified script.

Execution of the script was therefore aborted in the
called script.

Note the system alarm that may have occurred
prior to this.

directly or indirectly by the specified script.

Ensure that the tags used are of the allowed types.
Check system functions for the correct number and types
of parameters.

20012 | The configuration data is inconsistent. The script Recompile the configuration.
could therefore not be generated.

20013 | The scripting component of WinCC flexible Runtime | Reinstall WinCC flexible Runtime.
is not correctly installed. Therefore, no scripts can
be executed.

20014 | The system function returns a value that is not Select the specified script in the configuration.
written in any return tag. Check whether the script name has been assigned a

value.

20015 | Too many successive scripts have been triggered Find what is triggering the scripts. Extend the times, e.g.
in short intervals. When more than 20 scripts are the polling time of the tags which trigger the scripts.
queued for processing, any subsequent scripts are
rejected. In this case, the script indicated in the
alarm is not executed.

30010 | The tag could not accept the function result, e.g. Check the tag type of the system function parameter.
when it has exceeded the value range.

30011 | A system function could not be executed because | Check the parameter value and tag type of the invalid
the function was assigned an invalid value or type | parameter. If a tag is used as a parameter, check its
in the parameter. value.

40010 | The system function could not be executed since Check the parameter types in the configuration.
the parameters could not be converted to a
common tag type.

40011 | The system function could not be executed since Check the parameter types in the configuration.
the parameters could not be converted to a
common tag type.

50000 | The HMI device is receiving data faster than it is —
capable of processing. Therefore, no further data is
accepted until all current data have been
processed. Data exchange then resumes.

50001 | Data exchange has been resumed. —

60000 | This alarm is generated by the —

“DisplaySystemAlarms” function. The text to be
displayed is transferred to the function as a
parameter.

60010 | The file could not be copied in the direction defined | Restart the system function or check the paths of the
because one of the two files is currently open or the | source/target files. Using Windows NT/2000/XP: The user
source/target path is not available. executing WinCC flexible Runtime must be granted
It is possible that the Windows user has no access | access rights for the files.
rights to one of the two files.

60011 | An attempt was made to copy a file to itself. Check the path of the source/target file.

It is possible that the Windows user has no access | Using Windows NT/2000/XP with NTFS: The user
rights to one of the two files. executing WinCC flexible Runtime must be granted
access rights for the files.

70010 | The application could not be started because it Check whether the application exists in the specified path
could not be found in the path specified or there is | or close other applications.
insufficient memory space.

TP 277, OP 277 (WinCC flexible)
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A.2 System Alarms

Number

Effect/cause

Remedy

70011

The system time could not be modified.

The error alarm only appears in connection with

area pointer "Date/time PC". Possible causes:

e Aninvalid time was transferred in the job
mailbox.

e The Windows user has no right to modify the
system time.

If the first parameter in the system alarm is

displayed with the value 13, the second parameter

indicates the byte containing the incorrect value.

Check the time which is to be set.

Using Windows NT/2000/XP: The user executing
WinCC flexible Runtime must be granted the right to
change the system time of the operating system.

70012

An error occurred when executing the function
"StopRuntime" with the option "Runtime and
operating system".

Windows and WinCC flexible Runtime are not
closed.

One possible cause is that other programs cannot
be closed.

Close all programs currently running.
Then close Windows.

70013

The system time could not be modified because an
invalid value was entered. Incorrect separators may
have been used.

Check the time which is to be set.

70014

The system time could not be modified. Possible
causes:

e An invalid time was transferred.

e The Windows user has no right to modify the
system time.

o Windows rejects the setting request.

Check the time which is to be set.

Using Windows NT/2000/XP: The user executing
WinCC flexible Runtime must be granted the right to
change the system time of the operating system.

70015

The system time could not be read because
Windows rejects the reading function.

70016

An attempt was made to select a screen by means
of a system function or job. This is not possible
because the screen number specified does not
exist.

Or: A screen could not be generated due to
insufficient system memory.

Check the screen number in the function or job with the
screen numbers configured.
Assign the number to a screen if necessary.

70017

Date/time is not read from the area pointer because
the address set in the controller is either not
available or has not been set up.

Change the address or set up the address in the
controller.

70018

Acknowledgment that the password list has been
successfully imported.

70019

Acknowledgment that the password list has been
successfully exported.

70020

Acknowledgment for activation of alarm reporting.

70021

Acknowledgment for deactivation of alarm
reporting.

70022

Acknowledgment to starting the Import Password
List action.

70023

Acknowledgment to starting the Export Password
List action.

TP 277, OP 277 (WinCC flexible)
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A.2 System Alarms
Number | Effect/cause Remedy
70024 | The value range of the tag has been exceeded in Check the desired calculation and correct it if necessary.

the system function.
The calculation of the system function is not
performed.

70025

The value range of the tag has been exceeded in
the system function.

The calculation of the system function is not
performed.

Check the desired calculation and correct it if necessary.

70026

No other screens are stored in the internal screen
memory.
No other screens can be selected.

70027

The backup of the RAM file system has been
started.

70028

The files from the RAM have been copied in the
Flash memory.

The files from the RAM have been copied in the
Flash memory. Following a restart, these saved
files are copied back to the RAM file system.

70029

Backup of the RAM file system has failed.
No backup copy of the RAM file system has been
made.

Check the settings in the "Control Panel > OP" dialog and
save the RAM file system using the "Save Files" button in
the "Persistent Storage" tab.

70030

The parameters configured for the system function
are faulty.

The connection to the new controller was not
established.

Compare the parameters configured for the system
function with the parameters configured for the controllers
and correct them as necessary.

70031

The controller configured in the system function is
not an S7 controller.

The connection to the new controller was not
established.

Compare the S7 controller name parameter configured
for the system function with the parameters configured for
the controller and correct them as necessary.

70032

The object configured with this number in the tab
order is not available in the selected screen.

The screen changes but the focus is set to the first
object.

Check the number of the tab order and correct it if
necessary.

70033

An e-mail cannot be sent because a TCP/IP
connection to the SMTP server no longer exists.
This system alarm is generated only at the first
attempt. All subsequent unsuccessful attempts to
send an e-mail will no longer generate a system
alarm. The event is regenerated when an e-mail
has been successfully sent in the meantime.

The central e-mail component in WinCC flexible
Runtime attempts, in regular intervals (1 minute), to
establish the connection to the SMTP server and to
send the remaining e-mails.

Check the network connection to the SMTP server and
re-establish it if necessary.

70034

Following a disruption, the TCP/IP connection to
the SMTP server could be re-established.
The queued e-mails are then sent.

TP 277, OP 277 (WinCC flexible)
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A.2 System Alarms

Number | Effect/cause Remedy
70036 | No SMTP server for sending e-mails is configured. | Configure an SMTP server:
An attempt to connect to an SMTP server has failed | |, winCC flexible Engineering System
and it is not possible to send e-mails. using "Device settings > Device settings"
WinCC flexible Runtime generates the system . .
alarm after the first attempt to send an e-mail. In _the Windows CE operating system .
using "Control Panel > Internet Settings > E-mail > SMTP
Server"
70037 | An e-mail cannot be sent for unknown reasons. Check the e-mail parameters (recipient etc.).
The contents of the e-mail are lost.

70038 | The SMTP server has rejected sending or Check the domain of the recipient address or deactivate
forwarding an e-mail because the domain of the the authentication on the SMTP server if possible. SMTP
recipient is unknown to the server or because the authentication is currently not used in WinCC flexible
SMTP server requires authentication. Runtime.

The contents of the e-mail are lost.

70039 | The syntax of the e-mail address is incorrect or Check the e-mail address of the recipient.

contains illegal characters.
The contents of the e-mail are discarded.
70040 | The syntax of the e-mail address is incorrect or —

contains illegal characters.

70041 | The import of the user management was aborted

due to an error.
Nothing was imported.

Check your user management or transfer it again to the
panel.

80001 | The log specified is filled to the size defined
(in percent) and must be stored elsewhere.

Store the file or table by executing a ‘move’ or ‘copy’
function.

80002 | A line is missing in the specified log.

80003 | The copying process for logging was not
successful.
In this case, it is advisable to check any

subsequent system alarms, too.

80006 | Since logging is not possible, this causes a

permanent loss of the functionality.

In the case of databases, check whether the
corresponding data source exists and start up the system
again.

80009

A copying action has been completed successfully.

80010

the functionality.

Since the storage location was incorrectly entered
in WinCC flexible, this causes a permanent loss of

Configure the storage location for the respective log
again and restart the system when the full functionality is
required.

80012

written (using a hard disk, for example),
overloading may occur and recording is then
stopped.

Log entries are stored in a buffer. If the values are
read to the buffer faster than they can be physically

Archive fewer values.
Or:
Increase the logging cycle.

80013
resumes the recording of all values.

The overload status no longer applies. Archiving

80014 | The same action was triggered twice in quick
succession. Since the process is already in

operation, the action is only carried out once.

80015 | This system alarm is used to report DOS or

database errors to the user.

TP 277, OP 277 (WinCC flexible)
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A.2 System Alarms
Number | Effect/cause Remedy
80016 | The logs are separated by the system function Reconnect the logs.

"CloseAllLogs" and the incoming entries exceed the
defined buffer size.
All entries in the buffer are deleted.

80017 | The number of incoming events cause a buffer Stop the copy action.
overflow. his can be caused, for example, by
several copying actions being activated at the same
time.
All copy jobs are deleted.
80019 | The connection between WinCC flexible and all —
logs were closed, for example, after executing the
system function "CloseAllLogs".
Entries are written to the buffer and are then written
to the logs when a connection is re-established.
There is no connection to the storage location and
the storage medium may be replaced, for example.
80020 | The maximum number of simultaneously copy Wait until the current copying actions have been
operations has been exceeded. Copying is not completed, then restart the last copy action.
executed.
80021 | An attempt was made to delete a log which is still Wait until the current copying actions have been
busy with a copy action. Deletion has not been completed, then restart the last action
executed.
80022 | An attempt was made to start a sequence log, In the project, check
which is not a sequence log, from a log usingthe |4 if the "StartSequencelLog" system function was
system function "StartSequencelLog". No sequence properly configured
log file is created. « if the tag parameters are properly provided with data
on the HMI device
80023 | An attempt was made to copy a log to itself. In the project, check
The log is not copied. e if the "CopyLog" system function was properly
configured
o if the tag parameters are properly provided with data
on the HMI device
80024 | The "CopyLog" system function does not allow Edit the "CopyLog" system function in the project if
copying when the target log already contains data | necessary. Before you initiate the system function, delete
("Mode" parameter). The log is not copied. the destination log file.
80025 | You have canceled the copy operation. —
Data written up to this point are retained. The
destination log file (if configured) is not deleted.
The cancellation is reported by an error entry
$RT_ERRS at the end of the destination log.
80026 | This alarm is output after all logs are initialized. —
Values are written to the logs from then on. Prior to
this, no entries are written to the logs, irrespective
whether WinCC flexible Runtime is active or not.
80027 | The internal Flash memory has been specified as Configure "Storage Card" or a network path as the
the storage location for a log. This is not storage location.
permissible.
No values are written to this log and the log file is
not created.
TP 277, OP 277 (WinCC flexible)
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A.2 System Alarms

Number | Effect/cause Remedy

80028 | The alarm returns a status report indicating that the | —
logs are currently being initialized. No values are
logged until the alarm 80026 is output.

80029 | The number of logs specified in the alarm could not | Evaluate the additional system alarms , related to this
be initialized. The logs are initialized. alarm which is also generated.

The faulty log files are not available for logging Check the configuration, the ODBC (Open Database
jobs. Connectivity) and the specified drive.

80030 | The structure of the existing log file does not match | Delete the existing log data manually, in advance.
the expected structure.

Logging is stopped for this log.

80031 | The log in CSV format is corrupted. Delete the faulty file.
The log cannot be used.

80032 | Logs can be assigned events. These are triggered | Close WinCC flexible Runtime, delete the log, then restart
as soon as the log is full. If WinCC flexible Runtime | WinCC flexible Runtime.
is started and the log is already full, the event is not | Or:
triggered. Configure a button which contains the same actions as
The log specified no longer logs data because itis | the event and press it.
full.

80033 | "System Defined" is set in the data log file as the Install MSDE again.
data source name. This causes an error. No data is
written to the database logs, whereas the logging to
the CSV logs works.

80034 | An error has occurred in the initialization of the No action is necessary. However, it is recommended to
logs. An attempt has been made to create the save the backup files or delete them in order to make the
tables as a backup. This action was successful. A | space available again.
backup has been made of the tables of the
corrupted log file and the cleared log was restarted.

80035 | An error has occurred in the initialization of the It is recommended to save the backups or to delete them
logs. An attempt has been made to create backups | in order to release memory.
of the tables and this has failed. No logging or
backup has been performed.

80044 | The export of a log was interrupted because The export resumes automatically.

Runtime was closed or due to a power failure.
When Runtime restarted, it was detected that the
export needed to be resumed.

80045 | The export of a log was interrupted due to an error | The export is repeated automatically. Check:
in the connection to the server or at the server e the connection to the server
itself. e if the server is running

o if there is enough free space on the server.

80046 | The destination file could not be written while check whether there is enough space on the server and it
exporting the log. you have permission to create the log file.

80047 | The log could not be read while exporting it. check whether the storage medium is correctly inserted.

80048 |— —

80049 | The log could not be renamed while preparing to check whether the storage medium is correctly inserted
export it. and if there is sufficient space on the medium.

The job can not be completed.”
80050 | The log which shall be exported is not closed. Make sure the "CloseAll Logs" system function is called

The job can not be completed.

before using the "ExportLog" system function. Change
the configuration as required.
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A.2 System Alarms
Number | Effect/cause Remedy
90024 | No operator actions can be logged due to lack of Make more space available by inserting an empty storage

space on the storage medium for log. The operator
action will therefore not be executed.

medium or swapping out the log files on the server using
"ExportLog".

90025 | No user actions can be logged because of error check whether the storage medium is correctly inserted.
state of the archive. Therefore the user action will
not be executed.

90026 | No operator actions can be logged because the log | Before further operator actions are carried out, the log
is closed. The operator action will therefore not be | must be opened again using the system function
executed. "OpenAllLogs". Change the configuration as required.

90029 | Runtime was closed during ongoing operation Ensure that you are using the correct storage medium.
(perhaps due to a power failure) or a storage
medium in use is incompatible with Audit Trail. An
Audit Trail is not suitable if it belongs to another
project or has already been archived.

90030 | Runtime was closed during ongoing operation —

(perhaps due to a power failure).

90031 | Runtime was closed during ongoing operation —
(perhaps due to a power failure).

90032 | Running out of space on the storage medium for Make more space available by inserting an empty storage
log. medium or swapping out the log files on the server using

"ExportLog".

90033 | No more space on the storage medium for log. As | Make more space available by inserting an empty storage
of now, no more operator actions requiring logging | medium or swapping out the log files on the server using
will be executed. "ExportLog".

90040 | Audit Trail is switched off because of a forced user | Activate the "Audit Trail" again using the system function
action. "StartLog".

90041 | A user action which has to be logged has been A user action requiring logging should only be possible
executed without a logged on user. with permission. Change the configuration by setting a

required permission for the input object.

90044 | A user action which has to be confirmed was Repeat the user action if necessary.
blocked, because there is another user action
pending.

110000 | The operating mode was changed. "Offline" mode | —
is now set.

110001 | The operating mode was changed. "Online" mode | —
is now set.

110002 | The operating mode was not changed. Check the connection to the controllers.

check whether the address area for the area pointer 88
“Coordination" in the controller is available.

110003 | The operating mode of the specified controller was | —
changed by the system function
"SetConnectionMode".

The operating mode is now "offline".

110004 | The operating mode of the specified controller has | —
been changed by the system function
"SetConnectionMode".

The operating mode is now "online".
TP 277, OP 277 (WinCC flexible)
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A.2 System Alarms

Number | Effect/cause Remedy

110005 | An attempt was made to use the system function Switch the complete system to "online" mode, then
SetConnectionMode to switch the specified execute the system function again.
controller to "online" mode, although the entire
system is in "offline" mode. This changeover is not
allowed. The controller remains in "offline" mode.

110006 | The content of the "project version" area pointer Check:
does not match the user version configured in e the project version entered on the controller
WinCC fiexible. WinCC fiexible Runtime is e the project version entered in WinCC flexible
therefore closed.

120000 | The trend is not displayed because you configured | Change the configuration.
an incorrect axis to the trend or an incorrect trend.

120001 | The trend is not displayed because you configured | Change the configuration.
an incorrect axis to the trend or an incorrect trend.

120002 | The trend is not displayed because the tag check whether the data area for the tag exists in the
assigned attempts to access an invalid controller controller, the configured address is correct and the value
address. range for the tag is correct.

130000 | The action was not executed. Close all other programs.

Delete files no longer required from the hard disk.

130001 | The action was not executed. Delete files no longer required from the hard disk.

130002 | The action was not executed. Close all other programs.

Delete files no longer required from the hard disk.

130003 | No data medium found. The operation is canceled. | Check, for example, if

o the correct data medium is being accessed
o the data medium is inserted

130004 | The data medium is write-protected. The operation | check whether access has been made to the correct data
is canceled. carrier. Remove the write protection.

130005 | The file is read only. The operation is canceled. check whether access has been made to the correct file.

Edit the file attributes if necessary.
130006 | Access to file failed. The operation is canceled. Check, for example, if
e the correct file is being accessed
o the file exists
e another action is preventing simultaneous access to
the file

130007 | The network connection is interrupted. Check the network connection and eliminate the cause of
Records cannot be saved or read over the network | error.
connection.

130008 | The storage card is not available. Insert the storage card.

Records cannot be saved to / read from the storage
card.

130009 | The specified folder does not exist on the storage Insert the storage card.
card.

Any files saved to this directory are not backed up
when you switch off the HMI device.
130010 | The maximum nesting depth can be exhausted Check the configuration.

when, for example, a value change in a script
results in the call of another script and the second
script in turn has a value change that results in the
call of yet a further script etc.

The configured functionality is not supported.
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A.2 System Alarms
Number | Effect/cause Remedy
140000 | An online connection to the controller is —

established.

140001 | The online connection to the controller was shut —

down.

140003 | No tag updating or writing is executed. Check the connection and if the controller is switched on.
Check the parameter definitions in the Control Panel
using "Set PG/PC interface".

Restart the system.
140004 | No tag update or write operations are executed Verify the connection and check whether the controller is
because the access point or the module switched on.
configuration is faulty. Check the access point or the module configuration (MPI,
PPI, PROFIBUS) in the Control Panel with "Set PG/PC
interface".
Restart the system.

140005 | No tag updating or writing is executed because the | Use a different HMI device address.

HMI device address is incorrect (possibly too high). | Verify the connection and check whether the controller is
switched on.
Check the parameter definitions in the Control Panel
using "Set PG/PC interface".
Restart the system.

140006 | No tag updating or writing is executed because the | Select a different baud rate in WinCC flexible (according

baud rate is incorrect. to module, profile, communication peer, etc.).
140007 | Tag are not updated or written because the bus Check the user-defined bus profile.
profile is incorrect (see %1). Check the connection and if the controller is switched on.
The following parameter could not be written to the | Check the parameter definitions in the Control Panel
registry:: using "Set PG/PC interface".
1: Tslot Restart the system.
2: Tqui
3: Tset
4: MinTsdr
5: MaxTsdr
6: Trdy
7: Tid1
8: Tid2
9: Gap Factor
10: Retry Limit

140008 | No tag updating or writing is executed because Check the connection and if the controller is switched on.
baud rate is incorrect. The following parameters Check the parameter definitions in the Control Panel
could not be written to the registry: using "Set PG/PC interface".
0: General error Restart the system.
1: Wrong version
2: Profile cannot be written to the registry.
3: The subnet type cannot be written to the
registry.
4: The Target Rotation Time cannot be written to
the registry.
5: Faulty Highest Address (HSA).

140009 | Tags are not updated or written because the Reinstall the module in the Control Panel using "Set
module for S7 communication was not found. PG/PC interface".

TP 277, OP 277 (WinCC flexible)
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A.2 System Alarms

Number | Effect/cause Remedy
140010 | No S7 communication partner found because the Switch the controller on.
controller is shut down. DP/T:
DP/T: If only one master is connected to the network, disable
The option “PG/PC is the only master” is not setin | "PG/PC is the only master" in "Set PG/PC interface".
the Control Panel under “Set PG/PC interface.” If several masters are connected to the network, enable
these. Do not change any settings, for this will cause bus
errors.
140011 | No tag updating or writing is executed because Check the connection and that the communication
communication is down. partner is switched on.
140012 | There is an initialization problem (e.g. when Restart the HMI device.
WinCC flexible Runtime was closed in Task Or:
Manager). Run WinCC flexible Runtime, then start your other
Or: applications.
Another application (e.g.STEP7) with different bus
parameters is active and the driver cannot be
started with the new bus parameters (transmission
rate, for example).
140013 | The MPI cable is disconnected and, thus, there is Check the connections.
no power supply.
140014 | The configured bus address is in already in use by | Edit the HMI device address in the controller
another application. configuration.
140015 | Wrong transmission rate Correct the relevant parameters.
Or:
Faulty bus parameters (e.g. HSA)
Or:
OP address > HSA or: Wrong interrupt vector
(interrupt does not arrive at the driver)
140016 | The hardware does not support the configured Change the interrupt number.
interrupt.
140017 | The set interrupt is in use by another driver. Change the interrupt number.
140018 | The consistency check was disabled by SIMOTION | Enable the consistency check with SIMOTION Scout and
Scout. Only a corresponding note appears. once again download the project to the PLC.
140019 | SIMOTION Scout is downloading a new project to | Wait until the end of the reconfiguration.
the controller. Connection to the controller is
canceled.
140020 | The version in the controller and that of the project | The following remedies are available:
(FWX file) do not match. Download the current version to the PLC using
Connection to the controller is canceled SIMOTION Scout.
Regenerate the project using WinCC flexible ES, close
WinCC flexible Runtime and restart with a new
configuration.
150000 | No more data is read or written. Possible causes: Ensure that the cable is plugged in, the controller is
e The cable is defective. operational, the correct port is being used.
« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e The wrong port is used for the connection.
e System overload.
150001 | Connection is up because the cause of the —

interruption has been eliminated.

TP 277, OP 277 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6691-1DH01-0ABO

A-13



Appendix

A.2 System Alarms
Number | Effect/cause Remedy
160000 | No more data is read or written. Possible causes: Ensure that the cable is plugged in, the controller is

e The cable is defective.

e The PLC does not respond, is defective, etc.
e The wrong port is used for the connection.

e System overload.

operational, the correct port is being used.
Restart the system if the system alarm persists.

160001

Connection is up because the cause of the
interruption has been eliminated.

160010

No connection to the server because the server
identification (CLS-ID) cannot be determined.
Values cannot be read or written.

Check access rights.

160011

No connection to the server because the server
identification (CLS-ID) cannot be determined.
Values cannot be read or written.

Check, for example, if

e the server name is correct

e the computer name is correct
o the server is registered

160012

No connection to the server because the server
identification (CLS-ID) cannot be determined.
Values cannot be read or written.

Check, for example, if

e the server name is correct

e the computer name is correct
o the server is registered

Note for advanced users:
Interpret the value from HRESULT.

160013

The specified server was started as InProc server.
This has not been released and may possibly lead
to incorrect behavior because the server is running
in the same process area as the WinCC flexible
Runtime software.

Configure the server as OutProc Server or Local Server.

160014

Only one OPC server project can be started on a
PC/MP. An alarm is output when an attempt is
made to start a second project.

The second project has no OPC server functionality
and cannot be located as an OPC server by
external sources.

Do not start a second project with OPC server
functionality on the computer.

170000

S7 diagnostics events are not indicated because it
is not possible to log on to the S7 diagnostics
functions at this device. The service is not
supported.

170001

The S7 diagnostics buffer cannot be viewed
because communication with the controller is shut
down.

Set the controller to online mode.

170002

The S7 diagnostics buffer cannot be viewed
because reading of the diagnostics buffer (SSL)
was canceled with error.

170003

An S7 diagnostics event cannot be visualized. The
system returns internal error %2.

170004

An S7 diagnostics event cannot be visualized. The
system returns an internal error of error class %2,
error number %3.

170007

It is not possible to read the S7 diagnostics buffer
(SSL) because this operation was canceled with an
internal error of class %2 and error code %3.
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A.2 System Alarms

Number | Effect/cause Remedy
180000 | A component/OCX received configuration data with | Install a newer component.
a version ID which is not supported.
180001 | System overload because too many actions Several remedies are available:
running in parallel. NOt?” the actions can be ¢ Increase the configured cycle times or basic clock.
executed, some are rejected. e Generate the alarms at a slower rate (polling).
¢ |Initiate scripts and functions at greater intervals.
If the alarm appears more frequently:
Restart the HMI device.
180002 | The on-screen keyboard could not be activated. Reinstall WinCC flexible Runtime.
Possible causes:
"TouchlnputPC.exe" was not registered due to a
faulty Setup.
190000 | Itis possible that the tag is not updated. —
190001 | The tag is updated after the cause of the last error | —
state has been eliminated (return to normal
operation).
190002 | The tag is not updated because communication Select the system function "SetOnline" to go online.
with the controller is down.
190004 | The tag is not updated because the configured tag | Check the configuration.
address does not exist.
190005 | The tag is not updated because the configured Check the configuration.
controller type does not exist for this tag.
190006 | The tag is not updated because it is not possible to | Check the configuration.
map the controller type in the data type of the tag.
190007 | The tag value is not modified because the Set online mode or reconnect to the controller.
connection to the controller is interrupted or the tag
is offline.
190008 | The threshold values configured for the tag have Observe the configured or current threshold values of the
been violated, for example, by tag.
e avalue entered
e a system function
e ascript
190009 | An attempt has been made to assign the tag a Observe the range of values for the data type of the tags.
value which is outside the permitted range of
values for this data type.
For example, a value of 260 was entered for a byte
tag or a value of -3 for an unsigned word tag.
190010 | Too many values are written to the tag (for Increase the time interval between multiple write actions.
example, in a loop triggered by a script).
Values are lost because only up to 100 actions are
saved to the buffer.
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A.2 System Alarms
Number | Effect/cause
190011 | Possible cause 1:

The value entered could not be written to the
configured controller tag because the high or low
limit was exceeded.

The system discards the entry and restores the
original value.

Possible cause 2:
The connection to the controller was interrupted.

Make sure that the value entered lies within the range of
values of the control tags.

Check the connection to the PLC.

190012

It is not possible to convert a value from a source
format to a target format, for example:

An attempt is being made to assign a value to a
counter that is outside the valid, PLC-specific value
range.

A tag of the type Integer should be assigned a
value of the type String.

Check the range of values or the data type of the tags.

190100

The area pointer is not updated because the
address configured for this pointer does not exist.
Type

Warning alarms

Error alarms

Controller acknowledgment

HMI device acknowledgment

LED mapping

Trend request

Trend transfer 1

Trend transfer 2
0.
consecutive number shown in WinCC flexible ES.

ZoOoO~NOODNWN

Check the configuration.

190101

The area pointer is not updated because it is not
possible to map the PLC type to the area pointer
type.

Parameter type and no.:

see alarm 190100

190102

The area pointer is updated after the cause of the
last error state has been eliminated (return to
normal operation). Parameter type and no.:

See alarm 190100

200000

Coordination is not executed because the address

configured in the controller does not exist/is not set.

Change the address or set up the address in the
controller.

200001

Coordination is canceled because the write access
to the address configured in the PLC is not
possible.

Change the address or set the address in the controller at
an area which allows write access.

200002

Coordination is not carried out at the moment
because the address format of the area pointer
does not match the internal storage format.

Internal error

200003

Coordination can be executed again because the
last error state is eliminated (return to normal
operation).

200004

The coordination may not be executed.
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A.2 System Alarms

Number | Effect/cause Remedy
200005 | No more data is read or written. Possible causes: Ensure that the cable is plugged in and the controller is
e The cable is defective. operational. . .
« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e System overload.
200100 | Coordination is not executed because the address | Change the address or set up the address in the
configured in the controller does not exist/is not set. | controller.
200101 | Coordination is canceled because the write access | Change the address or set the address in the controller at
to the address configured in the PLC is not an area which allows write access.
possible.
200102 | Coordination is not carried out at the moment Internal error
because the address format of the area pointer
does not match the internal storage format.
200103 | Coordination can be executed again because the —
last error state is eliminated (return to normal
operation).
200104 | The coordination may not be executed. —
200105 | No more data is read or written. Possible causes: Ensure that the cable is plugged in and the controller is
o The cable is defective. operational. . '
« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e System overload.
210000 | Jobs are not processed because the address Change the address or set up the address in the
configured in the controller does not exist/has not controller.
been set up.
210001 | Jobs are not processed because read/write access | Change the address or set up the address in the
to the address configured in the controller is not controller in an area which allows read/write access.
possible.
210002 | Jobs are not executed because the address format | Internal error
of the area pointer does not match the internal
storage format.
210003 | The job buffer is processed again because the last | —
error status has been eliminated (return to normal
operation).
210004 | Itis possible that the job buffer will not be —
processed.
210005 | A control request with an illegal number was Check the controller program.
initiated.
210006 | An error occurred while attempting to execute the Check the parameters of the control request. Recompile
control request. As a result, the control request is the configuration.
not executed. Observe the next/previous system
alarms.
220001 | The tag is not downloaded because the associated | Change the configuration.
communication driver / HMI device does not
support the download of Boolean/discrete data
types.
220002 | The tag is not downloaded because the associated | Change the configuration.
communication driver / HMI device does not
support write access to the data type BYTE.
220003 | The communication driver cannot be loaded. The Install the driver by reinstalling WinCC flexible Runtime.

driver may not be installed.
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A.2 System Alarms
Number | Effect/cause Remedy
220004 | Communication is down and no update data is Check the connection.

transferred because the cable is not connected or
defective etc.

220005 | Communication is up. —
220006 | The connection between the specified PLC and the | —
specified port is active.
220007 | The connection to the specified controller is check whether
interrupted at the specified port. e The cable is plugged in
e The controller is OK
e The correct port is used
e your configuration is OK (port parameters, protocol
settings, PLC address)
Restart the system if the system alarm persists.
220008 | The communication driver cannot access or open Close all the applications which access this port and
the specified port. The port may be in use by restart the computer.
another application or the port used is not available | Use another port of the system.
on the destination device.
There is no communication with the controller.
230000 | The value entered could not be accepted. The Enter a practical value or delete any unneeded users.
system discards the entry and restores the previous
value.
Either
e the value range has been exceeded
o illegal characters have been entered
e the maximum permitted number of users has
been exceeded
230002 | The currently logged in user is not granted write Log on as a user with appropriate rights.
access rights. The system therefore discards the
input and restored the previous value.
230003 | Changeover to the specified screen failed because | Configure the screen and check the screen selection
the screen is not available/configured. The current | function.
screen remains selected.
230005 | The value range of the tag has been exceeded in Observe the range of values for the tag when entering a
the 10 field. value.
The original value of the tag is retained.
230100 | During navigation in the web browser, the system Navigate to another page.
returned a message which may be of interest to the
user.
The web browser continues to run but may not
(fully) show the new page.
230200 | The connection to the HTTP channel was Check the network connection.
interrupted due to an error. This error is explained | Check the server configuration.
in detail by another system alarm.
Data is no longer exchanged.
230201 | The connection to HTTP channel was established. | —
Data is exchanged.
TP 277, OP 277 (WinCC flexible)
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Number | Effect/cause Remedy
230202 | WININET.DLL has detected an error. This error Depending on the cause:
usually occurs when an attempt to connect to the | hen an attempt to connect fails or a timeout error
server fails or the server refuses to connect occurs:
because the client Iacks_ t_he proper authorization. e Check the network connection and the network.
An unknown server certificate may also be the
cause if the connection is encrypted by means of | ® Check the server address.
SSL. e check whether the web server is actually running on
The alarm text provides details. the destination computer.
This text is always in the language of the Windows | Faulty authorization:
installation because it is returned by the Windows |, The configured user name and/or password do not
OS. match those on the server. Establish consistency.
Process values are no longer exchanged. When the server certificate is rejected:
Certificate signed by an unknown CA ():
o Either ignore this item in your project, or
¢ Install a certificate that has been signed with a root
certificate known to the client computer.
If the date of certificate is invalid:
o Either ignore this item in your project, or
¢ Install a certificate with a valid date on the server.
Invalid CN (Common Name or Computer Name):
o Either ignore this item in your project, or
¢ Install a certificate with a name that corresponds to
that of the server address.
230203 | Although a connection can be made to the server, Error 503 Service unavailable: check whether
the HTTP server refuses to connect because e WinCC flexible Runtime is running on the server
¢ WinCC flexible Runtime is not running on the e The HTTP channel is supported.
server, or
e The HTTP channel is not supported
(503 Service unavailable).
Other errors can only occur if the web server does
not support the HTTP channel. The language of the
alarm text depends on the web server.
Data is not exchanged.
230301 | Aninternal error has occurred. An English text —
explains the error in more detail. This may be
caused by insufficient memory.
OCX does not work.
230302 | The name of the remote server cannot be resolved. | Check the configured server address.
The attempt to connect failed. check whether the DNS service is available on the
network.
230303 | The remote server is not running on the addressed | Check the configured server address.
computer. check whether the remote server is running on the target
Wrong server address. computer.
The attempt to connect failed
230304 | The remote server on the addressed computer is Use a compatible remote server.
incompatible to VNCOCX.
The attempt to connect failed.
230305 | The authentication has failed because the Configure the correct password.

password is incorrect.
The attempt to connect failed.
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230306 | Error in the connection to the remote server. This check whether

may occur as a result of network problems.
The attempt to connect failed.

e The bus cable is plugged in
e There are network problems

230307 | The connection to the remote server was shut —
down because
e the remote server was shut down, or
o the user instructed the server to close all
connections.
The connection is closed.
230308 | This alarm provides information on the connection | —
status.
An attempt is made to connect.
240000 | WinCC flexible Runtime is operating in demo mode. | Install the authorization.
You have no authorization or your authorization is
corrupted.
240001 | WinCC flexible Runtime is operating in demo mode. | Load an adequate authorization / powerpack.
Too many tags are configured for the installed
version.
240002 | WinCC flexible Runtime is operating with a time- Restore the full authorization.
limited emergency authorization.
240003 | Authorization failed. Restart WinCC flexible Runtime or reinstall it.
Without authorization, WinCC flexible Runtime will
run in demo mode.
240004 | Error while reading the emergency authorization. Restart WinCC flexible Runtime, install the authorization
WinCC flexible Runtime is operating in demo mode. | or repair the authorization (see Commissioning
Instructions Software Protection).
240005 | The Automation License Manager has detected an | Reboot the HMI device/PC. If this does not solve the
internal system fault. problem, remove the Automation License Manager and
Possible causes: install it again.
e A corrupt file
o A defective installation
¢ No free space for the Automation License
Manager etc.
250000 | The tag in the specified line in "Status force" is not | Check the set address and then verify that the address is
updated because the address configured for this set up in the controller.
tag is not available.
250001 | The tag in the specified line in "Status force" is not | Check the set address.
updated because the controller type configured for
this tag does not exist.
250002 | The tag in the specified line in "Status force" is not | Check the set address.
updated because it is not possible to map the
controller type in the tag type.
250003 | An attempt to connect to the PLC failed. The tags Check the connection to the PLC. Check that the
are not updated. controller is switched on and is online.
260000 | An unknown user or an unknown password has Log on to the system as a user with a valid password.
been entered in the system.
The current user is logged off from the system.
TP 277, OP 277 (WinCC flexible)
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260001 | The logged in user does not have sufficient Log on to the system as a user with sufficient
authorization to execute the protected functions on | authorization.
the system.

260002 | This alarm is triggered by the system function —

"TrackUserChange".

260003 | The user has logged off from the system. —

260004 | The user name entered into the user view already | Select another user name because user names have to
exists in the user management. be unique in the user management.

260005 | The entry is discarded. Use a shorter user name.

260006 | The entry is discarded. Use a shorter or longer password.

260007 | The logon timeout value entered is outside the valid | Enter a logon timeout value between 0 and 60 minutes.
range of 0 to 60 minutes.

The new value is discarded and the original value is
retained.

260008 | An attempt was made to read a PTProRun.pwl file |—
created with ProTool V 6.0 in WinCC flexible.
Reading the file was canceled due to incompatibility
of the format.

260009 | You have attempted to delete the user "Admin" or | If you need to delete a user, because perhaps you have
"PLC User". These users are fixed components of | exceeded the maximum number permitted, delete
the user management and cannot be deleted. another user.

260012 | The passwords entered in the "Change Password" | You have to log on to the system again. Then enter the
dialog and the confirmation field are not identical. identical password twice to be able to change the
The password has not been changed. User will be | password.
logged off.

260013 | The password entered in the "Change Password" You have to log on to the system again. Then enter a
dialog is invalid because it is already in use. new password that has not been used before.

The password has not been changed. User will be
logged off.

260014 | User has unsuccessfully attempted to log on 3 You can log on to the system with your correct password.
times in succession. Only an administrator can change the assignment to a
The user has been locked out and assigned to group.
group no. 0.

270000 | A tag is not indicated in the alarm because it check whether the data area for the tag exists in the
attempts to access an invalid address in the controller, the configured address is correct and the value
controller. range for the tag is correct.

270001 | There is a device-specific limit as to how many —
alarms may be queued for output (see the
operating instructions). This limit has been
exceeded.

The view no longer contains all the alarms.
However, all alarms are written to the alarm buffer.

270002 | The view shows alarms of a log for which there is Delete older log data if necessary.

no data in the current project.
Wildcards are output for the alarms.
270003 | The service cannot be set up because too many Reduce the number of HMI devices which want to use the

devices want to use this service.
A maximum of four devices may execute this
action.

service.
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A.2 System Alarms
Number | Effect/cause Remedy
270004 | Access to persistent buffer is not possible. Alarms | If the problems persist at the next startup, contact

cannot be restored or saved.

Customer Support (delete Flash).

270005 | Persistent buffer damaged: Alarms cannot be If the problems persist at the next startup, contact
restored. Customer Support (delete Flash).
270006 | Project modified: Alarms cannot be restored from The project was generated and transferred new to the
the persistent buffer. HMI device; The error should no longer occur when the
device starts again.
270007 | A configuration problem is preventing the restore (a | Update the operating system and then transfer your
DLL is missing, a directory is unknown, etc.). project again to the HMI device.
280000 | Connection is up because the cause of the —
interruption has been eliminated.
280001 | No more data is read or written. Possible causes: check whether
e The cable is defective. e The cable is plugged in
e The PLC does not respond, is defective, etc. e The controller is OK
e The wrong port is used for the connection. e The correct port is used
e System overload. Restart the system if the system alarm persists.
280002 | The connection used requires a function block in —
the controller.
The function block has responded. Communication
is now enabled.
280003 | The connection used requires a function block in check whether
the contrqller. e The cable is plugged in
The function block has not responded. e The controller is OK
e The correct port is used
Restart the system if the system alarm persists.
Remedy depends on the error code:
1: The function block must set the COM bit in the
response container.
2: The function block must not set the ERROR bit in the
response container.
3: The function block must respond within the specified
time (timeout).
4: Go online to the PLC.
280004 | The connection to the controller is interrupted. Check the connection parameters in WinCC flexible.
There is no data exchange at present. Ensure that the cable is plugged in, the controller is
operational, the correct port is being used.
Restart the system if the system alarm persists.
290000 | The recipe tag could not be read or written. It is Check in the configuration that the address has been set
assigned the start value. up in the controller.
The alarm can be entered in the alarm buffer for up
to four more failed tags if necessary. After that,
alarm 290003 is output.
290001 | An attempt has been made to assign a value to a Observe the value range for the tag type.
recipe tag which is outside the value range
permitted for this type.
The alarm can be entered in the alarm buffer for up
to four more failed tags if necessary. After that,
alarm 290004 is output.
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A.2 System Alarms

Number | Effect/cause Remedy
290002 | Itis not possible to convert a value from a source Check the value range or type of the tag.
format to a target format.
The alarm can be entered in the alarm buffer for up
to four more failed recipe tags if necessary. After
that, alarm 290005 is output.
290003 | This alarm is output when alarm number 290000 is | Check in the configuration that the tag addresses have
triggered more than five times. been set up in the controller.
In this case, no further separate alarms are
generated.
290004 | This alarm is output when alarm number 290001 is | Observe the value range for the tag type.
triggered more than five times.
In this case, no further separate alarms are
generated.
290005 | This alarm is output when alarm number 290002 is | Check the value range or type of the tag.
triggered more than five times.
In this case, no further separate alarms are
generated.
290006 | The threshold values configured for the tag have Observe the configured or current threshold values of the
been violated by values entered. tag.
290007 | There is a difference between the source and target | Insert the specified data recipe tag in the source
structure of the recipe currently being processed. structure.
The target structure contains an additional data
recipe tag which is not available in the source
structure.
The data recipe tag specified is assigned its start
value.
290008 | There is a difference between the source and target | Remove the specified data recipe tag in the specified
structure of the recipe currently being processed. recipe from the project.
The source structure contains an additional data
recipe tag which is not available in the target
structure and therefore cannot be assigned.
The value is rejected.
290010 | The storage location configured for the recipe is not | Check the configured storage location.
permitted.
Possible causes:
lllegal characters, write protection, data carrier out
of space or does not exist.
290011 | The record with the specified number does not Check the source for the number (constant or tag value).
exist.
290012 | The recipe with the specified number does not Check the source for the number (constant or tag value).
exist.
290013 | An attempt was made to save a record under a The following remedies are available:
record number which already exists. e Check the source for the number (constant or tag
The action is not executed. value).
e First, delete the record.
e Change the "Overwrite" function parameter.
290014 | The file specified to be imported could not be Check:
found. e The file name
e Ensure that the file is in the specified directory.
290020 | Message reporting that the download of records —

from the HMI device to the PLC has started.
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A.2 System Alarms
Number | Effect/cause Remedy
290021 | Message reporting that the download of records —
from the HMI device to the PLC was completed.
290022 | Message reporting that the download of records Check in the configuration whether:
from the HMI device to the PLC was canceled due |4 The tag addresses are configured in the controller
to an error. e The recipe number exists
e The record number exist
e The "Overwrite" function parameter is set
290023 | Message reporting that the download of records —
from the PLC to the HMI device has started.
290024 | Message reporting that the download of records —
from the PLC to the HMI device was completed.
290025 | Message reporting that the download of records Check in the configuration whether:
from the PLC to the HMI device was canceled due |+ The tag addresses are configured in the controller
to an error. e The recipe number exists
e The record number exist
e The "Overwrite" function parameter is set
290026 | An attempt has been made to read/write a record Set the record status to zero.
although the record is not free at present.
This error may occur in the case of recipes for
which downloading with synchronization has been
configured.
290027 | Unable to connect to the controller at present. As a | Check the connection to the PLC.
result, the record can neither be read nor written.
Possible causes:
No physical connection to the controller (no cable
plugged in, cable is defect) or the controller is
switched off.
290030 | This alarm is output after you selected screen Reload the record from the storage location or retain the
which contains a recipe view in which a record is current values.
already selected.
290031 | While saving, it was detected that a record with the | Overwrite the record or cancel the action.
specified number already exists.
290032 | While exporting records it was detected that a file Overwrite the file or cancel the process.
with the specified name already exists.
290033 | Confirmation request before deleting records. —
290040 | A record error with error code %1 that cannot be Check the storage location, the record, the "Data record"
described in more detail occurred. area pointer and if necessary, the connection to the
The action is canceled. controller.
It is possible that the record was not installed Restart the action after a short time.
correctly on the controller. If the error persists, contact Customer Support. Forward
the relevant error code to Customer Support.
290041 | A record or file cannot be saved because the Delete files no longer required.
storage location is full.
290042 | An attempt was made to execute several recipe Trigger the action again after waiting a short period.
actions simultaneously. The last action was not
executed.
290043 | Confirmation request before storing records. —
290044 | The data store for the recipe has been destroyed —
and is deleted.
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Number | Effect/cause Remedy
290050 | Message reporting that the export of records has —
started.
290051 | Message reporting that the export of records was —
completed.
290052 | Message reporting that the export of records was Ensure that the structure of the records at the storage
canceled due to an error. location and the current recipe structure on the HMI
device are identical.
290053 | Message reporting that the import of records has —
started.
290054 | Message reporting that the import of records was —
completed.
290055 | Message reporting that the import of records was Ensure that the structure of the records at the storage
canceled due to an error. location and the current recipe structure on the HMI
device are identical.
290056 | Error when reading/writing the value in the Check the specified line/column.
specified line/column.
The action was canceled.
290057 | The tags of the recipe specified were toggled from | —
"offline" to "online" mode.
Each change of a tag in this recipe is now
immediately downloaded to the controller.
290058 | The tags of the specified recipe were toggled from | —
"offline" to "online" mode.
Modifications to tags in this recipe are no longer
immediately transferred to the controller but must
be transferred there explicitly by downloading a
record.
290059 | Message reporting that the specified record was —
saved.
290060 | Message reporting that the specified record —
memory was cleared.
290061 | Message reporting that clearing of record memory | —
was canceled due to an error.
290062 | The record number is above the maximum of Select another number.
65536.
This record cannot be created.
290063 | This occurs with the system function Check the "ExportDataRecords" system function.
"ExportDataRecords" when the parameter
"Overwrite" is set to No.
An attempt has been made to save a recipe under
a file name which already exists.
The export is canceled.
290064 | Message reporting that the deletion of records has | —
started.
290065 | Message reporting that the deletion of records has | —
successfully completed.
290066 | Confirmation request before deleting records. —
290068 | Security request to confirm if all records in the —

recipe should be deleted.
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A.2 System Alarms
Number | Effect/cause Remedy
290069 | Security request to confirm if all records in the —
recipe should be deleted.
290070 | The record specified is not in the import file. Check the source of the record number or record name
(constant or tag value).
290071 | During the editing of record values, a value was Enter a value within the limits of the recipe tag.
entered which exceeded the low limit of the recipe
tag.
The entry is discarded.
290072 | When editing record values, a value was entered Enter a value within the limits of the recipe tag.
which exceeds the high limit of the recipe tag.
The entry is discarded.
290073 | An action (e.g. saving a record) failed due to an —
unknown error.
The error corresponds to the status alarm
IDS_OUT_CMD_EXE_ERR in the large recipe
view.
290074 | While saving, it was detected that a record with the | Overwrite the record, change the record number or
specified number already exists but under another | cancel the action.
name.
290075 | A record with this name already exists. Please select a different record name.
The record is not saved.
300000 | Faulty configuration of process monitoring Change the controller configuration.
(e.g. using PDiag or S7-Graph): More alarms are
queued than specified in the specifications of the
CPU. No further ALARM_S alarms can be
managed by the PLC and reported to the HMI
devices.
300001 | ALARM_S is not registered on this controller. Select a controller that supports the ALARM_S service.
310000 | An attempt is being made to print too many reports | Wait until the previous active log was printed.
in parallel. Repeat the print job if necessary.
Only one log file can be output to the printer at a
given time; the print job is therefore rejected.
310001 | An error occurred on triggering the printer. The Evaluate the additional system alarms related to this
report is either not printed or printed with errors. alarm.
Repeat the print job if necessary.
320000 | The movements have already been indicated by Deselect the movements on the other display units and
another device. select the motion control screen on the required display
The movements can no longer be controlled. unit.
320001 | The network is too complex. View the network in STL.
The faulty addresses cannot be indicated.
320002 | No diagnostics alarm selected. Select a diagnostics alarm from the ZP_ALARM alarm
The unit belonging to the alarm could not be screen.
selected.
320003 | No alarms exists for the selected unit. The detail Select the defective unit from the overview screen.
view cannot visualize any networks.
320004 | The required signal states could not be read by the | Check the consistency between the configuration on the
PLC. The faulty addresses cannot be found. display unit and the PLC program.
320005 | The project contains ProAgent elements which are | In order to run the project, install the optional ProAgent
not installed. ProAgent diagnostic functions cannot | package.
be performed.
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Number | Effect/cause Remedy
320006 | You have attempted to execute a function which is | Check the type of the selected unit.
not supported in the current constellation.
320007 | No error-triggering addresses were found on the Switch the detail screen to STL layout mode and check
networks. the status of the addresses and exclusion addresses.
ProAgent cannot indicate any faulty addresses.
320008 | The diagnostic data stored in the configuration are | Download the project to the HMI device again.
not synchronized with those in the PLC.
ProAgent can only indicate the diagnostic units.
320009 | The diagnostic data stored in the configuration are | Download the project to the HMI device again.
not synchronized with those in the PLC. The
diagnostic screens can be operated as usual.
ProAgent may be unable to show all diagnostic
texts.
320010 | The diagnostic data stored in the configuration are | Download the project to the HMI device again.
not synchronized with those in STEP7.
The ProAgent diagnostics data is not up-to-date.
320011 | A unit with the corresponding DB number and FB Check the parameters of the "SelectUnit" function and the
number does not exist. units selected in the project.
The function cannot be executed.
320012 | The "Step sequence mode" dialog is no longer Use the ZP_STEP step sequence screen from the
supported. corresponding standard project for your project. Instead
of calling the Overview_Step_Sequence_Mode function,
call the "FixedScreenSelection" function using ZP_STEP
as the screen name.
320014 | The selected controller cannot be evaluated for Check the parameters of the "EvaluateAlarmDisplayFault"
ProAgent. system function.
The Alarm view assigned to the
"EvaluateAlarmDisplayFault" system function could
not be found.
330022 | Too many dialogs are open on the HMI device. Close all dialogs you do not require on the HMI device.
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Abbreviations

ANSI
CPU
CSv
CTS
DC
DCD
DHCP
DIL
DNS
DP
DSN
DSR
DTR
EMC
EN
ES
ESD

PC/

TP 277, OP 277 (WinCC flexible)

American National Standards Institution
Central Processing Unit

Comma Separated Values

Clear To Send

Direct Current

Data Carrier Detect

Dynamic Host Configuration Protocol
Dual-in-Line (electronic chip housing design)
Domain Name System

Distributed 1/0

Data Source Name

Data Set Ready

Data Terminal Ready

Electromagnetic Compatibility
European standard

Engineering System

Electrostatic Discharge, the components and modules endangered by
such

Electrostatic Sensitive Device
Ground

High Frequency

Human Machine Interface
International Electronic Commission
Interface

Input and Output

Internet Protocol

Light Emitting Diode

Media Access Control

Metal Oxide Semiconductor
Multipoint Interface (SIMATIC S7)
Microsoft

Mean Time Between Failures

Not connected

Operator Panel

Personal Computer
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B-2

PELV
PG
PLC
PPI
RAM
RJ45
RTS
RxD
SD Card
SELV
SP
STN
Sub-D
TAB
TCP/IP
TFT
TTY
TxD
UL
USB
WINS

Protective Extra Low Voltage
Programming device
Programmable Logic Controller
Point-to-Point Interface (SIMATIC S7)
Random Access Memory
Registered Jack Type 45

Request To Send

Receive Data

Security Digital Card

Safety Extra Low Voltage

Service Pack

Super Twisted Nematic
Subminiature D (plug)

Tabulator

Transmission Control Protocol/Internet Protocol
Thin Film Transistor

Teletype

Transmit Data

Underwriter’s Laboratory
Universal Serial Bus

Windows Internet Naming Service

Operating Instructions,
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Glossary

Acknowledge
Acknowledgement of an alarm confirms that it has been noted.

Alarm logging

Output of user-specific alarms to a printer, in parallel to their output to the HMI device
screen.

Alarm, acknowledging
Acknowledgement of an alarm confirms that it has been noted.

Alarm, activated
Moment at which an alarm is triggered by the PLC or HMI device.

Alarm, deactivated
Moment at which the initiation of an alarm is reset by the PLC.

Alarm, user-specific

A user-specific alarm designates a certain operating status of the plant connected to the HMI
device via the PLC.

Array
Area reserved in configured screens for the input and output of values.

Automation device
PLC of the SIMATIC S5 series such as the AG S5-115U

Automation system AS
PLC of the SIMATIC S7 series such as a SIMATIC S7-300
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Bootloader

Used to start the operating system. Automatically started when the HMI device is switched
on. After the operating system has been loaded, the Loader opens.

Bootstrapping

Function called when updating the operating system. When a functional operating system is
available, updates can be performed without bootstrapping. Otherwise, updating with
bootstrapping is necessary. In this case, the configuration computer communicates with the
HMI device by means of the HMI device bootloader.

Configuration PC

General term for programming devices and PCs on which plant projects are created using an
engineering software.

Control request
Triggers a function for the PLC at the HMI device.

Display duration

Defines whether and a system alarm is displayed on the HMI device and the duration of the
display.

EMC

Electromagnetic compatibility is the ability of electrical equipment to function properly in its
electromagnetic environment without influencing this environment.

Engineering software

Software used to generate project used for the purpose of process visualization, such as
WinCC flexible.

Event

Functions are triggered by defined incoming events. Events can be configured. Events which
can be assigned to a button include "Press" and "Release", for example.

Flash memory

Non-volatile memory with EEPROM chips, used as mobile storage medium or as memory
module installed permanently on the motherboard.

Function key

Key on the HMI device which supports user-specific functions. A function is assigned to the
key in the configuration. The assignment of the keys may be specific to an active screen or
not.
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Half Brightness Life Time

Hardcopy

HMI device

Time period after which the brightness reaches 50% of the original value. The specified
value is dependent on the operating temperature.

Output of the screen content to a printer.

Device used for the operation and monitoring of machines and plants. The statuses of the
machine or plant are indicated by means of graphic elements or by indicator lamps on the
HMI device. The operator controls of the HMI device allows the operator to interfere with the
processes of the machine or plant.

HMI device image

Info text

10 field

Object

Operator control

Plant

PLC

A file that can be transferred from the configuration computer to the HMI device. The HMI
device image contains the operating system and elements of the runtime software required
to run a project.

Configured information on objects within a project. Info text for an alarm, for example, may
contain information on the cause of the fault and troubleshooting routines.

Enables the input or output of values on the HMI device which are transferred to the PLC.

Component of a project. Example: screen or alarm. Objects are used to view or enter texts
and values on the HMI device.

Component of a project used to enter values and trigger functions. A button, for example, is
an operator control.

General term referring to machines, processing centers, systems, plants and processes
which are operated and monitored on an HMI device.

General term for devices and systems with which the HMI device communicates, e.g.
SIMATIC S7.
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Process visualization

Project

Project file

Visualization of technical processes by means of text and graphic elements. Configured
plant screens allow operator intervention in active plant processes by means of the input and
output data.

Result of a configuration using an engineering software. The project normally contains
several screens with embedded system-specific objects, basic settings and alarms. The
project file of a project configured in WinCC flexible is saved under the file name extension
*.hmi.

You need to distinguish between the project on the configuration computer and that on an
HMI device. A project may be available in more languages on the configuration computer
than can be managed on the HMI device. The project on the configuration computer can also
be set up for different HMI devices. On the runtime project that has been generated for the
respective HMI device can be transferred to it.

File generated from the runtime project file for use on the HMI device. The project file is
normally not transferred and remains on the configuration PC.

The file name extension of a source file is *.hmi.

Project file, compressed

Recipe

Compressed format of the project file. The compressed project file can be transferred
together with the runtime project file to the respective HMI device. For this purpose, "Enable
Upload" must be set in the project on the configuration computer. The compressed project
file is normally stored on an external memory card.

The file extension of a compressed file is *.pdz.

Combination of tags forming a fixed data structure. The data structure configured can be
assigned data on the HMI device and is then referred to as a record. The use of recipes
ensures that all the assigned data is transferred synchronously to the PLC during the
transfer of a record.

Runtime project file

File generated from the project file for a specific HMI device. The runtime project file is
transferred to the corresponding HMI device and used to operate and monitor plants.

The extension of a compressed file is *.pdz.

Runtime software

Glossary-4

Process visualization software used to test a project on a configuration computer.
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Screen

Form of the visualization of all logically related process data for a plant. The visualization of
the process data can be supported by graphic objects.

Screen object

Configured object used to display or operate the facility, e.g. rectangle, 10 field or message
field.

STEP 7 Micro/WIN
STEP 7 Micro/WIN is the programming software for SIMATIC S7-200 PLCs.

STEP 7

STEP 7 is the programming software for SIMATIC S7, SIMATIC C7 and SIMATIC WinAC
PLCs.

Symbolic 10 field

Field for the input and output of the value. Contains a list of default entries from which one
can be selected.

System alarm

A system alarm is assigned to the "System" alarm class. A system alarm refers to internal
states on the HMI device and the PLC.

Tab order
In the configuration, this sets the sequence in which objects are focused on pressing the
<TAB> key.

Tag
Defined memory location to which values can be written to and read from. This can be done
from the PLC or the HMI device. Based on whether the tag is interconnected with the PLC or
not, we distinguish between "external" tags (process tags) and "internal" tags.

Transfer

Transfer of a runtime project from the configuration PC to the HMI device.

"Transfer" mode

An operating mode of the HMI device in which an executable project is transferred from the
configuration computer to an HMI device.
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/
/Audit, [1-9

A

Accessory kit, 1-4
ACK, 9-3
ACK key, 8-13
Acknowledge key, 8-13
Acknowledging
Alarm, 8-13, 9-6
Error alarm, 9-6
Activating
Direct connection, 6-5
Password protection, 6-18
Address assignment
TCP/IP network, 6-40
Addressing, 6-37
Admin, 8-42, 8-43, 8-44
Agency, iv
Alarm, 9-1
Acknowledging, 8-13, 9-6
Displaying, 9-3
Editing, 9-7
Functional scope, 1-6
Alarm buffer, 9-2
Functional scope, 1-6
Alarm class, 9-1, 9-5
Alarm event, 9-1
Alarm group, 9-2
Alarm indicator, 9-3
Alarm line, 9-3
Alarm log, 9-2
Alarm report, 9-2
Alarm view
Expanded, 9-4
Simple, 9-4
Alarm View, 9-3
Alarm window, 9-5
ALARM_S, [1-6
Alphanumerical
Key assignment, 6-11, 8-13
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Alphanumerical screen keyboard, 8-8
Alphanumerical value
changing, 8-9
Changing, 8-17
Entering, 8-9, 8-17
ALT key, 6-11, 8-13
Ambient conditions
Climatic, 3-2
Mechanical, 3-1
Test, 3-2
Ambient temperature, 3-3
Angle adapter, 1-5
Applications
OP 277, 1-1
TP 277, 1-1
Authorization, 8-34
Automatic
Transfer, 7-6
Automation License Manager, 7-20
A-Z key, 6-11, 8-13

B

Backing up, 7-3, 7-10, 7-11|, 7-12, 8-35
Registry information, 6-5, 6-22
Temporary files, 6-22
To memory card, 6-5, 6-45
With ProSave, 7-12
With WinCC flexible, 7-11

BACKSPACE key, 6-11, 8-13

Backup, 6-5, 6-46

Bar, 8-20

Basic knowledge
Required, |

Booting, 6-5, 6-26

Bootstrapping, 7-3, 7-14

Bottom view, 1-2, 1-4

Bus connection, [1-9

Bus parameters
Profile, 6-33

C

cabinet
Working on, 2-1
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Cable

Connecting, 4-4
Calibrating

Touch screen, 6-5, 6-16
Care, 11-1
CE approval, 2-2
Certificates and approvals, 2-2
Changing

Monitor setting, 6-5

User data, 8-42, 8-43
Character repetition, 6-5

Screen keyboard, 6-14
Charge

Electrostatic, A-1
Cleaning screen, 11-2
Clearance

OP 277, 3-5

TP 277, 3-5
Climatic

Shipping conditions, 2-6

Storage conditions, 2-6
Closing

Project, 8-44
Column sequence

Alarm view, 9-4
Communications properties

Device name, 6-39

PC connection, 6-43
Communications Properties, 6-5
Compatibility conflict, 7-10
Conductor cross-section

Equipotential bonding, 4-6
Configuration PC, 7-1

Connecting, 4-12

Wiring diagram, 4-12
Configuration phase, [7-1
Configuring

Network, 6-38

Operating system, 6-1

PC/PPI cable, 4-13

RS -422/RS -485 port, 4-11

Screen keyboard, 6-12
Connecting

Configuration PC, 4-12

Equipotential bonding, 4-6

PLC, 4-10

Power supply, 4-8, 4-9

Printer, 4-15

PROFINET, 4-11, 4-12

Terminal block, 4-8

USB device, 4-14
Connecting the PLC

Wiring diagram, 4-10
Connection, 1-9

Index-2

Connection sequence, 4-4
Connection to PLC

Number, 1-9
Control keys

Keyboard unit, 6-10
Control Panel

MPI, 6-32

Opening, 6-5

Operating, 6-7, 6-9

Password protection, 6-2

PROFIBUS, 6-32

Screen keyboard, 6-8
creating

User, 8-38, 8-40
Creating

Recipe data record, 10-9, 10-18
C-Tick mark (Australia), 2-3
CTRL key, 6-11, 8-13
Cursor key, 6-10, 8-12

D

Data channel
Enabling, 6-33
Locking, 6-33
Parameter assignment, 6-33
Programming, 6-6
Data flow, 10-4

Date, 6-5
Entering, 8-10, 8-18
Setting, 6-19

Synchronizing, 6-20
Date format, 6-6, 6-21
Date/time properties, 6-5, 6-19
Deactivating
Password protection, 6-19
Decimal, 8-7
Default gateway, 6-41
Degree of protection, 3-4
Protection against ingress of solid foreign
bodies, 3-5
Protection against water, 3-5
Delay time
Setting, 6-6, 6-29
Delete
User, 8-44
DELETE key, 6-11, 8-13
Deleting
Recipe data record, 10-12, 10-20
Device name
For network operation, 6-39
Setting, 6-5
Device Name, 6-39
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DHCP, 6-41
DIP switch
Setting, 4-11
Direct connection, 6-43
Activating, 6-5
Direct key, 8-4
Assigning, 12-5
Functional scope, 1-8
Display
OP 277,12-4
TP 277, 12-2
Display format, 8-7, 8-16
displaying
OP 270 information, 6-27
TP 270 information, 6-27
Displaying
Alarm, 9-3
Info text, 8-11|, 8-14, 8-19, 9-5
Memory information, 6-28
System information, 6-28
DNS, 6-41
DNS server, 6-37
Documentation
Conventions, i
enclosed, 4-1
Getting Started, iii
Operating instructions, i
User manual, |
Double-click, 6-5
Setting, 6-15

E

EC Declaration of Conformity, 2-2
Editing
Alarm, 9-7
Recipe data record, 10-11, 10-19
Electrical potential difference, 4-6
Electrical separation
Safe, 4-9
Electrostatic charge, A-1
Electrostatic discharge
Precautions, A-2
Element list, 10-5, 10-16
e-mail settings, 6-6
E-mail settings, 6-44
EMC directive, 2-2
Emission, 2-4, 2-5
END key, 6-11|, 8-12
Enhanced alarm view, 9-4
Enhanced recipe view, 10-5
Enhanced user view, 8-36
ENTER key, 6-11, 8-12

TP 277, OP 277 (WinCC flexible)
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Entering
Alphanumerical value, 8-9, 8-17
Date, 8-10, 8-18
Hotkeys, 6-11
Input field, 8-6
Numerical value, 8-7, 8-16
Recipe data record, 10-25
Shortcut key, 8-13
Symbolic value, 8-10
Time, 8-10, 8-18
Equipotential bonding
Cable, 4-6
Connecting, 4-6
Requirements, 4-6
Wiring diagram, 4-7
Error alarm
Acknowledging, 9-6
ESC key, 6-11, 8-13
ESD
Abbreviations, A-1
Labeling, A-1
Explorer
Operating, 6-3
Exporting
Recipe data record, 10-23
External
Keyboard, 6-7
Mouse, 6-7
USB devices, 4-5

F

Feedback
Optical, 8-3
Fixation, 3-4
FM Approval, 2-3
Fn key, 6-11, 8-13
Front view, 1-2, 1-3
Function
Additional, 1-8
Function key
Global assignment, 8-15
Labeling, 5-6
Local assignment, 8-15
Function test, 4-17
Functional scope
Alarm buffer, 1-6
ALARM_S, 1-6
Alarms, 1-6
Graphics list, 1-6
Info text, 1-8
Limit value monitoring, 1-6
Log, 1-7

Index-3



Index

Recipe, 1-7
Safety, 1-8
Scaling, 1-6
Screen, 1-7
Tag, 1-6
Text list, 1-6

G

Gauge, 8-20
Graphics list

Functional scope, 1-6
Group acknowledgement, 8-13

H

High frequency radiation, 2-1
HMI device
Booting, 6-5
Bottom view, 1-2, 1-4
Cold restart, 6-26
EMC-compliant mounting, 2-4
Front view, 1-2, 1-3
Information, 6-5
Ports, 4-5
Rear view, 1-4
Rear view, 1-3
Side view, 1-2, 1-3
Switching off, 4-17
Switching on, 4-16
Testing, 4-16
HOME key, 6-11|, 8-12
Host cable
Safety instruction, 4-14
Hotkeys
Entering, 6-11

Importing
Recipe data record, 10-24
Info text
Displaying, 8-11|, 8-14, 8-19, 9-5
Functional scope, 1-8
Key, 8-14
Information
on HMI device, 6-27
Initial startup, 7-2
Input field, 8-6
Character mode, 8-12
Normal mode, 8-12
Input on the HMI device

Index-4

By means of function key, 8-15
Using operator controls, 8-1
Input unit
OP 277, 12-4
TP 277,12-3
InputPanel, 6-5
Installation location
Selecting, 3-4
Installing
Network, 6-37
Option, 7-4, 7-17, 7-18, 7-1S
Instructions
General, 2-4
Insulation test
Test voltage, 3-5
Interference
Pulse-shaped, 2-4
Sinusoidal, 2-5
Internet
Service, v, 11-3
Support, v, 11-3
Internet settings, 6-44
IP address, 6-5
Ethernet, 6-41

K

Key
ACK, 8-13
ALT, 6-11|, 8-13
A-Z, 6-11, 8-13
Backspace, 8-13
Cancelling, 6-11
CTRL, 6-11, 8-13
Cursor, 6-10, 8-12
Delete, 6-11|, 8-13
END, 6-11, 8-12
ENTER, 6-11, 8-12
ESC, 6-11, 8-13
Fn, 6-11, 8-13
HOME, 6-11, 8-12
Info text, 8-14
Scroll back, 6-11, 8-12
Scroll forward, 6-11|, 8-12
SHIFT, 6-11, 8-13
TAB, 6-10, 8-12
Tabulator, 6-10
Keyboard
External, 6-7
Safety instruction, 5-3
Keyboard control, 8-12, 8-15
Keyboard properties, 6-5
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L

Label
Function key, 5-6
Labeling
Certificates and approvals, 2-2
EC Declaration of Conformity, 2-2
Labeling strips
Dimensions, 5-6
Printing, 5-6
Language change
Functional scope, 1-8
Layout
Slider control, 8-22
Sm@rtClient view, 8-30
Trend view, 8-24
LED ACK, 9-3
License key, 7-20
Transferring, 7-4, 7-21
Uploading, [7-4, 7-22
Limit value
For password, 8-35
For user, 8-35
For user view, 8-35
Limit value monitoring
Functional scope, 1-6
Limit value test, 8-7, 8-16
List box, 8-10, 8-18
Opening, 6-11|, 8-13
Loader, 6-1
Operating, 6-2
Locking
Operator control, 11-2
Log
Functional scope, 1-7
Logoff
User, 8-38
Logoff time, 8-34
Logon
User, 8-36

M

MAC address, 6-40
Maintenance, 11-1, 11-3
Manual

Production sequence, 10-26

Transfer, 7-5
Mechanical

Shipping conditions, 2-6

Storage conditions, 2-6
Memory

OP 277,12-4

TP 277, 12-3
Memory card, 1-5

TP 277, OP 277 (WinCC flexible)
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Backup to, 6-45
Ejecting, 5-5
Inserting, 5-4
Restoring file system, 6-22
Restoring from, 6-45
Memory information, 6-6
Displaying, 6-28
Menu command
Simple recipe view, 10-17
Monitor setting
Changing, 6-5
Monitoring mode
Sm@rtClient view, 8-30
Mounting
EMC-compliant, 2-4
Mounting clamp
Mounting, 4-2, 4-3
Mounting cut-out
Dimensions, 3-4
Preparing, 3-4
Mounting position, 3-3
Mouse, 6-5
External, 6-7
MP 277
Switching on, 4-16
Testing, 4-16
MPI
Setting, 6-6, 6-32
Multimedia card, 5-3
Multiple key operation, 8-2, 8-14

N

Name server, 6-5, 6-41
Network

Configuring, 6-38

Installing, 6-37

Logon data, 6-5
Network configuration, 6-5

Identification, 6-42
Network operation

Options, 6-6, 6-44
Network setting, 6-5, 6-40
Non-insulated structure, 4-9
Number format, 6-6, 6-21
Numerical

Key assignment, 6-11|, 8-13

Screen keyboard, 8-6
Numerical value

Changing, 8-7, 8-16

Decimal places, 8-7

Display format, 8-7, 8-16

Entering, 8-7, 8-16

Limit value test, 8-7, 8-16
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O

Offices, iv
Offline
Operating mode, 7-2
Recipe tag, 10-8
Test, [7-8
Online
Operating mode, 7-2
Recipe tag, 10-8
Test, 7-8
OP 270
Displaying information, 6-27
OP 277
Applications, 1-1
Clearance, 3-5
Mounting, 4-1
Operator control element, 5-2
OP properties, 6-5
Device, 6-27
Persistent storage, 6-22
Touch, 6-16
Opening
Control Panel, 6-5
List box, 6-11, 8-13
Operating
Control Panel, 6-7
Explorer, 6-3
Key, 8-12, 8-15
Loader, 6-2
Operator control, 6-11

Operator control element, 8-12

Project, 8-1

Recipe screen, 10-9, 10-18

Slider control, 8-23

Switch, 8-21

Trend view, 8-25

User Interface, 6-3

With external keyboard, 8-2

With external mouse, 8-2
Operating instructions

Area of application, |

Purpose of, |
Operating mode, 7-2

Offline, 7-2

Online, 7-2

Switching, 7-2

Transfer, 4-16, 7-2
Operating system

Configuring, 6-1

Safety instruction, 4-14

update via ProSave, 7-16

update via WinCC flexible, 7-15

Updating, 7-3, 7-14

Index-6

Operation
Feedback, 8-2
Operation feedback, 8-2
Operator control
Locking, 11-2
Operating, 6-11
Recipe view, 10-9
Selecting, 6-10
Operator control element
Memory card slot, 5-4
OP 277, 5-2
Operating, 8-12
Simple recipe view, 10-16
TP 277, 5-1
Operator input options, 6-6
Optical feedback, 8-3
Option
Installing, 7-4, 7-17
Installing with ProSave, 7-19
Installing with WinCC flexible, 7-18
Removing, 7-4, 7-17
Removing with ProSave, 7-20
Removing with WinCC flexible, 7-18
Options, 1-9
Network operation, 6-6, 6-44
Overall dimensions
TP 277,121

P

PAGE DOWN key, 6-11|, 8-12
PAGE UP key, 6-11, 8-12
Parameter assignment
Data channel, 6-33
Password, 8-34
Backing up, 8-35
Restoring, 8-35
Specifying, 6-18
Password list, 8-34
Password properties, 6-5, 6-18
Password protection, 6-2, 6-5
Activating, 6-18
Deactivating, 6-19
PC connection, 6-43
PC/PPI
Adjusting adapter, 4-13
Cable, 1-5
Configuring cable, 4-13
PELV, 4-9
Peripheral equipment
Rated load, 4-14
Permissions in remote operation, 8-31|, 8-33
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Pin assignment
Power supply, 12-6
RJ45 plug connector, 12-7
RS -422/RS -485 port, 12-6
USB port, 12-7
PLC
Configuring the port, 4-11
Number of connectible, 1-9
Protocol, 1-9
Reading recipe data record, 10-14, 10-21

Transferring recipe data record, 10-15, 10-22

PLC_User, 8-42, 8-43, 8-44
Pocket Internet Explorer, 1-9
Port

HMI device, 4-5

OP 277,12-4

Rated load, 4-14

TP 277, 12-3
Power failure, 7-10
Power supply

Connecting, 4-8, 4-9

Pin assignment, 12-6

Wiring diagram, 4-8
Precautions

Electrostatic discharge, A-2
Printer

Connecting, 4-15

Wiring diagram, 4-15
Printer connection

Setting, 6-24
Printer properties, 6-6, 6-25
Printer setting, 6-6
Printing

Labeling strips, 5-6

Via a network printer, 6-38
Process control phase, 7-1
Production sequence

Manual, 10-26
PROFIBUS

Setting, 6-6
PROFIBUS DP

Setting, 6-32
PROFINET, 6-6, 6-37

Addressing, 6-37

Connecting, 4-11, 4-12
PROFINET IO

Disabling direct keys, 6-36

Enabling direct keys, 6-36
Programming

Data channel, 6-6
Project

Closing, 8-44

Offline testing, 7-8

Operating, 8-1

TP 277, OP 277 (WinCC flexible)
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Testing online, [7-8

Transferring, 7-1, 7-4
Proper use, 2-1
Protection class, 3-5
Protective foil, 1-5, 11-2
Protocol

PLC, 1-9
Proxy server, 6-44
Proxy settings, 6-6, 6-45

R

Radiation
High frequency, 2-1
Radio interference, 2-4
Emission, 2-5
Rated load
Port, 4-14
Rated voltage, 3-6
Reading out
Recipe data record, 10-14, 10-21
Rear view, 1-3, 1-4
Recipe, 10-1
Data flow, 10-4
Element, 10-3
Field of application, 10-1
Functional scope, 1-7
Recipe screen, 10-4
Recipe view, 10-4
Record, 10-2
Synchronizing tags, 10-13
Recipe data record
Creating, 10-9, 10-18
Deleting, 10-12, 10-20
Editing, 10-11, 10-19
Entering, 10-25
Exporting, 10-23
Importing, 10-24
Reading from controller, 10-14, 10-21
synchronize with PLC, 10-11
Transferring to PLC, 10-15, 10-22
Recipe list, 10-5, 10-16
Recipe screen, 10-6
Operating, 10-9, 10-18
Overview, 10-6
Recipe tag
Offline, 10-8
Online, 10-8
Synchronizing, 10-7, 10-13
Recipe view, 10-4
Expanded, 10-5
Operator control, 10-9
Simple, 10-5
Recommissioning, [7-2
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Record list, 10-5, 10-16
Regional and Language Settings, 6-21
Regional settings, 6-6, 6-21
Registered trademarks, iv
Registry information
Backing up, 6-5, 6-22
Regulations for the prevention of accidents, 2-1
Remote control
Forcing permission, 8-31, 8-33
Starting, 8-31, 8-32

Removing
Option, 7-4, 7-17, 7-18, 7-20
Repairs, 11-3

Restore, 6-5, 6-46
Restoring, 7-3, 7-10, 7-11, 7-13, 8-35
From memory card, 6-5, 6-22, 6-45
With ProSave, [7-13
With WinCC flexible, 7-11
Return Center, 11-3
Reverse Polarity Protection, 4-9
RJ45 plug connector
Pin assignment, 12-7
RS -422/RS -485 port
Configuring, 4-11
RS -422/RS -485 port
Pin assignment, 12-6
RS 422-RS 232 Converter, 1-5
Ruler, 8-25
Trend view, 8-25

S

S7 transfer settings, 6-6

Safety
Functional scope, 1-8
Standards, 2-2

Safety instruction
Changed tag name, 10-13
Cold restart, 6-26
Compeatibility conflict, 7-10
Compressed project file, 7-4
Connection sequence, 4-4
Data channel, 7-14
Data loss, 7-14
Direct key, 8-3
Electrostatic charge, A-1
Grounding conductor, 4-6
High frequency radiation, 2-1
Keyboard, 5-3
License key, 7-10, 7-17
Memory card, first use, 5-4
Multiple key operation, 8-2
Observe grounding measures, A-2

Index-8

Path, 6-30
Port, 4-14
Power failure, 7-10
preventing faulty operation, 11-1
Project File, 6-30
Recipe data record in background, 10-6
Remote control for Channel 1, 6-34
Storage, 2-6
Switching info text, 8-11, 8-19
Touch screen, 5-3
Transfer mode, 6-31, 6-35
Transfer mode Channel 2, 6-35
Transport, 2-6
Unintentional action, 5-2, 8-14
Unintentional transfer mode, 6-34
Updating the operating system, 4-14
USB Host-to-Host Cable, 4-14
Working on the cabinet, 2-1
Safety isolation, 4-9
Safety regulations, 2-1
Scaling
Functional scope, 1-6
screen
Functional scope, 1-7
Screen keyboard, 6-5, 8-5
Alphanumerical, 8-8
Change layout, 6-8
Character repetition, 6-14
Configuring, 6-12
For Control Panel, 6-8
Keyboard level, 8-9
Language change, 8-8
Numeric, 8-6
Representation types, 6-8
Screen saver, 6-6, 6-24
Setting, 6-24
Security system, 8-34
Seeting PROFINET 10, 6-6
Selecting
Operator control, 6-10
Service
On the Internet, v, 11-3
Service pack, 11-3
Setting
Date, 6-19
Date format, 6-21
Delay time, 6-6, 6-29
Device name, 6-5
DIP switch, 4-11
Double-click, 6-15
E-mail connection, 6-44
Language, 8-4
MPI, 6-6, 6-32
Number format, 6-21
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PC/PPI adapter, 4-13

Printer connection, 6-24

PROFIBUS, 6-6, 6-32

Proxy, 6-45

Regional data, 6-21

Screen saver, 6-24

Time, 6-19

Time format, 6-21
Setting language, 8-4
Setting the time zone, 6-19
SHIFT key, 6-11, 8-13
Shipping conditions, 2-6
Shortcut key

Entering, 8-13
Side view, 1-2, 1-3
Simple alarm view, 9-4
Simple recipe view, 10-5

Menu command, 10-17

Operator control element, 10-16
Simple user view, 8-36
Slider control, 8-22
Sm@rtAccess, 1-1, 1-9
Sm@rtClient view, 8-30, 8-31

Monitoring mode, 8-30

Usage, 8-30
Sm@rtService, 1-1, 1-9
SMTP server, 6-44
Software options, 1-9
Sort order

Alarm View, 9-4
Specifications

Display, 12-2, 12-4

Input unit, 12-3, 12-4

Memory, 12-3, 12-4

OP 277,12-3

Ports, 12-3, 12-4

Power supply, 12-6

RJ45 port, 12-7

RS -422/RS -485 port, 12-6

Supply voltage, 12-3, 12-4

TP 277, 12-2

USB port, 12-7
Specifying

Password, 6-18
Standard operating system, 1-1
Starting

HMI device, 6-26
Status / control, 8-26

Keyboard control, 8-28

Touch Operation, 8-27
Storage conditions, 2-6
Structure

Non-insolated, 4-9
Subnet mask, 6-41
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Supply voltage
OP 277,12-4
TP 277,12-3
Support
On the Internet, v, 11-3
Switch, 8-21
Switching off
HMI device, 4-17
Switching on
MP 277, 4-16
Symbolic value
Changing, 8-10
Entering, 8-10
Synchronizing
Date and time, 6-20
Recipe tag, 10-7, 10-13
System alarms
Parameter, A-3
System information, 6-6
Displaying, 6-28
System properties, 6-6
Memory, 6-29

T

Tab

Memory, 6-29
TAB key, 6-10, 8-12
Tag

Functional scope, 1-6
Task planner

Functional scope, 1-8
TCP/IP address, 6-40
Technical support, iv
Temporary files

Backing up, 6-22
Terminal block

Connecting, 4-8
Test

For ambient conditions, 3-2
Testing

MP 277, 4-16
Text list

Functional scope, 1-6
Time, 6-5

Entering, 8-10, 8-18

Setting, 6-19

Synchronizing, 6-20
Time format, 6-6, 6-21
Touch screen

Calibrating, 6-5, 6-16

Safety instruction, 5-3
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TP 270
Displaying information, 6-27
TP 277
Applications, [1-1
Clearance, 3-5
Mounting, 4-1
Operator control element, 5-1
Overall dimensions, 12-1
Training Center, iv
Transfer, 7-1, 7-2, 7-4
Automatic, 7-6
Cancel, 4-16
Manual, 7-5
Transfer mode
Unintentional, 6-34
Via MPI, 6-31
Via PROFIBUS DP, 6-31
Transfer settings, 6-6, 6-33
Channel, 6-34
Directories, 6-29
Transferring
License key, 7-4, 7-21
Project, 7-1, 7-4
Recipe data record, 10-15, 10-22
Transport damage, 4-1
Trend view, 8-24
Trends
Functional scope, 1-8
Limit violation, 8-24

U

UL approval, 2-2
Unintentional action, 5-2, 8-2
Unintentional transfer mode, 6-34
Updating

About ProSave, 7-16

Operating system, 7-14

Via WinCC flexible, [7-15
Upload, 7-4, 7-9
Uploading

License key, [7-4, 7-22
USB device

Connecting, 4-14
USB port

External device, 4-5

Pin assignment, 12-7
Use

Index-10

Conditions, 3-1
In industry, 2-4
In residential areas, 2-4
With additional measures, 3-1
User, 8-34
Admin, 8-42, 8-43, 8-44
creating, touch operation, 8-38, 8-40
Delete, 8-44
Logoff, 8-38
Logon, 8-36
PLC_User, 8-42, 8-43, 8-44
User data
Backing up, 8-35
Changing, 8-42, 8-43
Restoring, 8-35
User group, 8-34
User Interface
Operating, 6-3
User manual, |
User view, 8-35
Expanded, 8-36
Simple, 8-36
Using the RS 485/RS 232 port, 4-12

Vv

Value table

Trend view, 8-24
VBScript

Functional scope, 1-8

w

WiInCC flexible internet settings
E-mail, 6-44

WiInCC Internet settings, 6-6

Windows CE taskbar, 6-2
Password protection, 6-2

WINS, 6-41

WINS server, 6-37

Wiring diagram
Configuration PC, 4-12
Connecting the PLC, 4-10
Equipotential bonding, 4-7
Power supply, 4-8
Printer, 4-15

Working on the cabinet, 2-1
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